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Environmental, Social, and Governance
Management

The ServiceNow® Environmental, Social, and Governance Management application helps you to
centrally manage all your environmental, social, and governance (ESG) commitments. The ESG
Management application also facilitates easier reporting on the progress that you make on your
ESG initiatives.

ESG Management overview

ESG refers to the three pillars of interest for socially responsible investors: the environmental,
social, and corporate governance. Socially responsible investors consider it important to
incorporate their values into their investments instead of simply considering their profit. The
ESG framework considers the impact of factors such as sustainability, equality, and so on in the
investment decision-making process.

Most organizations must report how they integrate ESG commitments into their business
strategies. There’s no defined exhaustive list of ESG initiatives. Some examples of ESG
commitments are as follows:

« Responsible procurement
« Diversity, inclusion, and belonging at work
 E-waste reduction

« Reduced carbon footprint

The following image shows how different departments collaborate for ESG reporting.

ESG Management uses

ESG Management

Consolidate ESG data from across
multiple systems

Deliver investor-grade ESG disclosures
with delivered frameworks

Align ESG goals and targets with
material topics

Materiality Sustainability
Assessment Reports

Sales & Customer Supply Risk & / \ Regulatory
Marketing Finance FocHties Service Chain Compliance a J Reporting

Disclosures

“‘ % ‘
Internal
Review

Strategic Porifolio Management

« Create project plans to achieve
transition targets and other ESG goals

« Collaborate on budget, timelines,
resources, and results
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Integrated Risk Management

* Assess, quantify, and control climate-

related risks

« Ensure organizational compliance with

ESG policies and governance
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Get started

Explore

Learn about how ESG

program managers use

the ESG Management
application for addressing
their environmental, social,
and governance concerns.

Use

Use the ESG Management
application for tasks
such as importing
citations, creating
disclosures, updating
disclosures, and so on.

Configure

3

Configure your ESG

Management application.

Overview pages

View the ESG
Management workspace
overview pages
for various reports.

Integrate

(o))
1

Integrate your ESG
Management application
with other applications
such as Project Portfolio
Management, Integrated
Risk Management
and Watershed.

Reference

P

Get details about
components like fields,
tables, roles, and
properties installed
with ESG Management.

Implement ESG Management

Use the Setup checklist for the ESG Management application to quickly implement the ESG

Management application.

Learn

What is Environmental, Social, and Governance (ESG)? &

Exploring ESG Management

The ServiceNow® ESG Management application helps you to manage your environmental,
social, and governance (ESG) initiatives.

ESG Management overview

While most organizations engage in ESG initiatives, some lack a central tool to manage all their
ESG programs. The absence of a tool leads to a lack of visibility into the ESG efforts and lack
of progression tracking. The ESG Management application helps to resolve this issue. This
application enables companies to manage their ESG programs and to communicate their ESG

goals and progress.
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The business benefits of ESG reporting using the ESG Management application are as follows:
« Improves your brand reputation.

« Creates a competitive advantage.

« Attracts investors and more capital.

« Enables you to comply with regulatory requirements.

« Establishes strong corporate governance through ethical, transparent, and secure business
practices.

« Improves corporate reputation.

« Improves customer confidence.

« Promotes transparency about the risks and opportunities.
ESG Management workfow

The following diagram shows the workflow of ESG Management for each user role.

WorkFHow of setting up and using the ESG Management application

External Process - Outside of ServiceNow

Identify material topics through
a materiality assessment

{
o (2] © 0 .1

(Optional) Associate

ESG Program

marager Docurrleqt ilc:enFiﬁed —>  Establishgoals | —> Crefg:e toc:]rlgiets o entiAtises:f;ateoqls o
DCESTICICRIC 9 9 definitions to target
¢ A
[
1
— 00—
1
ESG Metrics |
manager Define metrics |- - —--=---+
ESG Provide data
Batcowres for metrics
ESG reporting &
disclosure manager d?si?c?srs::s

Document material topics

Determine the material topics you‘d like to track, such as managing carbon
emissions. See Create material topics to get started and review Material topic
workflow and states for more details.

Establish goals

Goals are the outcomes you want to achieve, and targets are specific, measurable
milestones that help you reach the goals. The Create an ESG goal page explains
how to enter your goals and includes links to useful information like how goal
progress is calculated. See Create an ESG goal for details.

Create targets

A target shows you how well you are doing against your goal. The Create an ESG
target page shows you how to do it.

Associate entities with goals
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Associate the entities that must be tracked for the goals and subgoals. This
association is created for tracking purposes. Entities that are associated with the
goal are responsible for tracking the goal. See Associate entities to goals for more
details.

Define metrics

Create metric definitions and metrics to measure performance and how the
organization is progressing toward its goals and targets. To gain an in-depth
understanding of what are metrics and how they’re useful in ESG Management,
refer to Exploring GRC: Metrics

Add metrics to targets

Optionally, after you create a target, you can add a source for the target. The source
can be a metric or a metric definition that contributes to the target. See Add a
source for a target for more details.

Provide data for manual metrics or automatically collect data for automated metrics

Collect data for metrics either manually or automatically. Data must be provided
manually for manual metrics and is automatically collected at the scheduled time for
automated metrics. See Provide data for a metric data task for more details.

Generate disclosures

The disclosure is sent for review to the ESG program manager and after approval,
it can be downloaded to a spreadsheet for easier reporting. Using the Microsoft
365 for ServiceNow Reporting, you can create disclosures in a Microsoft Word
document. See Integrating Microsoft 365 with ServiceNow reporting to get started
and review Disclosures in ESG Management for details.

ESG Management benefits

Benefit Feature Users

Manage your ESG activities from the ESG Workspace ESG program

interactive dashboard in the Home page. manager, disclosure
manager.

Monitor your individual and team tasks froma My tasks page view ESG program

single dashboard in the My tasks view. manager

Create material topics to determine your ESG  Create a material topic ESG program

initiatives manager

Establish ESG goals to track your progress Create an ESG goal ESG program

toward your chosen material topics. manager

Create an ESG target to help track the Create an ESG target  ESG program

progress towards your ESG goal. manager

Use GRC: Metrics to track goals and targets, Exploring GRC: Metrics manager

collect data, and report data. Metrics

Create disclosures for your organization. Create a narrative Reporting disclosure

Disclosures enable investors to make disclosure onremote  manager, ESG

informed decisions about companies, their storage program manager

risk posture, sustainability standards, and ESG

compliance.
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Elements of ESG Management

Before you start your environmental, social, and governance (ESG) initiatives, familiarize yourself
with the key elements such as material topics, metrics, and disclosures that make up the ESG
Management application.
The key components of the ESG program are as follows:

« Material topics: Themes that you want to work on.

« Goals: Objectives that you want to reach based on your topics.

« Targets: Set targets to track and measure the progress of the goals.

« Emission activities and factors: Activities that lead to emissions.

« Disclosures: Reports generated to show the company's progress on the chosen material topic.

Material topics

Material topics are topics that represent an organization's most significant impacts on the
economy, environment, and people. Companies identify these material topics by performing
materiality assessments. These topics reflect the organization’s most significant impacts on

the society, environment, and people, including impacts on human rights. Some examples of
material topics are E-waste management, giving and volunteering, and so on. To learn about the
states of the material topic, refer to Material topic workflow and states.

Goals

Goals refer to objectives that an organization sets for itself to make an impact on their chosen
material topics. You can link goals to material topics. Some examples of goals are as follows:

« Using renewable energy by the end of the year 2035.
« Increase diversity in the workplace by 50 percent.

A goal can also have subgoals. You can also associate different entities to the goal so that you
can track who is responsible for fulfilling the goal.

If you integrate ESG Management with other products, you can also do the following:

« If you integrate with Project Portfolio Management, you can add programs and projects to
capture the work being done to meet your goal.

« If you integrate with Integrated Risk Management, you can add risks, risk statements, policies,
control objectives, and issues to your goals and build a governance framework.

For more information on integrations, see Integrating ESG Management with other applications.

Targets

Targets help you to measure your goal. For example, to meet the goal of increasing diversity in
the workplace by 50 percent, the target can be to hire 30 percent diverse workforce by the first
quarter of 2035.

Disclosures

An ESG disclosure is a form of public reporting by an organization about its performance across
various ESG issues.
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Emission activities and factors

An emission activity refers to any activity that is associated with the release of pollutants such as
Greenhouse gases (GHG).

The release of GHG into the atmosphere depends mainly on the activity and the product that
emits the gases. To estimate GHG emissions per unit of available activity, you must use a factor
called an emission factor. An emission factor is a coefficient which allows to convert activity
data into GHG emissions. It is the average emission rate of a given source, relative to units of
an activity or processes. As an ESG program manager, you must set up your library of emission
activities and factors.

Material topic workAow and states

Material topics are the point of origin for ESG initiatives. Only when a material topic is identified,
it can be tracked and success can be measured.

The following image shows the states of a material topic.

State
] ] o ] {5} ®

Draft Approval Ready to assess Assess risk Monitor Retired
Complete Complete Complete Complete In progress Upcoming

The states of a material topic are defined as follows:
1. Draft: All material topics begin in this state. The following fields can be updated in this state:
°© Name
o Classification
o Importance to business success
o Importance to stakeholders
o Priority

o Approver

N

Approval: In this state, the ESG program manager conducts a review of the material topic and
ensures that all fields have been accurately updated to align with the materiality assessment
outcomes. After the review is complete, the status is changed to the Monitor state. For
example, if the material topic identified is Carbon emissions, the reviewer might review it for
aspects such as:

o If the material topic adheres to the materiality assessment.
o If the description of the material topic is accurate.

3. Ready to assess: This state is accessible only if you have the ESG risk management plugin
installed and activated. In this state, the material topic is sent for risk assessment.

4, Assessrisk: This state is accessible only if you have the ESG risk management plugin installed
and activated. In this state, the material topic risks are assessed by the ESG program manager.

5. Monitor: This state designed to oversee the material topic from a monitoring perspective. It
remains in its current state until any modification is made to any of the material topic attributes.
If an update is necessary, the material topic should be reverted to the Draft state. This may
occur after a subsequent materiality assessment, where there could be a shift in the following
attributes:
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© Priority
o Significance to business success

o Significance to stakeholders

If a material topic moves back to the Draft state, there’s no downstream impact to goals and
targets. Only those material topics that are in the Monitor state are shown in the Materiality
matrix on the ESG Workspace home page. Even when a material topic is in the Monitor state,
the risk assessment can be re-initiated.

6. Retired: This state is used to retire the material topic when it is no longer tracked by the
organization as an issue that is relevant to the organization.

ESG Management use case

The ESG use case consists of multiple processes such as setting up your ESG program,
defining metrics, collecting data for metrics, adhering to regulatory frameworks, and generating
disclosures.

Setting up the ESG Management program

As an ESG administrator and ESG program manager, you must begin by setting up the ESG
program. The set up requires the following steps:

» Assessing materiality: Assessing materiality enables you to discern the most significant
material topics and their respective areas of impact on your stakeholders and organization.
Firstly, you identify the material topics that hold the greatest importance for your stakeholders
and possess the most substantial influence. The identification of topics happens externally
and then they are documented in the ESG Management application.

« Defining goals and targets: As an ESG program manager, you can choose to create goals and
targets for your material topics.

Goals and targets play a crucial role in driving and measuring the success of an ESG initiative.
Here's a brief explanation:

1. Goals: Goals in an ESG initiative are broad, long-term aspirations that define the overall
purpose and direction of sustainability efforts. They are often aligned with the company's
mission, values, and stakeholder expectations. Examples of ESG goals include reducing
greenhouse gas emissions, promoting diversity and inclusion, and improving corporate
governance.

2, Targets: Targets are specific, measurable, and time-bound objectives set to achieve the
broader ESG goals. They provide clarity and focus, enabling organizations to track progress
and demonstrate accountability. Targets can be established for different aspects of ESG,
such as environmental impact, social issues, and governance practices. When you set
targets, you must also specify the sources from where the target will obtain data.

o Environmental targets: These relate to reducing the company's environmental footprint and
promoting sustainable practices. They can include targets for carbon emissions reduction,
water and energy conservation, waste management, and adoption of renewable energy
sources.

o Social targets: These focus on addressing social issues and fostering positive impacts
on communities and employees. Examples of social targets include increasing workforce
diversity, ensuring fair labor practices, promoting employee well-being and safety, and
supporting community development initiatives.
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o Governance targets: These targets emphasize the implementation of robust governance
frameworks and ethical business practices. They may involve enhancing transparency
and accountability, strengthening board independence, promoting responsible executive
compensation, and ensuring compliance with legal and regulatory requirements.

 Scoping entities: Each goal is associated to an entity that must be tracked for the progress
being made.

Defining metrics

As an ESG metrics administrator, establish a comprehensive data collection process to gather
relevant ESG data across all operations. The data can be collected using metric definitions. The
three types of metric definitions are manual, calculated, and automated. Identify the key ESG
metrics aligned with industry best practices, such as carbon emissions, energy consumption,
waste management, employee diversity, workplace safety, supply chain sustainability, and
corporate governance. Ensure data accuracy by implementing appropriate tracking systems and
engaging relevant stakeholders such as data providers for manual metrics.

Measurement reporting

Once the material topics are identified, the ESG metrics administrator and an ESG program
manager collect the metrics that are of utmost importance to the organization. You can report on
the performance of these metrics against predetermined thresholds and objectives, as well as
document any issues that arise when the metrics fail to meet the thresholds.

Reporting framework

As an ESG program manager, develop an ESG reporting framework based on recognized
standards like the Global Reporting Initiative (GRI), Sustainability Accounting Standards Board
(SASB), and Task Force on Climate-related Financial Disclosures (TCFD). The framework defines
reporting boundaries, disclosure protocols, and data.

Generating disclosures

As an ESG disclosure manager, using the collected data, generate an annual ESG report.
The report provides a comprehensive overview of the company's sustainability performance,
including quantitative and qualitative data. Highlight the achievements, challenges, goals,
and future initiatives related to environmental impact, social responsibility, and corporate
governance.

ESG Workspace

The ESG Workspace is a simplified user interface designed for different users to perform their
respective tasks. The home page of the ESG Workspace displays various quick actions and
reports.

The ESG Workspace displays different sections to provide data visualization for different
components. These sections reference the three pillars of Environmental, Social, and
Governance (ESG) commitments.
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The following image shows you the ESG home page.

Favorites  History ~ Workspaces 5 ESG Workspace

ESG dashboard

::: Welcome, System Administrator!

Overview Show all goals v Quick actions

All H Environmental H Social H Governance H Document a material topic
Create a goal

Create a narrative disclosure

Tasks View all tasks

My pending tasks

Green Yellow None Green Yellow None Yellow Green Green Open Overdue
| P h | B 3 3 il b | B
Material ~ Top-level ~Sub-goals | | Material ~ Top-level ~Sub-goals | | Material  Top-level ~Sub-goals | | Material  Top-level ~Sub-goals
o r " " Approvals
Topics oals Topics Goals Topics Goals Topics Goals
7 8 14 3 5 8 2 2 1 4 1 5
Top Level Goals Summary Al goals data v ] [anv]
Goal ¥ Classification Status Progress  Off-trackgoals  Off-tracktargets  Overduemetrics  Non-compliant policies High risks Failed controls Openiissif
Accelerate a sustainable future Environmental . “ o o o o o o
through our products. G
Accelerate a sustainable future e - @ ° 0 0 0 0 o
through our products
Accelerate circular economy and Environmental . " o o o o o o
reduce waste
Accelerate circular economy and A R - o o o 5 o o
reduce waste
Accelerate Decarbonization Environmental * Yellow 27.51 2 o 44 1 o 19
Accelerate Decarbonization Environmental » Yellow 2751 2 o o o o o
Act with integrity Governance ®Green 578 Y o o 1 o 1
Act with integrity Governance ®Green 578 o o o o o o
Create equitable opportunity Social ®Green 15 o o o o o o
Create equitable opportunity Social ®Green 15 o o o o o 4
Showing 1-10 of 15 1 2 5 10~ rows per page
Targets summary by goal
> Name s Goal o Status Owner Measure Target value Actual value Progress Check in frequency Updated Updated by
> Goal: Accelerate Decarbonization (3) Show all
> Goal: Reduce data center emissions (1) Show all
> Goal: Reduce emissions from employee-related activities (2) Show all
Showing 1-3 of 3 1 20 rows per group
Disclosures Pending Disclosures
Disclosure Summary Name Type State v v Assigned to
Open Overdue ACME Global Impact Report Annual Report Review Bernard Laboy
2 2 | ACME SASB disclosure Framework Draft Antony Alldis
Due in 30 days
0
Disclosures. Bytype v
2
Porsiren [
1 1 Showing 1-2 of 2 a 20+  rows per page
Material topics [ Heatmap ~

Cimate & Energy
1- Very important

Community Involvement | Circular Economy
2-Important

ESG Transparency | Ethics & Compliance
3- Moderately im,

Importance to stakeholders

4 Slightly import

4- Slightly important 3- Moderately important 2 Important 1- Very important

Importance to business success
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Each section of the dashboard is explained in the following sections.

Quick actions

When you log in to the ESG Workspace, the ESG dashboard is the first page that is available
to you. Using the Quick actions section on the ESG Workspace, you can perform the following
tasks:

« Document a material topic
» Create a goal

« Create a program

« Create a project

« Start a disclosure

Note: The options to create a program and a project are available only when you integrate
with Project Portfolio Management.

Tasks

The Tasks section enables you to view the following:
« Provides a single page for viewing all the ESG related tasks.

« Enables you to view the individual user tasks, user group tasks, my items, and watch list on the
Tasks page in the workspace view.

» Enables you to view the pending approvals if you are a manager.

You can launch the Tasks page by selecting the Task icon on the ESG Workspace (ﬁ)

Overview section

Material topics are the areas selected by your company. The Overview section shows you the
status of all those material topics that have associated goals and sub-goals for the three pillars.

Each link is clickable and leads you to the related pages. You can see if the goals are on-track, at
risk, or off-track. Using the filter on the page, you can either view all your goals or only your top-
level goals.

Top Level Goals Summary

The Top Level Goals Summary section provides a more detailed view of the goals and their
status. In this section, you can filter your goals by the three pillars. You can see only the top
level goals and when the filter is changed, you can still see only the top level goals but the data
includes all the child-level goals. Under this section, you can view the following items for your
goals:

» Goal: Shows all the goals.

« Classification: Shows if the goal belongs to environmental, social, or governance.
« Status: Shows if the goal is on track or off track.

 Progress: Shows the progress value of the goal.

» Off-track goals: Shows the number of off-track goals.

« Off-track targets: Shows the number of off-track targets.

e Overdue metrics: Shows the overdue metrics.
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« Overdue Programs/Projects: Shows the number of programs and projects that are associated
with the goal.

« Non-compliant policies: Shows the number of non-compliant policies that are applied to the
goal.

« High risks: Shows the number of risks for the goal.

() Note: Non-compliant policies and High risks appear only when you install Integrated Risk
Management (IRM).

Target summary by goal

This section provides a summary of the targets by goals and their status, owners, measure, target
value, actual value, progress, check in frequency, and who is the goal updated by.

Disclosures

The Disclosures section provides a breakdown of the different disclosures. Disclosure refers
to the disclosure of data relating to an organization's environmental, social and governance
performance. Such disclosures enable investors to make informed decisions by identifying
companies that may pose a risk. This section displays the following information:

« Open disclosures
e Overdue disclosures

« Disclosures due in 30 days

Disclosures are of different types and each disclosure has a workflow. You can filter the
disclosures using either the By type or By state filters.

Pending disclosures

The Pending disclosures section displays all the disclosures that are pending. These disclosures
are displayed along with their state, type, and the person who is assigned the disclosure.

Material topics

Using the Ffilter provided, you can view the status of your material topics in one of the following
formats:

» Heatmap

o List

In the Heatmap view, the Material topics section shows you the matrix of your material topics
according to their importance to stakeholders and to business success. Each tile in the heatmap
is clickable. If you opt for the List view, you can also see the priority and the classification of the
material topics.

@ Note: Only the material topics in the Monitor state contribute to this report.

Searching in the ESG Workspace

You can use the ability to search the ESG Workspace by using the Search field. To search
the ESG Workspace, select ESG workspace from the list. The search results appear on the
contextual side panel.

© 2026 ServiceNow, Inc. All rights reserved. 15
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

My tasks page view

My tasks page displays a single-pane view of your pending tasks, and the tasks assigned to your

user group.

Tabs on the Tasks page

The Tasks page displays the assigned tasks for the logged-in user in different tabs as shown in

the following

Servicenaw Al Favorites

History ~ Workspaces

@ My pending tasks (24) My items (1)

example.

Needs my approval New

All - Metric data tasks

Last refreshed just now

OO

Name
lask for test manual MU for ALME Asia

Task for test manual MD for Accounts Receivable
Task for test manual MD for ACME Americas
Task for test manual MD for Acer

Task for test Manual MD check 2 for ACME Personal
Banking

Task for test Manual MD check 2 for ACME RB India
Task for test Manual MD check 2 for ACME RB UK
Task for test Manual MD check 2 for ACME Midwest

Task for test manual MD for ACME Asia

Showing 1-13 of 24

( ESG Workspace vt

Overdue

Number
MDIASKUOZU161

MDTASK0020162

MDTASK0020163

MDTASK0020164

MDTASK0020165

MDTASK0020166
MDTASK0020167
MDTASK0020168

MDTASK0020211

1

2 > 3l

The Tasks page in the ESG Workspace displays the following tabs:

Assigned to ¥
ESG Admin

ESG Admin
ESG Admin
ESG Admin
ESG PM
ESG PM
ESG PM
ESG PM

ESG Admin

‘ Q Search

Priority
4 - Low

10

Bla =y

State v
Awaiting Approval

New
Awaiting Approval
New

Awaiting Approval

Awaiting Approval

« My pending tasks: Displays an overview of the pending tasks that are assigned to you and the
tasks that require an action from you. You can filter your pending tasks by using the following

types of the states:

o All

o Draft/New

© In progress

©o Needs my approval
© Needs my review

o Overdue

© Pending response

@ Note: The data displayed in the Tasks page is based on the roles of the users.

» My items: Displays a list of the tasks that are assigned to the logged-in user.

A typical My tasks page for a logged-in user is shown in the following example.

() Note: On the My pending tasks, My items tab, you can only view the records that are in-
progress. The closed and canceled records are not displayed on these tabs. You can view

the closed and canceled records in their respective forms in the ESG Workspace.

If you have the ESG Management administrator role, you can customize the ESG Workspace by
updating the Tasks page configurations module.
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ESG Workspace users

The ESG Workspace displays the relevant data for the environmental, social, and governance
pillars and enables you to take appropriate actions according to your role. These roles include
the ESG administrator, ESG program manager, ESG reporting and disclosure manager, ESG
metrics manager, and ESG data owner.

The ESG Workspace is highly configurable and role-driven. Being role-driven means that the ESG
Workspace is customized or unique for each user or role in your organization.

The following table lists the key tasks that each role performs in your organization.

ESG users and their tasks

ESG Administrator Set up the ESG Management application so
that it can be used by the users.

« Create material topics

» Create ESG goals

» Set targets for goals

» Add a goal to a material topic

e Approve a material topic

« Manage entities in ESG Management
« Create a new emission activity

« Create an emission factor

» Manage all integrations

» Create a new schedule for calculating the
due date of the metric data task.

« Manage metrics.

» Create unit family, units, and unit
conversions.

ESG program manager « Create material topics

» Create ESG goals

« Set targets for goals

« Add a goal to a material topic

« Approve a material topic

» Manage entities in ESG Management

» Manage metrics

ESG reporting and disclosure manager Create disclosures for internal and external
stakeholders

ESG metrics manager » Create an automated metric definition

« Create a manual metric definition
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ESG users and their tasks (continued)

« Create a calculated metric definition
+ Create a metric

e Integrating ESG Management with
Watershed

ESG data owner « Provide data for the metrics

« Provide responses for multiple metrics

ESG Risk Manager ¢ Create arisk statement @
O Note: This role is installed if you » Generate a risk from a risk statement &

activate the sn_esg_risk_mgmt plugin » Create arisk assessment scope and initiate

an assessment

For more information on the roles, see Components installed with ESG Management.

Managing Sustainable IT

The Sustainable IT application enables you to effectively manage and monitor the emissions
generated by your hardware assets. Additionally, it enables you to keep track of the energy
consumption of your assets and their proper disposal after they reach the end of their lifespan.

As an ESG program manager, the Sustainable IT application empowers you to track the
sustainability performance of your hardware assets such as laptops, servers, desktops, printers
and scanners, and so on. With this tool, you can easily monitor and assess the environmental
impact of your hardware assets. The application provides valuable insights through a dashboard,
enabling you to make informed decisions on whether to retire or repurpose these assets. The
dashboard also displays important data such as electricity consumption and emissions. To use
the Sustainable IT application, you must install and activate the Sustainable IT (sn_esg_sustain)
plugin and the Hardware Asset Management (sn_hamp) plugin.

With the Sustainable IT application, hardware asset managers can make informed decisions
regarding asset purchases, focusing on reduced energy consumption. By providing insights
into devices with the lowest emissions, the application enables managers to prioritize
environmentally friendly choices.

Using this application, you can monitor your data center's emission performance and identify
your most environmentally friendly or greenest data centers.

To collect data of the hardware asset emissions, consumption, e-waste, and energy star assets,
by default, 27 metric definitions such as Energy from solar power, Energy from biomass, and so
on are provided. You must activate those metric definitions for which you want to collect data and
configure your entities appropriately so that the correct data is collected and displayed. The data
is always collected on a monthly basis and is only displayed for the completed metric data.

For the Digital End-User Experience (DEX), data on energy emissions from laptops and desktops
is collected using 10 metrics definitions by default. These include metric definitions such as
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Real-Time CO2e Emissions by Model and Real-Time Energy Consumption by Asset Location, all
grouped under Dex-Real Time Emissions. Data collection occurs monthly.

« Activate all metric definitions grouped under “Dex-Real Time Emissions” and ensure all
required details are filled in.

« Assign appropriate entities (locations/models) to each metric definition.

« For emissions-related metrics configure the emission factor “CO2 equivalent from Purchased
Electricity eGRID” from the eGRID source via Content Accelerator.

(] Note: Confirm that the emission factor’s location matches the asset location
records. If no emission factor is found for a location, the calculated value will be zero
#unique_42_Connect_42_ul_nhx_5t3_fdc.

« Set the metric period date to the previous month.

Note: DEX agents report the previous day's energy consumption data (example,
September 15 data is sent on September 16). If the metric period is not set properly, data
may be labeled with incorrect dates (example, May's data appearing under June dates).

Related topics

Methods to set up entities for Sustainable IT

Sustainable IT dashboard

The Sustainable IT dashboard displays a variety of information to easily gauge the sustainability
impact of the IT assets of an organization.

The Sustainable IT dashboard displays data for Hardware assets, datacenters, and your
organization's IT footprint on the world map. Datacenters refer to the facilities that house the IT
infrastructure. All these tabs are explained in the following sections.

0 Note: To view the Hardware assets tab and the Data centers tab on the dashboard, you
must activate the Hardware Asset Management (sn_hamp) plugin. Additionally, to activate
the IT footprint map tab, you must activate the Geo Map component (sn_geo_map) plugin.
For more information on the required Geo Map component, see the Understanding Google
Maps APIs in geo-map component [KB1588661] & article in the Now Support knowledge
base.

IT footprint map

The first tab on the Sustainable IT dashboard showcases a global map depicting the carbon
footprint of your datacenters, office buildings, and so on, highlighting your most energy-efficient
facilities. The data displayed is determined by the configuration that you configure on the map
marker. For more information, refer to Configure a map marker. When you hover over the icons on
the map, you can view the classification of the configured marker's efficiency, the metric name,
the entity name, and the most recent metric data available. You can configure any of the metric
definitions that are provided along with the Sustainable IT plugin. Only those metric definitions
that are grouped under Sustainable IT are available for selection. For example, you can use the
following the metric definitions:

« Carbon intensity for office locations
» DCIE by data center

@ Note: DCiE stands for datacenter infrastructure efficiency.
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For more information on how you can filter the metric definitions that are grouped under
Sustainable IT, refer to Filter Sustainable IT metric definitions.

When you move the cursor over the icon, a popover is displayed. On the popover, you can select
the entity name and a side panel opens that shows the metrics related to the selected entity of
the following metric definitions.

« PUE by Data Center

« WUE by Data Center

o CUE by Data Center

« CO2e emissions from energy usage

« Total energy used

« Hardware energy consumption by location

« CO2e from hardware assets by location

You can select Open link to navigate to the metric record page for details. An entity class filter on
the right side of the dashboard is available to select the data that you want to view.

Hardware assets
The following video shows the Hardware assets tab.

Overview: In the overview section, you can see the Trend chart that displays the data for the
following metric definitions:

« Carbon emissions from hardware assets.

« Hardware energy consumption.

You can select the chart to further explore or delve into more detailed information or data related
to the chart. The fields from where the data is obtained are specified in the metric definition form.
For more information, see Create an automated metric definition.

Energy consumption: The energy consumption section displays the information in the
subsequent formats:

« Total energy consumption (kWh): This figure represents the total energy consumption for
the Hardware energy consumption by model category metric definition. Hardware energy
consumption by model category refers to the amount of energy or power consumed by
different categories of hardware. Hardware model category refers to various types of devices,
such as computers, servers, or other devices. The configuration of the metric definition
includes specifying the model category column in the hardware table for the purpose of data
collection.

» Energy consumption by model category (kWh) or location: This horizontal bar graph displays
the energy consumption data. You can filter the data either by the Location filter or the Model
category filter. You have the option to sort the bar chart in either ascending or descending
order using the available filters. If you drill down on this bar chart, a new page opens that
displays further details about the assets that are in use and that consume maximum energy. By
default, this new page shows all the assets of the first bar in the chart at the bottom and shows
the top models by energy consumption on the right.

« Energy star assets: The dial chart showcases the number of energy star-certified assets out of
the total number of assets.

Emissions: Within the emissions section, the data is presented in the following format.
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« Total emission (days): You can view both the total emissions value and the variation in
emissions when compared to the previous month.

« Emissions by model category or by location (days): This horizontal bar graph displays the
emissions data. You can filter the data either by the Location filter or the Model category
filter. You have the option to sort the bar chart in either ascending or descending order using
the available filters. If you drill down on this bar chart, a new page opens that displays further
details about the assets that are in use and that generate maximum emissions. By default,
this new page shows all the assets of the first bar in the chart at the bottom and shows the top
models by emissions on the right. The data that is displayed depends on the selection you
make in the filters, that is, whether you selected Location or Model category.

E-waste reused, donated, or landfilled: In this section, the data is presented in the following
format:

« Retired assets (Ibs): The donut chart displays the number of assets reused, donated, and
disposed.

« Landfills (Ibs): The pie chart in this section displays the weight of hardware assets, by model
categories, that have been disposed. This weight is in pounds.

The data for this section is obtained from the Hardware asset table. Each chart is interactive,
enabling you to select specific segments to access more detailed information.

Data centers

The following video shows the Data center tab.

https://playervimeo.com/video/952411276?
h=c57fd6f950&amp;badge=0&amp;autopause=0&amp;player_id=0&amp;app_id=58479

Overview: In the overview section, you can view the Trend chart that displays the data for the
following metric definitions:

» Co2e from energy usage

« Total energy used

You can select the chart to further explore or delve into detailed information about the energy
use or emission for each data center. The overview section also displays the number of data
centers from where the data for emissions and energy is sourced. You can also see the top three
greenest data centers based on the DCIiE where the data center with the highest DCIE is ranked
at the top. Greenest data centers refer to data centers have the minimum amount of emissions.

Data center efficiency: In the data center efficiency section, the data is presented in the
following formats:

» Power usage effectiveness: Power Usage Effectiveness (PUE) is a metric used to assess the
energy efficiency of a data center. It’s a ratio that quantifies the amount of energy consumed by
a data center facility compared to the energy used by the IT equipment it houses.

« Water usage effectiveness (KgCO2e): Water Usage Effectiveness (WUE) is a metric used to
evaluate the water efficiency of a data center or a facility. Similar to Power Usage Effectiveness
(PUE), which measures energy efficiency, WUE quantifies the amount of water consumed by a
data center facility in relation to the water used by the IT equipment.

« Carbon usage effectiveness (KgCO2e/kWh): Carbon Usage Effectiveness (CUE) is a metric
used to assess the carbon efficiency and environmental impact of a data center or facility. It
quantifies the number of carbon dioxide emissions produced per unit of IT load or computing
work performed by the data center.
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Energy consumption: Within the energy consumption section, the information is displayed in the
subsequent formats:

« Total energy consumption (kWh): This figure represents the combined energy consumption
of all the data centers. It provides an overview of the overall energy usage across all the data
centers.

« Total energy consumption by source: A donut chart is used to illustrate the distribution of
energy consumption in kilowatt hours (kWh) from different energy sources. The energy
sources are specified in the form of metric definitions. Each section of the semi donut chart is
interactive, enabling you to select specific segments to access more detailed information.

« Energy consumption by data centers (kWh): The bar chart showcases the energy consumption
for each individual data center, considering all the active metric definitions. You have the
option to sort the bar chart in either ascending or descending order using the available filters.
This enables you to analyze and compare the energy usage of different data centers more
effectively.

Emissions: In the emissions section, the data is presented in the following formats:
« Total emissions (KgCO2e): This figure represents the total emissions for all the data centers.

» Emissions by data center (KgCO2e): The bar chart showcases the emissions for each
individual data center, considering all the active metric definitions. You can use the provided
filters to sort the bar chart in either ascending or descending order. Additionally, each bar of
the bar chart is interactive, enabling you to select specific segments to access more detailed
information.

@ Note: The data is aggregated by using the summation method.

Digital end-user experience

The Digital End-User Experience (DEX) tab on the Sustainable IT Dashboard integrates real-time
energy consumption data from DEX into the dashboard. This integration enhances the accuracy
and reliability of sustainability reporting for IT assets, particularly desktops and laptops. By
leveraging real-time usage data from DEX, organizations can move beyond estimated hardware
energy metrics and promote a more precise calculation of CO.e emissions.

Overview: In the overview section, you can see the Trends chart that displays the data for the
following metric definitions:

« Real time CO2e Emissions by Models

« Real-time Energy Consumption by Models

You can select the chart to further explore or delve into more detailed information or data related
to the chart. The fields from where the data is obtained are specified in the metric definition form.
For more information, see Create an automated metric definition. In the overview section, you
can also see the Asset coverage, which displays the number of assets from where the usage and
consumption data is sourced. You can select the asset number to further explore or delve into
more detailed information into the asset details.

Energy consumption: Within the energy consumption section, the information is displayed in the
subsequent formats:

« Total energy consumption (kWh): This figure represents the combined energy consumption of
all the assets. It provides an overview of the overall energy usage across assets.

» Energy consumption by models (kWh): The bar chart showcases the energy consumption
for assets by brand model or location of that asset. Each bar of the bar chart is interactive,
enabling you to select specific segments to access more detailed information. The available
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filters enable you to analyze and compare the energy usage of different models more
effectively. You have the following filters available:

o Use the Group by filter to group data by asset location or asset models.
o Use the Sort by filter to sort the data in ascending or descending order.
o Use Filter by model to view data for only selected models.

« Energy consumption breakdown: The dial chart displays the energy consumption breakdown
by asset components, including central processing unit (CPU), network, energy loss, display,
and others.

Emissions: In the emissions section, the data is presented in the following formats:
« Total emissions (KgCO2e): This figure represents the total emissions for all the assets.

» Emissions by models (KgCO2e): The bar chart showcases the emissions for assets by brand
model or location of that asset. Each bar of the bar chart is interactive, enabling you to select
specific segments to access more detailed information. You have the following filters available:

o Use the Group by filter to group data by asset location or asset models.

o After selecting the group as location, you can use filter by location to view data for only
selected locations.

o Use the Sort by filter to sort the data in ascending or descending order.

o Use Filter by model to view data for only selected models.

For more information on DEX, see Digital End-User Experience @.

Scope 3 dashboard

The Scope 3 dashboard helps you to calculate and track scope 3 emissions to gain a complete
understanding of your organization's environmental impact and ensure compliance with evolving
regulations. Scope 3 emissions refer to indirect emissions in your value chain, for example, the
emissions generated from procurement of equipment.

Integrated with the ESG Workspace, the Scope 3 dashboard is useful for ESG program managers
and ESG administrators to get an overview of the trends of the organization's scope 3 emissions.
To view the scope 3 dashboard, you must activate the Scope 3 emissions management
(sn_esg_scope3d) plugin. This application starts collecting data only after the plugin is activated
and the necessary categories and models tables are configured. If you want to view historical
data on the dashboard, then the data must be imported into the system.

() Note: A total of 10 metric definitions are provided to collect data for this dashboard. By
default, these metric definitions are in the inactive state and must be activated. These
metric definitions are grouped under Scope 3 emissions for you to easily find them.

You can access the Scope 3 dashboard by selecting the icon on the ESG Workspace.

There are 15 categories of greenhouse gases (GHGs) for which you can report your Scope
3 emissions. Organizations can choose which categories to report, and with the Scope 3
emissions management application, you can report on the following two categories.
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« Category 1 Purchased goods and services: This category refers to the extraction, production,
and transportation of goods and services purchased or acquired by the reporting company in
the reporting year.

« Category 2 Capital goods: This category refers to the extraction, production, and transportation
of capital goods purchased or acquired by the reporting company in the reporting year. Capital
goods are physical assets like buildings, machinery, and equipment that are used to produce
consumer goods or services.

The dashboard displays the scope 3 data for GHG category, spend category, and supplier
category. The following sections explain these categories. Understanding these types of data
helps you to understand the data that is displayed on the Scope 3 dashboard.

Spend category data

Spend-based emission factors assign typical levels of greenhouse gas (GHG) emissions to
different spending categories. For instance, the emissions generated from spending $1on
office equipment may differ from those generated from spending $1 on transportation services.
By multiplying the amount spent in each category by the relevant emission factor, you can
estimate your indirect emissions. For example, if you categorize all your laptops as assets spend
category, you can aggregate the expenditure on all those assets and then multiply the figure by
the emission factor value provided by the Environmentally extended input-output (EEIO).

Supplier category data

The supplier category data uses the following calculation methodologies.

« Environmentally extended input-output (EEIO) data: EEIO data integrates environmental data
with economic input-output models to assess the environmental impacts associated with
economic activities. This type of data is crucial for understanding how economic activities
contribute to environmental pressures and can be used to evaluate the environmental impacts
of different sectors and products throughout their supply chains. This data can either be
entered manually in the ServiceNow instance or can be uploaded in bulk if the data is available
in a spreadsheet. EEIO data is derived from the emission tables that are filled by activating
from the ESG content accelerator application.

Life cycle assessment (LCA) data: LCA data is used for evaluating the environmental impacts
associated with all stages of a product's life from raw material extraction through materials
processing, manufacture, distribution, use, repair and maintenance, and disposal or recycling.
LCA data is crucial for conducting these assessments and includes detailed information about
the environmental impacts of materials, processes, energy use, and waste management
throughout the product life cycle.

Supplier category data: Each organization has several suppliers for a variety of goods and
services. Some examples of suppliers are laptop suppliers, monitor suppliers, desktop
suppliers, and so on. You can categorize each of the suppliers into different categories. The
scope 3 dashboard displays the emissions generated by these suppliers using the metric
definitions that are provided by default. This information helps you to identify the scope for
reduction of emissions. This data can either be entered manually in the ServiceNow instance
or can be uploaded in bulk if the data is available in a spreadsheet.

o Note: For more information on the data calculation, see the Overview of Calculation
Methodologies for Metric Definitions in the Scope 3 Dashboard [KB1648880] & article in the
Now Support Knowledge Base.
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GHG category

Emissions from purchased goods and services, classified under Scope 3 category 1 of the
Greenhouse Gas (GHG) Protocol and capital goods classified under category 2, refer to the
indirect emissions generated from a company's procurement of goods and services. The GHG
category also uses the EEIO, LCA, and supplier calculation methodologies.

Related topics

Configuring the Scope 3 dashboard

Reports on the scope 3 dashboard

The Scope 3 dashboard displays a variety of reports to easily gauge the sustainability impact of
the scope 3 emissions of an organization. All the reports on this dashboard can be drilled down
for detailed metric definitions and the entities that provide the data for each report.

Scope 3 dashboard

SErVICeNOW Al Favorites  History Workspaces  Admin ESG Workspace Q Search

& Scope 3 dashboard

Scope 3 dashboard

Track GHG category 1 & 2 scope 3 carbon footprint of your organization.

Aggregated scope 3 emissions (KgCO2e)
Total Emissions [rstsimas, Emissions by calculation methodologies () LestSyears'y

o |

4000

2019 2020 2021 2022 2028

e
5 Yes

Bcadt  WEEOG: W suppler data

Suppliers with CDP data (O 2025+

Bsupicrdan @icAcn  WESO G

The following section explains each of the reports that are displayed.

Data visualizations

As an ESG administrator and an ESG program manager, you can view the following reports on the

Scope 3 dashboard.
Title Type Description
o Area chart Displays the total emissions generated by asset procurement fo
Total emissions years. The data in this widget gets aggregated for each year. The
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Title Type Description

measurement for this report is KgCO2e. You can view the data f

~\_. 5 years to obtain a comparative analysis.

e Note: You can configure the number of years for which yo
the datainthe sn_esg_scope3. historical_years
property. By default, the data for 5 years is displayed.

Line chart Displays the emissions generated based on the various calculal

Emissions by methodologies such as EEIO data, LCA data, and supplier data.
calculation information about these calculation methodologies, refer to Scc
methodologies The unit of emission measurement for this report is also KgCO2
the data for the past 3, 4, or 5 years to obtain a comparative ana

Emissions by Bar graph Displays detailed and granular data for supplier category and sy
supplier and spend Select either Supplier category or Spend category to view the |
category (KgCO2e) You can choose the desired year to view the data from the drop.

provided. The data for the last 5 years is available for this report

Suppliers with SBTi
approved targets

Donut Shows the supplier data obtained using the Science Based Targ
(SBTi) standard that suppliers must adhere to. SBTi defines and
strategies for emissions reductions and net-zero targets in line \
science. This report enables you to identify which of your suppli
to the SBTi standards. The data for this report comes from the re
manual metrics definition that is provided by default.

@ Note: For the metric data tasks of this metric definition, th
owner must enter their responses as either Yes or No.

Emissions by GHG  Bar graph Displays the data for the GHG categories that are category 1 Pur
scope 3 categories and services and category 2 Capital goods. You can choose the
(KgCO2e) view the data from the drop-down list that is provided. The data

is available for this report.

Suppliers with CDP
data

Displays the supplier data obtained using the Carbon disclosur
standard that the suppliers must adhere to. CDP requires organ
disclose their climate impact. The data for this report comes fror
of the manual metrics definition that is provided by default.

O
o
3
=%

@ Note: For the metric data tasks of this metric definition, th
owner must enter their responses as either Yes or No.

Related topics

Configuring the Scope 3 dashboard

ESG content accelerator

The ESG content accelerator application is a centralized repository of frameworks, citations,
metric definitions, and emission factors. Using this application accelerates the adoption of ESG
frameworks.
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You can install ESG content accelerator from the ServiceNow Store. After installation, you can

launch the application by selecting the ESG content accelerator icon (E).

Frameworks and regulations

The application contains the following frameworks and regulations.
« Global Reporting Initiative (GRI)
« Sustainability Accounting Standards Board (SASB)
« Task Force on Climate-related Financial Disclosures (TCFD)
« United Nations Sustainable Development Goals
« SustainablelT.org (Available on version 18.0.3)
« European Sustainability Reporting Standards (ESRS/CSRD) (Available on version 18.0.3)
« The International Sustainability Standards Board (ISSB) (Available on version 19.1.0)
« IFRS Sustainability Disclosure Standards (ISSB) (Available on version 19.1.0)

0 Note: The list of frameworks supported isn’t exhaustive and may evolve over the future
releases.

Emission factors

An emission factor is a coefficient that quantifies the emissions released per unit of activity or
output. It is used extensively in environmental science, engineering, and regulatory contexts
to estimate the amount of pollutants or greenhouse gases emitted into the atmosphere from
various sources. The ESG content accelerator also contains several emission factors. For more
information on emission factors, refer to Emission factor library.

Emission factors are sourced from certain standard content providers. These content providers
publish the emission factors for a variety of industries and geographies. As an ESG administrator,
while you can create your own emission factor to calculate your emissions, you can also use the
emission factors provided through the ESG content accelerator application. Using the emission
factors through the ESG content accelerator application saves your time and effort. The following
emission factors are provided by this application.

« eGRID

* GHG Emission Factors by US EPA

« UK GHG factors (From DEFRA and DESNZ)

« US Environmentally-Extended Input-Output (USEEIO)

You can activate or update the ones that meet your requirement. Whenever there is a latest

version of the emission factors available, you can update it using the ESG content accelerator
application.

() Note: Selecting the information icon on any tile displays the description of the framework
or the emission factor.

Benefits of the ESG content accelerator application

The following are the benefits of the ESG content accelerator application:
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« Provides the ability to choose the framework you want to use.

« Facilitates the alignment of the metric definitions with the relevant citations from different
frameworks. This helps achieve interoperability between citations of different frameworks and
ensures consistent reporting of ESG performance across various standards and regulations.

« Enables you to choose the citations that are associated with a particular framework and install
them in the active state in your instance.

« Allows the installation of the metric definitions, which are associated with the citations, in the
inactive state.

« Eliminates the need to manually create the metric definitions.
« Enables the users to edit the metric definitions.

« Aims to integrate updates as they become available and are listed in the versions under the
respective frameworks and regulations.

Workfow of the ESG content accelerator application

The following figure displays the life cycle of the ESG content accelerator application.

> Install the Unified
Content Management

o
:\\l//\w‘ \’\ application

Navigate to Unified > Select emission factor Accept > Select

v

Content Management source and version the disclaimer emission activities
(o8 4
Emission factor sources, Map existing locations
activities, factors and locations — Submit — P "9
(Optional)

are loaded into the system

For more information see, Activate or update a framework and install citations using the ESG
content accelerator.

Emission factor library

An emission factor library consists of emission factors, emission activities and emission activity
sources. Itis crucial to set up your emission factor library to calculate your emissions accurately.

The following sections explain the differences between emission factors, emission activities, and
emission activity sources.

Emission factor

An emission factor is a coefficient that quantifies the emissions released per unit of activity or
output. It is used extensively in environmental science, engineering, and regulatory contexts
to estimate the amount of pollutants or greenhouse gases emitted into the atmosphere from
various sources.

An example of an emission factor is Carbon dioxide (CO.) emissions from the combustion
of diesel fuel. Its value, for example, is 2.68 kilograms of CO, per liter of diesel fuel burned.
If an organization consumes 10,000 liters of diesel fuel in a year, the total CO, emissions
can be estimated as: Total CO, Emissions=Diesel Fuel ConsumedxEmission Factor. Total
CO, Emissions=10,000 litersx2.68 kg CO./liter. Total CO, Emissions=26,800 kg CO.. So, the
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organization would emit approximately 26,800 kilograms (or 26.8 metric tons) of CO, annually
from diesel fuel combustion.

Following are some uses of emission factors.
« Estimation of emissions
« Environmental reporting and disclosures

« Life cycle assessment

Audit tracking is enabled by default on Emission Factor tables, ensuring that all modifications are
systematically recorded in a audit log. Access to this log is restricted to authorised users, who
can review detailed entries for compliance and traceability. The audit log captures:

« User details initiating the change
« Timestamp of the modification
« Type of change performed

« Modified data entries

Emission activity

An emission activity refers to any process or action that produces pollutants or greenhouse
gases released into the atmosphere. These activities can occur in various sectors such as
industry, transportation, agriculture, and residential areas. Some examples of emission activities
are:

« Burning coal in a power plant to generate electricity.
« Cement production.

« Activities such as livestock farming.

Emission activity sources

Emission activity sources provide data and methodologies to estimate greenhouse gas (GHG)
emissions from various activities. These sources can be categorized based on the type of activity
and the pollutants they emit. Some examples of emission activity sources are:

» Greenhouse Gas (GHG) emission sources
« Department for environment, food and rural affairs (DEFRA )
 Environmentally extended input-output models (EEIO)

« Emissions and generation resource integrated database (eGRID)

Related topics

Set up the emission factor library

Usage of emission factors in a calculated metric definition

When using an emission factor in a calculated metric definition (CMD), follow the specified
guidelines to confirm accurate results.
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1. Date alignment:

o The start and end dates of your metric data must fall within the date range specified by the
emission factor location.

o If your metric data start and end dates aren’t within this range, the calculation defaults to a
value of 0.

2, Location matching:

© The location associated with your metric data must match the location specified for the
emission factor.

o If these locations don’t match, the system checks the parent location of the metric data. If
the parent location matches an emission factor location, that emission factor value is used in
the calculation.

o If the location matches but doesn’t fall within the valid date range of the emission factor
location, the parent hierarchy of the location isn’t checked for calculations.

3. Updating emission factor for older CMD's:

o Older emission factors does not have a recalculate button, making it challenging to update
linked CMDs when emission factor values changes. While newly created CMDs offer a
recalculate option when emission factors are updated, existing CMDs don't have this
capability. To address this limitation, refer to Enable recalculation for historical CMDs &
to update older CMDs and enable the recalculate button, ensuring they refiect the latest
emission factor values.

o When you update an emission factor value and recalculate it, the system automatically
reruns the calculations when a scheduled job automatically recalculates the data. This
recalculation applies to the relevant dates within the emission factor's validity period.
This confirms that CMD metrics data and CMD data are always up to date with the latest
calculations, providing more accurate and reliable insights.

By verifying both the date and location alignment, you can accurately build your formulas for
calculations.

Forecasting planning and analysis

You can use the forecast planning and analysis feature to simulate various scenarios. The
forecast planning and analysis tools enable for the creation, saving, visualization, and
comparison of multiple analyses, enabling better planning.

You can install Forecast planning analysis from the ServiceNow Store. After installation, you can

navigate to Forecast planning analysis by selecting the list icon =,

Analysis contexts

An analysis context is used to group different analyses for a specific use case. This context
enables you to organize and manage multiple analyses within a single, cohesive structure.
Creating an analysis context involves selecting a metric definition or a metric that you want to
simulate and specifying the number of periods to forecast and the number of previous periods
of data to use. By setting up an analysis context, you can help confirm that all relevant analyses
are considered and compared systematically, providing a comprehensive view of potential
outcomes.
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o Note: You can choose a manual, automated, or calculated metric definition when creating
analysis contexts. You must have at least 12 periods of historical data for forecast planning
analysis. This provides the necessary foundation for simulating different analyses.

Analysis creations

An analysis is a simulation that models different outcomes based on specific interventions or
changes. After creating an analysis context record, you can create different analyses. You can
create the analysis by selecting the forecast method and adjusting the formula parameters.
These analyses can be used to compare the outcomes with other analyses and make informed
decisions for future planning.

Forecasts

After creating an analysis record, a standard forecast graph and adjustable parameters are
generated. This standard forecast acts as a baseline, showing how the metric would likely
perform if no external changes were made. The original values used for the forecast are
displayed for each of the parameter fields. In the following example a calculated metric definition
is used to display the forecast model.

The following example shows a generated standard forecast.

Example of importing a template

Best case © Regenerate forecast save | m
Record type State Metric definition Analysis context
Analysis In progress  Emissions from em... Employee commut...
Details Emission factor analysis (4) Forecast
Input | =
Formula
: ’ Period e
Total employees * % of employees using car * EF for cars * Number of working days in office * 15) + ( Total employees * % of employees using bus * EF —
for bus * Number of working days in office * 20) + ( Total employees * % of employees using rail * EF for train * Number of working days in 2025-12-31 hd
office * 30) + (Total employees * % of employees commuting by foot * EF for walking * Number of working days in office * 2) )
Original values used for forecast are
displayed for each of the fields below,
update it to visualise the deviation.
Total employees
27779.66
00,0 % of employees using car
0.44
/
Number of working days in office
7 89.95
0.0 % of employees using bus
0.32
/
g % of employees using rail
000 - —
2013 2014 2015 2017 2018 2019 202 0 2022 0 6 0.17
% of employees commating by foot

You can create forecast interventions, to explore different possible outcomes by updating input
parameters. A graph is generated showing the standard forecast and the new adjusted forecast.

The following example shows a generated standard and adjusted forecast.
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Example of importing a template

Best case © Regenerate forecast Save wm

Record type State Metric definition Analysis context

Analysis In progress  Emissions from em... Employee commut...
Details Emission factor analysis (4) Forecast
Formula
Input P
( Total employees * % of employees using car * EF for cars * Number of working days in office * 15) + ( Total employees * % of employees using bus * EF
for bus * Number of working days in office * 20) + ( Total employees * % of employees using rail * EF for train * Number of working days in
office * 30) + (Total * % of c by foot * EF for walking * Number of working days in office * 2) )

Formula parameters

B 2025-12-31 (B

Total employees.
30000

Number of working days in office
140

]

- 2 b B 2026-12-31
4000000.00 7// / Total employees

_— \
B
\
\
\

32000
500000.00 \ /
\ / Number of working days in office
000 — 160
2013 2014 2015 2016 2017 2018 2019 2020 2021 2022 2023 2024 2025 2026

I | Adjusted forecast | Standard hf!asll

After creating and publishing multiple analyses and forecasts, you can compare the analyses
and view a graph that captures the data for each analysis you select.

[ ] Note: After publishing an analysis and forecast, you can't change the parameters.

By comparing these analyses, you can better understand the potential impacts of your
decisions, aiding in more strategic and informed planning.

The following example shows a generated comparison graph for two different analyses.

Example of a Comparison

S Lst > Create New Analysis context > Analysis context: Employee commuting forscope 3 >  Forecast comparison

Comparison - Graph View

Salactonid /
12000000.00

10000000.X / &

8000000.0¢

6000000.00
2000000.0¢

| Bestcase Worst case

() Note: You can select up to five analysis records for comparison. If the selected analysis
have adjusted values, those are plotted in the comparison. Otherwise, the standard
forecast values are plotted.

Related topics
Set up analysis contexts and analyses
Create an analysis context

Create an analysis
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Adjust parameters

Create a forecast comparison graph

Configuring ESG Management

As an administrator, use this section to set up the ESG Management application. You must first
create your material topics, your goals and targets, emission activities, and emission factors. You
can then create entities and entity types for which you want to report the metrics and measure
the ESG performance of your organization.

ESG Management implementation

Use the steps in the ServiceNow® ESG Management application checklist to download the ESG
Management from the ServiceNow Store, and get it ready for operation. Mandatory and optional
setup steps, as well as an implementation checklist are provided to simplify the setup.

The flow of mandatory steps in the checklist is illustrated here.
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Implementation workflow for ESG Management

O) Install the ESG Management application from the Servicenow Store

Create material topics

g:z Create goals

@ Create targets

— . .

29 Create entity and entity types
Define metric definitions

= Define metrics

Provide data for metrics

Create disclosures

Integrate with other apps such as Watershed, PPM and IRM (optional)

D Import citations (optional)
2
G

Install ESG Management

You can install the ESG Management application (sn_esg) if you have the sys_admin roleThe
application includes demo data and installs related ServiceNow ™~ Store applications and plugins
if they are not already installed.
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Before you begin

« Ensure that the application and all of its associated ServiceNow Store applications have valid
ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product

or application &.

« ESG Management requires the following ServiceNow Store applications. Ensure that these
applications are installed before you install ESG Management.

Required ServiceNow Store applications
GRC: Profiles

The GRC: Profiles application is a set of common components
shared by the GRC suite of applications. The application includes
common architecture, issue management, and indicators.

GRC: Common Workspace Elements

The GRC Base Workspace is the container of all the shared seismic workspace
parts among GRC applications.

Goal Framework

The Goal Framework application enables you to add goals that track your
progress towards your chosen material topics.

GRC: Metrics

The GRC: Metrics application enables you to define the metrics that are used to
assess, compare, track, and report the performance of the other applications.

Microsoft 365 for ServiceNow Reporting

The Microsoft 365 for ServiceNow Reporting (sn_esg_msoff_intg) provides
disclosure reporting capabilities to ESG reporting managers to seamlessly report
ServiceNow ESG Management system data, list reports, charts, pivot, and multi
pivot reports using Microsoft Word.

() Note: With the ESG Management application, you can use the authority documents and
citations in the GRC: Policy and Compliance Management application and entities in the
GRC: Profiles application.

Role required: admin

About this task

The following items are installed with ESG Management:
» Roles

» Scheduled jobs

e Tables

For more information, see Components installed with ESG Management.

Procedure
1. Navigate to All > System Applications > All Available Applications > All.
2. Find the ESG Management application (sn_esg) using the filter criteria and search bar.

You can search for the application by its name or ID. If you cannot find the application, you
might have to request it from the ServiceNow Store.
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Visit the ServiceNow Store B website to view all the available apps and for information about
submitting requests to the store. For cumulative release notes information for all released
apps, see the ServiceNow Store version history release notes &.

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or
need to be installed. If any plugins or applications need to be installed, you must install them
before you can install ESG Management.

4. Optional: If demo data is available and you want to install it, select the Load demo data check
box.
Demo data comprises the sample records that describe application features for the common
use cases. Load the demo data when you first install the application on a development or test
instance.

5. Select Install.

Complete the entitlements for ESG Management
After you install the ESG Management application from the ServiceNow® Store , you must
complete the entitlements to gain complete access to the application and use it.

Before you begin
Role required: admin

Procedure

1. Navigate to ServiceNow® Store.

2. Search for and select Environmental, Social, Governance Management.

3. Optional: On the product page, to change the version, select the Other App Versions link.
a. To view the details of the other versions, select any version.
b. Select View Details.

4. Select View Products.

5. Select Environmental, Social, Governance Management.

6. To entitle all instances to the applications, select Opt-in.
The eligible list displays all the application dependencies you are licensed for.

7. Select the option to agree to the ServiceNow® terms and conditions.

8. Select Accept.
A checkmark appears next to the product name, and the Manage Entitlements button
appears.

9. Optional: Select Manage Entitlements to change the instances affected by the applications
to which you are entitled.

10. After you agree to the ServiceNow® terms and conditions and manage the entitlements, you
can entitle the other products with a single click.

Setup checklist for the ESG Management application

This checklist includes the set up tasks that you are required to complete in your ServiceNow
Al Platform® instance. When you have completed these tasks, the base system is ready for
operation.
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Before you begin
Role required: none

Consider creating and printing a PDF of this checklist topic. You can then check off tasks as you

¢

complete them. To generate a PDF, click the Save As PDF —~icon and at the top of the topic and

click Selected topic.

ESG Management application checklist

O

U
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A user with the sn_esg.program_manager
role, can download and install the ESG
Management application. For details, see
Install ESG Management.

A user with the sn_esg.program_manager role
performs the following tasks:

« Creates material topics

» Creates goals

» Creates targets

» Creates an emission activity

+ Creates an emission factor

A user with the sn_esg.program_manager
role also manages entities and performs the
following tasks:

» Creates an entity
«» Creates an entity type

» Creates an entity class

A user with the sn_esg.metrics_manager role
defines the various types of metric definitions
and metrics. This user performs the following
tasks:

+ Creates an automated metric definition
+ Creates a manual metric
» Creates a composite metric definition

+ Create a metric

A user with the sn_esg.data_owner role can
provide data for the manual metrics data tasks
and a user with the sn_esg.program_manager
can override the data that is provided. For
more information, see Provide data for a metric
data task

A user with the
sn_esg.reporting_disclosure_manager,

sn_esg.program_manager roles can create
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ESG Management application checklist (continued)

disclosure. Disclosures enable the investors
to make informed decisions about the
companies, their risk posture, sustainability
standards, and ESG Management compliance.

D Optionally, users of the Install ESG
Management application can integrate
with other applications such as Project
Portfolio Management and Integrated Risk
Management. These integrations provide
more features and capabilities. For more
information, see Integrating ESG Management
with other applications

Create a material topic

Create material topics for your organization so that you can identify the areas where you want to
make an ESG impact.

Before you begin
Role required: sn_esg.program_manager

About this task
Material topics are topics that reflect the organization’s most significant impacts on the economy,
environment, and people. After you create a material topic, you must send the topic for approval.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Material topics.

2. Select New.
3. On the form, fill in the fields.

Material topic form

Field Description

Name Name of the material topic. For example,
Climate and Energy.

Classification Category of the material topic. Choices are
the following:

o Environmental
o Social
o Governance

Approver Person responsible for the review and for
approval of the material topic.

State State of the material topic. This field is
automatically set to Draft.
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Field Description

Importance to business success Effect of the material topic on the business
success. Choices are the following:

o None

o Very important

© Important

o Moderately important
o Slightly important

Importance to stakeholders Importance of the material topic for the
stakeholders. Choices are the following:

© None

© Very important

© Important

o Moderately important
o Slightly important

Url Links to any online information that the teams
may use.

Priority Priority of the material topic. Choices are the
following:

o None
o High
o Moderate

° Low

Description Brief description of the material topic.

4, Select Save.

5. To send the topic for review, select Ready for Review.

6. To mark a material topic as confidential, in the Security section, select the Confidential option.
a. In the Allowed users field, select the users who can view the record.

b. In the Allowed groups, select the groups that can view the record.

This Security section only appears ifthe sn_grc. enable_record_confidentiality
property is enabled under GRC properties. By default, the logged-in user is added to the list of
confidential users.

Result
The material topic is sent to the approver. The state changes to Review.

What to do next
Create a metric
Approve or reject a material topic

Review and approve or reject a material topic if it is assigned to you for approval.
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Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Tasks > My
pending tasks > Material topics.

2, Open the material topic to review.

3. To approve or reject the topic, set the State field to one of the following.

To approve Select Approve.
To reject ‘ Select Reject.
4, Click Save.
Result

If the material topic is approved, its state changes to Monitor. If the topic is rejected, the state
changes to Draft.

Create an ESG goal

Establish environmental, social, and governance (ESG) goals to track your progress toward your
chosen material topics.

Before you begin
Role required: sn_esg.program_manager

About this task
After you create a material topic, you must also create goals to track your progress toward the

material topic. After you create a goal, you can do the following:
« Assign targets to track the progress of goal achievement.

« If you integrate with Integrated Risk Management, you can add policies. You can also monitor
the goal-related risks, policy and control compliance, and issues that are due. This integration
enables you to create policies and implement controls to reinforce company goals.

« If you integrate with Project Portfolio Management, you can add programs and projects for the
goal.

For more information, see Goal framework B

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Goals.

2. Click New.
3. On the form, fill in the fields.

© 2026 ServiceNow, Inc. All rights reserved. 40
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


https://www.servicenow.com/docs/access?context=goal-framework&version=xanadu&pubname=xanadu-it-business-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=goal-framework&version=xanadu&pubname=xanadu-it-business-management&ft:locale=en-US
https://www.servicenow.com/docs/access?context=goal-framework&version=xanadu&pubname=xanadu-it-business-management&ft:locale=en-US

servicenow.

Goal form

Field Description

Name

Classification

Start date
Owner

Status

State
Category

End date
Contributors

Progress

© 2026 ServiceNow, Inc. All rights reserved.
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Name of the goal. For example, Climate
change strategies.

Category of the goal. Choices are the
following:

o Environmental

o Social

°o Governance

Start date for the goal.
Person who owns the goal.

Status to indicate the goal progress. Choices
are the following:

° Red

° Yellow

°© Green

State of the goal.

Category to which the goal belongs. Choices
are the following:

o Total Applications

o Total Cost

o Opex

o Capex

o Cloud Applications

o Homegrown Applications
o Support Cost

© Labor Cost

o Standards Compliance

o Strategic

o Operational

o Tactical

End date for the goal.

Users contributing to the goal.

Percentage complete for the goal. The
progress value is calculated automatically.

For more information, on how the progress
value is calculated, see Goal progress value
calculation.
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Description
Description Description of the goal.
4, Click Save.
What to do next

To view the goal's relationship with other sub goals, targets, metric definitions, and so on, click
360° view.
Related topics

Goals overview in the ESG Workspace

Goal progress value calculation

The progress or percentage complete value of goals is auto-calculated using different formulas.
The formula depends on whether the goal has only targets, a combination of sub-goals and
targets, and if it has weighted average calculation enabled.

Scenario Formula used to calculate the progress value of the goal

Progress value of the goal = Sum of
progress values of its associated
» The goal doesn’t have sub-goals. targets / number of targets

* The goal has targets.

« No weight scale defined for
targets.

Progress value of the goal = Sum of
progress values of its sub-goals and
associated targets / number of sub-
» No weight scale defined for sub- goals and targets

goals and targets.

« The goal has sub-goals and
targets.

Progress value of the goal = [(Progress
of target 1 * Weight scale of target 1)
+ (Progress of target 2 * Weight scale
» The goal doesn’t have sub-goals. of target 2)] / (Weight scale of target
1 + Weight scale of target 2)

« The goal has two targets (target 1
and target 2).

« Weight scale defined
for targets and the
sn_gfweighted_average_enabled
system property is set to Yes.

Progress value of the goal = [(Progress
of sub-goal 1 * Weight scale of sub-
goal 1) + (Progress of sub-goal 2 *

« The goal has two sub-goals (sub- Weight scale of sub-goal 2) + (Progress
goal 1and sub-goal 2). of target 1 * Weight scale of target 1)
« Weight scale defined for sub- + (Progress of targgt 2 * Weight scale
goals and targets and the of target 2)] / (Weight scale of sub-

sn_gfweighted_average_enabled gogl 1 + Weight scale of sub-goal 2 +
Weight scale of target 1 + Weight scale

of target 2)

« The goal has two targets (target 1
and target 2).

system property is set to Yes.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

42



servicenow.

Migrate existing goals data to Goal Framework

With the admin role, you can migrate the existing goals data to the Goal Framework tables by
running the scheduled job.

Before you begin
Role required: sys_admin

About this task

If you are an existing user of IT Business Management, then you must migrate your existing goals
to the Goal Framework. New customers automatically have the new framework and they do not
need to run the job mentioned in this procedure.

Procedure
1. Navigate to All > System Definition > Scheduled Jobs.

2. Search and click the Migrating Goal, Strategy, and related Work Item data to the new tables
scheduled job.

3. On the Scheduled Script Execution form, perform the following steps:
a. Ensure that the frequency is selected as On Demand in the Run field.

b. Set the value to true for the required parameters in the Run this script field.

Parameter Description

migrateGoalData » Migrates all existing goal records from the Goal [goal]

table to the Goal [sn_gf_goal] table. The sys_ID
remains the same. The corresponding target records
will be created in the Target [sn_gf_goal_target] table.

= Creates the existing relationship between the goal
and work items (Project, Demand, Program) in the
Goal Relationship [sn_gf_goal_m2m_relationship]
table with the first goal as the primary goal.

@ Note: Only existing goal records that have the
Direction field populated on the Goal [goal] table
are migrated to the Goal [sn_gf_goal] table.

migrateStrategyData Migrates all existing strategy records from the
Enterprise Strategy [enterprise_strategy], Business
Unit Strategy [business_unit_strategy], and Strategic
Obijective [strategic_objective] tables to the Strategic
Priority [sn_gf_strategy] table. The sys_ID remains the
same.

migratingGoalStrategyM2Mdata In Goal Framework, a goal can be mapped to only one
strategy. If an existing goal has two strategies mapped
to it, a clone of the goal will be created (one as a generic
goal and another as a sub-goal) with the same strategy
populated for both. And, for the sub-goal, the first goal
will be set as the parent goal.

For example, consider a scenario where an existing goal
(G1) is mapped to five strategies (S1, S2, S3, S4, and S5).
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Parameter Description

Then, four clones of G1 will be created as sub-goals (G2,
G3, G4, and G5) and the parent goal is populated as G1.
For the sub-goals (G2, G3, G4, and G5), the Strategy
field is populated respectively (S1, S2, S3, S4, and S5).

@ Note: The name of the cloned sub-goal will be
prefixed with Cloned SubGoal :, followed by
the parent goal name.

migrateStrategyWorkltemRelData Migrates the existing relationship of strategy and

work items (Project, Demand, Program) to the Goal
Relationship [sn_gf_goal_m2m_relationship] table.

= |f a goal does not have an association between the
strategy (as current strategy) and the work item in the
Goal Relationship [sn_gf_goal_m2m_relationship]
table, a dummy goal will be created with a strategy
value of current strategy. And, a goal relationship is
created with the dummy goal and the work item in the
Goal Relationship [sn_gf_goal_m2m_relationship]
table.

@ Note: The name of the dummy goal will be
prefixed with Goal :, followed by the strategy
name.

4. Click Execute Now.

Display the priorities and goals on the project form

If you are an existing user, configure the project form to upgrade to the Goal Framework. The
benefit of the Goal Framework is that it enables you to set targets for goals. You can also define
strategic priorities and associated goals as part of the organization's strategic plans.

Before you begin
Role required: sys_admin

About this task
If you have preconfigured forms, you must do this configuration to make the new framework
features and fields available. The following images show the form fields before and after
configurations.

Before configuration of new fields

Dates Details | BusinessCase | Financials Score Notes Preferences
Strategies @

e
After configuration of new fields
Dates Details BusinessCase Financials Score Notes Preferences

The same procedure can be performed on the Demand and Program forms as well. For more
information, see Goal framework &.
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Procedure
1. Navigate to All > Project > Projects > All.
2. Open a project.

3. Click the additional actions icon (E) and do the following:
a. Click Configure.

b. Click Form Layout.

c. Under the Form view and section, set the View name field to the view that has the goal and
strategy Glide list.

d. Under the Form view and section, set the Section field to Business Case.

e. In the Available list, select Primary goal [+] and click the tree workfow icon ( ™).

£ In the Available list, double-click Strategic priority [+].
The Selected list shows Primary goal.Strategic priority.

g. Click Save.

Repeat this step for all the views that have the goal and strategy Glide list, such as Score and
Financial.

Resulit
The Project form shows the Strategic priority field and the Primary goal field.

Map a goal to a material topic

Map a goal to a material topic so that you can track the actions being taken for the chosen topic.
Based on this mapping exercise, you can act on the goals with the most significant material

impact.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Material topics.

2. Open the material topic to which you want to map a goal.
3. To add a goal, do the following:

a. Click the Goals related list.

b. Click Add.

¢. Select the goals to add.

d. Click Add.

e. Click Save.
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Result
The goal is mapped to the material topic. This goal can now track the progress toward your
chosen theme or topic.

Associate entities to goals
After you create the goals, you must associate those entities, which you want to track, to the
goals.

Before you begin
Role required: sn_esg.program.manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Goals.

2, Open the goal for which you want to add the entities.
3. Select the entities related list.
4. Select Add.

a. Select the entities to add.

b. Select Add.

Create an ESG target

Create an environmental, social, and social (ESG) target to help track the progress towards your
ESG goal.

Before you begin
Role required: sn_esg.program_manager

About this task

When you create a target, you can use the target to see how well you are meeting your goals. You
can treat the status of the target as a report card about your goals. After you create a target, you
can create and collect metrics to measure whether the targets are met.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Targets.

2. Click New.
3. On the form, fill in the fields.

Target form

Name Name of the target. For example, Launch
diversity programs each
quarter.

Goal Goal that this target will track.

Start date Date the target begins

Owner Owner of the target.
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Field Description

Type Target type that shows the direction of
achievement. Choices are the following:

o Maximize: The direction of the progress
is towards the Target value from the Base
value. The base value must be less than
the target value.

o Minimize: The direction of the progress is
towards the Target value from the Base
value. The target value must be less than
the base value.

o Milestone: Fixed type. Only the progress
field is available. The values of the field
(0100) capture the achievement of a

milestone.
State State of the target.
Status Status to indicate the target progress.

Choices are the following:
o Green: Indicates that the target is on track.

o Yellow: Indicates that the target needs
improvement.

o Red: Indicates that the target needs
immediate attention.

End date Date when the target ends.
Contributors Users who contribute to achieving the target.
Check in frequency Option to specify how frequently should the

owner or contributor be updating the actual
value of the target. The available options
are Daily, Weekly, Fortnightly, Monthly, and
Quarterly.

Measure Measure type for the specified value. The
available measure types are stored in the
Units [sn_gf_units] table.

Base value Base value of the target. The base value can
also be considered as the present or current
value.

Actual value Actual value of the target at a given time. This

field is available only when the Type field is
set to Maximize or Minimize.

Target value Target value of the target. This value is the
goal that your team wants to reach. This field
is available only when the Type field is set to
Maximize or Minimize.

Progress Percentage of target that is complete. This
value is calculated automatically.
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Field Description

If the Type field is set to Maximize, then
the progress value is calculated using the
following formula.

Progress = (Actual value -
Base value) / (Target value
- Base value) x 100

If the Type field is set to Minimize, then
the progress value is calculated using the
following formula.

Progress = (Actual value -
Target value) / (Base value
- Target value) x 100

Weight scale A numerical value that represents the
importance of the target relative to the other
targets of the goal. If there are any sub-
goals present, they are also considered for
relative weights and consequent progress
calculation. By default, the weight scale is 1.

© Note: This field is
available only when the
sn_gfr.weighted_average_enabled
system property is set to Yes.

Source for target The metric definition or the metric that acts
as a source of the target. This field only
appears when the Type field contains either
Maximize or Minimize. For information on
how to add a source, see Add a source for a
target.

4. To mark a material topic as confidential, in the Security section, select the Confidential option.
a. In the Allowed users field, select the users who can view the record.

b. In the Allowed groups, select the groups that can view the record.

This Security section only appears ifthesn_grc. enable_record_confidentiality
property is enabled under GRC properties. By default, the logged in user is added to the list of
confidential users.

5. Click Save.
The Metric Definitions and the Metric related lists appear.

6. To add a metric definition, do the following:
a. Click the Metric Definition related list.
b. Click Add.
c. Select the metric definitions to add.
d. Click Add.

Result
The target with metric definitions is created.
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Add a source for a target

After you create a target, you must add a source for the target. The source can be a metric or a
metric definition that contributes to the parent target.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Targets.

2, Select and open the target for which you want to add the source.

3. From either the Metric Definitions or the Metrics related list, select the metric definition or the
metric that you want to set as the source for the target.

Q = List > Target: Achieve net zero carbon emissions globally to 8...
Achieve net zero carbon emissions globally to 80... © (-]
:::] Start date End date Owner State
2021-06-05 2026-06-04 Oliver Jones ~In Progress
Details ~ Metric Definitions (5) ~ Metrics
5
Metric Definitions [5 v l Add as target source l l Remove (1) l m Goals and Targets Hierarchy
Last refreshed just now.
v Accelerate ® In Progress
] Metric definition 7 Unit Frequency Enterprise owner Class Decarbonization
4 Gettonet ® In Progress
@  Corporate grants $ Annually Jude Haza Metric Definition zero by 2030
[]  Employee donation participation % Daily Jude Haza Metric Definition @ ::1";:"" Clilos
[ Approach to Stakeholder Engagement (empty) Annually Oliver Jones Metric Definition bzl
- operations
[]  Employee donations $ Annually Jude Haza Metric Definition sl
starting in
[J  Employee engagement % Annually Elisa Gracely Metric Definition 20z
4 Source ® In Progress.

4. Select Add as target source.

Set up the emission factor library

To calculate your emissions accurately, you must set up your emission factor library. The
emission factor library consists of emission factors, emission activities, activity sources and
factor locations.

Create a new emission activity
Create new emission activities to track the activity that leads to emissions if you do not want to
use the standard emission activities provided through the ESG content accelerator application.

Before you begin
Role required: sn_esg.program_manager, sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Emission Factor Library > Activity.

2. Select New.
3. On the form, fill in the fields.

Emission activity form

Description
Name Name of the emission activity. For example,
Cars.
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Description
Type Type of activity. For example, Luxuzry.
Subtype Subtype of the activity. For example,
Diesel.

4. Select Submit.

Import emission activities and map their locations

Use the ESG content accelerator application to import the standard emission activities and

add their locations. These emission factors identify which activities within your organization are
producing specific amounts of pollution. The reason you must add locations to a factor is that an
organization may have different locations and each location may have a different factor value for
different periods.

Before you begin
Role required: sn_esg.program_manager, sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Content
accelerator.

2. Select the Emission factors tab.

3. Select the emission factor that you want to activate or update.

4, Select either Update or Activate.

5. Select Agree for the disclaimer.

6. Select the emission activities that you want to import in your system.

7. Select Next.

8. Optional: In the Map existing location column, select the location for each activity.
9. Select Submit.

Result
The emission activities are mapped to the emission factor sources and the factors are ready to
be used in calculate metric definitions.

Create an emission factor

Create your own custom emission factors if you don’t want to use the standard emission factors
provided by the ESG content accelerator application. An emission factor is a representative
value that relates the quantity of a pollutant released to the atmosphere with the activity
associated with the release of that pollutant.

Before you begin
Role required: sn_esg.program_manager, sn_esg.admin

About this task

An emission factor is a coefficient that enables conversion of activity data into emissions. It’s the
average emission rate of a given source, relative to the units of an activity or process. When you
create an emission factor, you can select the unit from which you want to convert the data into
the unit that you want to use to measure your emissions. For example, you can convert miles,
which is the activity data, to the emissions the activity causes.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Emission Factor Library > Factor.

2. Select New.
3. On the form, fill in the fields.

Emission factor form

Field Description

Name Name of the emission factor. For example,
Cars-Mini-Diesel-miles-KgCO2e.

From unit Unit in which the data is collected.
To unit Unit to which the data must be converted.
Emission activity Emission activity or source of the factor.

4. Select Submit.

Result

« Two related lists are now available on the emission factor: 'Emission Factor Location, which
was previously available and displays linked locations, and 'Calculated Metric Definition), a
new addition that displays linked calculated metric definitions.

« You can now use this emission factor in a calculated metric definition.

Add locations to an emission factor

Add locations to an emission factor after you create the factor. The reason you must add
locations to a factor is that an organization may have different locations and each location may
have a different factor value for different periods.

Before you begin
Role required: sn_esg.program_manager, sn_esg.admin

About this task

Usually, the factors are obtained from standard sources such as the Greenhouse Gas (GHG)
protocol. Each factor for a location is effective for a specified time period. When you add
locations to an emission factor, you specify the factor value for that particular location.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Emission Factor Library > Factor.

2, Open the emission factor for which you want to add locations.
3. In the Emission factor locations related list, select New.

4. On the form, fill in the fields.
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Emission factor location

Field Description

Emission factor Name of the emission factor for which you are
adding the location. This field is automatically
set.

Effective from Date the emission is effective from.

Effective to Date until which the emission would last.

@ Note: If you do not specify the end
date, then the factor value is applied
indefinitely.

Location Location of your emissions.

@ Note: If you do not specify a location,
then the factor value applies to all the
locations of your organization.

Value Value for the factor. For example, if natural
gas emits 0.375 kg CO2eq/kWh ICV, then you
can provide 0.375 as the value.

5. Select Submit.

Example: Calculation logic for a location

Each location may have a parent location. For example, if your location is Tokyo, the parent
location of Tokyo is Japan. Similarly, the parent location of Japan is Asia Pacific. If you select a
parent location such as Japan in the Location field and specify the value as 1.5, then the metrics
are calculated using the value of 1.5 for any location that does not have a record but has the
parent location as Japan. Similarly, if you select Asia Pacific in the Location field and specify the
value as 2.5, then the metrics are calculated using the value of 2.5 for any location that does not
have a record but has the parent location as Asia Pacific.

Recalculate emission factor

When an emission factor value is updated, you can initiate the recalculation of the calculated
metric definitions to which the emission factor is associated to. This ensures that metrics data
remains consistent and accurate, reflecting the latest changes.

Before you begin
Role required: sn_esg.program_manager, sn_esg.admin

About this task

For immediate updates, you can manually execute a CMD by opening it and selecting
'Recalculate) it is added to a process queue where a scheduled job automatically recalculates
the data.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Emission Factor Library > Factor.

2. Open the emission factor that is updated and for which you want to recalculate the data.

3. Select Recalculate.
To recalculate data for all calculated metric definitions linked to an emission factor, use the
'Recalculate’ button on the emission factor's detail page.

Related topics

Usage of emission factors in a calculated metric definition

Create a new schedule

Create a schedule or modify an existing schedule to calculate the due date for metric data tasks.

Before you begin
Role required: admin

About this task

Using schedules, you can specify that the due date for a metric data task. For example, you can
specify that the due date does not fall over a weekend or a holiday. Another example could be
that you can specify your working hours so that the due date automatically is set based your
specifications. By default, the 8-5 weekdays schedule is used to set the due date.

Procedure
1. Navigate to All > Environmental, Social, and Governance > Administration > Schedules.

2. Select New and provide a unique and meaningful Name and Description, and then fill in the
form.

For detailed information on Schedule form fields, see Schedule fields &.

Create related list groupings

Simplify the groupings of related lists on a record page and customize them to your specific
needs, assigning meaningful names in the process. This configuration enhances readability and
user experience when interacting with the forms.

Before you begin
Role required: admin or sn_grc_workspace.record_view_admin

About this task

On a form there can be numerous related lists that can occasionally result in a cluttered view.
To streamline the display, you have the option to select and configure the related lists you want
to see on the form. By default, the ability to configure the related lists is given for the following
tables:

« Calculated metric definition table
e Goal table

« Manual and automated metric definition table

While you can select any table and configure the related lists for that table, as an example, this
procedure describes how you can create groupings for the Goal configuration table. Apart from
the related lists, you can also specify a UX page that you want to display under a group.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > Administration > Record View
Configurations.

2. Select ESG workspace configuration.

3. In the Table configurations related list, select Goal configuration.
4, In the Group configurations related list, select New.

5. On the form, fill in the fields.

Group configuration form

Field Description

Table configuration Name of the table for which you're
configuring the related list. This field is
automatically set.

Name Name of the group that will be displayed on
the related list of the form. For example, you
can provide a name suchas Program set

up.
Active Option to indicate if the configuration is
active.
Order Order number of the group on the form.

© Note: If you want to display the order
before the Details tab, then the order
number must be less than or equal to
100.

Condition Conditions that must be met in order to be
displayed on the form. For example, you can
specify that if a goal is of type Environmental,
only then it must be displayed on the form.

6. Select Submit.

7. In the Group configurations related list, select the entry you created.
a. In the Group entries related list, select New.

b. On the form, fill in the fields.

Group entry form

Group configuration Group for which the related list is being
created. For example, in this procedure, the
group for which you're configuring the entry
is Program setup.

Order Order of the entry on the Ul page.
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Field Description

Application Application for which the related list is
being created. This field is automatically
set to Environmental, Social, Governance

Management.
Active Option to indicate if the entry is active.
Type Choice to indicate the type of item the group

will contain. The choices are as follows:
= UX page
= Related list

Related list Related list that you want must appear under
the group. This option appears only when
the Type field contains Related list.

Screen Specific variation or version of a page. This
option appears only when the Type field
contains UX page.

Route The path of the UX screen. This option
appears only when the Type field contains
UX page.

c. Select Submit.

Resulit
The following figure shows grouped related

=Llist > Goal Accelerate Decarbonization

Accelerate Decarbonization © (+]
Record type  Classification Status Owner State
Goal Environmental e Yelow KarlaKen In Progress
Overview | =
Material Topics (1)~ Sub-goals (8)  Targets (4)  Entities (1)
Details _—
1
(R el SED Material Topics [2 v m

Reporting requirements Last refreshed just now

Metrics
] Material topic Classification Priority Importance to business success Importance to stakeholders
Risk posture

s g [0 Climate & Energy Environmental 2 - Important 1 - Very important

lists.

Configure Sustainable IT

Follow the order of the steps to configure the Sustainable IT plugin.

Activate the Sustainable IT plugin

The Sustainable IT is used to effectively manage and monitor the emissions generated by your
hardware assets.

Before you begin
Role required: admin

About this task
For more information, see Components installed with ESG Management.
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Procedure
1. Navigate to All > System Applications > All Available Applications > All.
2. Find the Sustainable IT plugin (sn_esg_sustain) using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to
request it from ServiceNow personnel.

3. Select Install to start the installation process.

Note: When domain separation and delegated admin are enabled in an instance, the
administrative user must be in the global domain. Otherwise, the following error appears:
Application installation is unavailable because another
operation is running: Plugin Activation for <plugin name>.

You will see a message after installation is completed. For information about the components
installed with a plugin, see Find components installed with an application &.

Filter Sustainable IT metric definitions

Apply the filter to obtain the metric definitions that are shipped with the Sustainable IT plugin.
The filter must be applied to all the three types of metric definitions namely manual, automated,
and calculated.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Metrics.
2. Select a type of metric definition.

3. Select the filter icon.

4, Select Advanced view.

5. Build a filter by selecting Group, is, Sustainable IT.

6. Select Update.

Methods to set up entities for Sustainable IT

There are two methods, manual and automatic, to set up your entities for data collection for the
Sustainable IT application. You can select any one and proceed to collect your data.

You can set up the entities in one of the following ways:

« Use the cmdb_ci_datacenter table to create your entities. After you create the entities, you
can add the locations for each entity. For more information, see Create new entities for data
centers. Usually, this method is the preferred method for configuring entities.

« Manually create entities for data centers and add them to an entity type. The entity type is
then added to the metric definitions that enables the metric definitions to collect data from
various data centers. For more information, see Manually set up entities for Sustainable IT data
centers.

Create new entities for data centers

Use the cmdb_ci_datacenter table to create entities for all your data centers.
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Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Scoping
> All Entities.

2, Select New.

3. Ensure that the Refers to existing record option is selected.

4. In the Table field, select cmdb_ci_datacenter.

5. In the Applies to record field, select the data center you want to add.

6. In the Location field, select the data center location from where you want to collect data.
7. In the Class field, select Sites.

8. Add the entity to the metric definition for which you want to collect data.

9. Save the metric definition form.

Result
When the metric definition is executed, the metrics for the selected data center will be collected
and displayed on the Sustainable IT dashboard.

Manually set up entities for Sustainable IT data centers

Create entities for data centers and add them to an entity type. The entity type is then added
to the metric definitions that enables the metric definitions to collect data from various data
centers.

Before you begin
Role required: sn_esg.admin

About this task

To gather emissions data pertaining to your data centers, it is necessary to give a unique name
to your entities and associate a location in such a way that they can retrieve data from all of your
data center locations. For instance, if you wish to utilize the metric definition named Energy from
coal, it implies that you want the coal energy emissions data from four locations, for example,
Bangalore, New York, Paris, and Berlin when the metrics are executed. To accomplish this task,
you need to create entities with names such as New York, Bangalore, and so on. To use the
Sustainable IT application, when you create entities, it is mandatory to add a location to them.
You can then group the entities within an entity type. For example, you can call the entity type
"Data centers." This entity type is then added to the metric definition named Energy from coal.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Scoping
> All Entities.

2, Create new entities with names such as Paris data center.
For information on how to create a new entity, refer to Create an entity. The name that you use
when creating an entity is the name that is displayed on the Sustainable IT dashboard. It is
important to provide a value in the Location field on the entity form. If a particular data center
has multiple locations, you can name the entities accordingly.

3. Create an entity type called Data center.
For information on how to create a new entity, refer to Create an entity type. The name that you
use when creating an entity is the name that is displayed on the Sustainable IT dashboard.
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4, Add the entities that you created to the Data center entity type.

5. Add the entity type to the metric definition that you would use to collect metrics.

Result
When the metrics are executed, data from all four entities is collected and displayed on the
Sustainable IT dashboard.

Configure a map marker

Configure the items that you want to view on the IT footprint map tab of the Sustainable IT
dashboard.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Sustainable IT
> Map marker configuration.

2. Select New.
3. On the form, fill in the fields.

Map marker configuration table

Field Description

Name Name of the configuration.

Metric definition Active metric definition related to Sustainable
IT.

Map marker icon Icon used to represent the configuration on
the map.

Show on map by default Option to show the configuration on the map,
by default, during the initial loading of the
map.

Active Option to mark the configuration as active.

Only active configurations are displayed on
the map during the initial loading of the map.

Entity class Unique entity class of the entities associated
with the selected metric definition.

Default icon color Hex color code of the icon whenit’s
displayed on the map. You can change the
default color that is automatically set in this
field.

4. Select Submit.

What to do next
Define data range configurations. See Map data range configurations.
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Map data range configurations

Define the criteria for classifying map markers based on their metric data values. You can specify
a range of values and assign a corresponding classification and color to markers that fall within
that range.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Sustainable IT
> Map marker configuration.

2, Select and open the map marker configuration for which you want to add the data range.
3. Select New.
4. On the form, fill in the fields.

Map data range configuration

Field Description

Name Name of the data range. For example, High
emission.

Lower interval Lowest value in the range that you want to
set.

Map marker configuration Name of the configuration for which you're
defining the range. This field is automatically
set.

Classification Classification that is assigned to ranges

based on the values within the upper and
lower intervals. For instance, a range of
250000 Co2e emissions can be categorized

as Good.

Upper interval Highest value in the range that you want to
set.

Icon color Hex color code of the icon whenit’s

displayed on the map for the range specified.

5. Select Submit.

Activate or update a framework and install citations using the ESG
content accelerator

Activate or update your chosen framework and select the citations for the framework you've
selected. This will install the framework and the selected citations and metric definitions on your
instance.

Before you begin
Role required: sn_esg.admin
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Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace.
2. Select ESG content accelerator.
3. Select the version for the required framework.
a. Select Activate.
b. Read the disclaimer and select Agree.
4. On the citations page, select the required citations.
5. Select Next.
6. On the metric definitions page, select the required metric definitions.
7. Select Submit.

8. To update a framework, select a framework and select Update.

Filter citations documents for ESG

Set the functional domain to Environmental, Social, Governance to view only those citations
that are specific to the ESG domain. This ability to select the domain enables you to see only
those citations that are relevant to you. The same procedure applies to authority documents as
well.

Before you begin
Role required: sn_esg.reporting_disclosure_manager

About this task

When you view the citations and authority documents in an instance, all the citations and
authority documents that are available are displayed. Not all citations and authority documents
are relevant for your domain. In this case, you can apply a filter to display only those documents
that are specific to your domain. After you apply the filter and a relevant citation or authority
document is not displayed, then it means that the document's functional domain is not set to
Environmental, Social, Governance.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosure requirements > Citations.

2. Select the filter icon.

3. Select Advanced view.

4. Build a filter by selecting Functional domain, contains, Environmental, Social, Governance.
5. Select Update.

Related topics

Create or deactivate a citation &

Configuring the Scope 3 dashboard

To view data on the Scope 3 dashboard, you must configure the emission category types to
define the categories for which you want to report scope 3 data.

The following are the tables that you must configure to view your supplier category, spend
category, and GHG category data on the Scope 3 dashboard. After configuration, the metric

definitions for Scope 3 emissions use the data from these tables.
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Create an emission category type
Create emission category types to define the categories for which you want to report scope 3
data that will be displayed on the Scope 3 dashboard.

Before you begin
Role required: sn_esg.admin and sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > Scope 3 configurations >
Emission category types.

2. Select New.
3. On the form, fill in the fields.

Scope 3 emission category types form

Field Description

Category type Type of category for which you are creating
the record. The choices are as follows.

o Supplier category
© Spend category
o GHG category

Model category Relevant model categories that must be
associated with the category type. For
example, for a Supplier category, you can
select Linux server, rack, and so on as the
model category.

Category name Name of the category.

EEIO emission activity EEIO emission activity associated with the
category type. The selection made in this
field helps in the calculation of the emissions.

Note: You must activate the emission
activities from the ESG content
accelerator application.

4. Select Submit.

Configure the supplier emissions by model table

Configure your supplier emission data collection to capture emissions by specific models of
assets to report and calculate Scope 3 emissions accurately.

Before you begin
Role required: sn_esg.admin and sn_esg.program_manager

About this task

The data that is configured in the supplier emissions by model table is used in the automated
metric definition for supplier data collection. Ensure that data is populated in supplier emissions
by model table before the first run date of the metric definition.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > Scope 3 configurations > Supplier
emissions by model.

2. Select New.
3. On the form, fill in the fields.

Supplier emissions by model form

Field Description

Model Model of your hardware for which you want to
collect data.
Supplier emission factor Measure used to quantify the amount of

greenhouse gas (GHG) emissions produced
per unit of a product or service provided by a
supplier.

Supplier emission factor year Specific year for which the emission factors
provided by a supplier are applicable.
Because the emission factors can vary every
year, select a specific year in this field.

Supplier Name of the supplier.

Supplier emission factor unit Unit of measurement used to quantify the
emissions per unit of activity, material, or
energy consumed. The units supported are
as follows.

o KgCO2e/$: If you select this unit, then the
calculation happens by multiplying the sum
of cost by the dollar.

o KgCO2e/unit: If you select this unit, then
the calculation happens by multiplying the
units by the emission factors.

4. Select Submit.

Create an inflation factor

Create inflation factors for spend-based emission factors to account for price changes over time,
which can otherwise make these factors inaccurate. Spend-based emission factors estimate
pollution based on monetary expenditure. Adjusting spending for inflation before applying the
emission factor ensures a more realistic picture of your emissions footprint.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > Administration > Inflation
Factors.

2. Select New.
3. On the form, fill in the fields.
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InAation factor form

Field Description

Country Name of the country.

@ Note: If you want to create an infiation
factor for the United States of America,
you must provide the country name as
United States.Usingany other
form of naming such as US or USA, will
result in data not being collected.

Inflation factor Value that is used to compare the value of
money across different years. For example, to
find out what a $100 purchase in 2018 would
cost in today's dollars, you would apply the
infAation factor to adjust for the change in
value.

Year Year for which the inflation factor is
applicable.

4. Select Submit.

Manage entities in ESG Management

You can learn about how ESG, which stands for Environmental, Social, and Governance
Management (ESG) is used by the investors and reporting agencies to evaluate different entities
that they want to invest in, such as different business units in an organization.

Entities can be people, processes, departments, or applications. For example, if your goal is to
reduce the carbon emission from the datacenters, then you can consider datacenters as entities.

As another example, assume you’re a company that has subsidiary companies. Your goal is to
measure greenhouse gas emissions (GHG) in your subsidiary companies. Both your company
and your subsidiary companies are your entities. Your company is the parent entity, while the
subsidiary companies are the child entities. Typically, the parent entity handles reporting and
measuring the GHG of the child entities.

As part of your ESG Management strategy, you have to provide disclosures to your stakeholders.
ESG Management disclosures refer to the disclosure of data that relate to an organization's
Environmental, Social, and Governance Management performance. These disclosures concern
the goals, targets, and metrics that are associated with your entities. By using these disclosures
and other metrics, the investors assess and rate the performance of entities based on the ESG
parameters.

A parent entity that has the child entities is said to have downstream entities. Any child entity
that has the parent entities is said to have upstream entities.

After creating the entities, you can tag similar entities by individually defining an entity class for
them or by linking them to an existing entity class.
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Entity classes

Entity classes are used to tag an entity or to add the conceptual information about an entity.
For example, consider a company that has office branches in three cities. The office space is
considered as an entity, while the entity class for these entities is the location of the offices.

Entity types

An entity type is a grouping of entities that is based on filtering attributes. An entity type defines
a set of the entities that have the same attributes. An entity type is used to describe and identify
an entity that is based on a set of filter conditions.

Consider the following two entity types: Employee and Product. Each entity type has its own
attributes.

For Employee, its attributes are employee number, name, department, and designation. In the
Employee table of the company database, the sample attributes of an employee are displayed in
row E1 as 1001 (employee number), Paul (name), Marketing (department), and PM (designation).

For Product, its attributes are product ID, name, cost, and currency. In the Product table in the
company database, the sample attributes of an energy-efficient product are displayed in row P1
as 800 (product ID), Solar Panel (name), 200 (cost), and USD (currency).

Entities and entity types can have a one-to-many relationship. For example, an entity called Hope
can have an entity type called Person and an entity type called Organization.
Related topics

Create an entity

Create an entity

Create an entity and measure its performance against the goals. Defining an entity ensures
that the entity owners are also identified. After an entity is defined, ESG Management goals are
applied to the entity.

Before you begin

Role required: (per product)

« In Environmental, Social, and Governance Management: sn_esg.program_manager
« In GRC: Metrics: sn_grc_metric.manager

« In Risk Management: sn_risk_workspace.|T_risk_manager and
sn_risk_workspace.operational_risk_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Scoping > All
entities.

2. Click New.
3. On the form, fill in the fields.

New entity form

Description

Entity
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Field Description

Refers to existing record Option that refers the new entity to an
existing record.

Table Table to be queried to create an entity.

Applies to record Records that are associated with the selected
table.

Name Name of the entity.

Owned by Details of the owner of the entity such as
system administrator.

Active Option that indicates whether the entity is
active.

Class Name of the class that is associated with the

entity such as Application or Business Entity.

Location Location record of the entity with details such
as address, city, state, and country.

Description Description of the entity.
Compliance

Attestation frequency Frequency of attestations for the controls that
are attached to an entity. The choices are as
follows:

o Daily

°o Weekly

© Monthly

© Quarterly

© Semi-annually

© Annually

4, To save the entity, click Save.

(] Note: On the New Entity form, only the Details tab is displayed. After a new entity is
created, the Overview tab, the Details tab, and other related lists are displayed on the
form.

Result
The entity is created. The New Entity form is displayed with the Overview tab, Hierarchy tab, and
the related lists:

« Entity types

« Downstream risks

» Downstream controls

« Downstream engagements
» Downstream issues

» Downstream tasks

« Policy exceptions
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« Content References

e Goals

() Note: Some related lists appear in the entity form only when certain applications are
installed. For example, the Downstream risks related list appears only when the Risk
Management application is installed. The Downstream engagements related list appears
only when the Audit Management application is installed. The Downstream controls,
Downstream issues, and Policy exceptions related lists appear only if you have the IRM
license.

What to do next
Update an entity

Update an entity

Update the details of an existing entity.

Before you begin
Role required: (per product)

« In Environmental, Social, and Governance Management: sn_esg.program_manager
« In GRC: Metrics: sn_grc_metric.manager

« In Risk Management: sn_risk_workspace.|T_risk_manager and
sn_risk_workspace.operational_risk_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Scoping > All
entities.

2, Click an entity from the list.

3. On the form, update the fields as necessary.

Entity tabs and related lists

Field Description

Tabs

Overview tab Compliance status and risk status of the
entities. Tracking details of the issues,
controls, and policy exceptions. This field is
automatically set to display the overview of
the status and the tracking details.

Details tab Information on the entity. For more
information on the Details tab, see Create an
entity for more information.

Hierarchy tab Upstream entities and downstream entities
for the selected entity. A parent entity that
has the child entities is said to have the
downstream entities. Any child entity that
has the parent entities is said to have the
upstream entities. Select an entity and click
Add to add an upstream or downstream
entity to the parent entity.
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Field Description

Related lists

Entity types

Downstream risks

Downstream controls

Downstream engagements

Downstream issues

Downstream tasks

Policy exceptions

Content References

Goals

Details of the entity type, description,
filter condition for the entity type, and the
compliance score in percentage.

Details of the downstream risk for the
selected entity such as number, name,
entity, class, risk statement, risk assessment
methodology, owner group, and owner of the
entity. To add new risk statements, click Add.
To create a new risk statement, click New.

Details of the downstream controls such as
name, number, entity, control objective, state,
status, exempt, owner, and description. To
add the new downstream controls, click Add.

Details of the downstream engagements
such as name, number, type, parent plan,
state, engagement lead, remaining expense
budget (%), remaining resource budget (%),
and engagement planned start. To create a
new downstream engagement, click New.

Details of the downstream issues, such as
name, number, issue source, issue type,
state, issue manager, assigned to, priority,
and due date. To add a new issue, click New.

Details of the downstream tasks, such as
name, number, parent, state, assigned to, and
planned end date.

Details of the policy exceptions, such as
name, number, state, substate, policy, control
objective, issue, reason, requester, valid from,
valid to, and risk rating.

Details of the content references for the
entity such as content reference, description,
and version. To add new content references,
click Add.

Details of the goals for the entity such as the
goal, owner, state, status, progress, start date,
and end date for the goal. To add a new goal,
click Add.

() Note: Some related lists display in the entity form only when certain applications are
installed. For example, the Downstream risks related list displays only when the Risk
Management application is installed. The Downstream engagements related list displays
only when the Audit Management application is installed. The Downstream controls,
Downstream issues, and Policy exceptions related lists display only if you have the IRM

license.

4. To save the updates to an entity, click Save.

5. To retire an entity, click Retire.
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6. To delete an entity, click Delete.

7. To visually explore the relationship between the upstream entities, downstream entities, entity
class, and entity type associated with the entity, select 360° view.

Create an entity type
Create an entity type for the entities in your system. Entity types enable you to find and create
entities that have the same attributes and that match a set of filter conditions.
Before you begin
Role required: (per product)
« In Environmental, Social, and Governance Management: sn_esg.program_manager
« In GRC: Metrics: sn_grc_metric.manager

« In Risk Management: sn_risk_workspace.|T_risk_manager and
sn_risk_workspace.operational_risk_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace.
2. Under Scoping, select Entity types and click New.

3. On the form, fill in the fields.

New entity type form

Field Description

Name Name of the entity type.

Active Option to set the entity type as active.

Compliance Compliance score of the entity type. The value is a percentage. This field
score (%) is automatically set.

Description Description of the entity type.

4, To save the entity type, click Save.
(] Note: In the new entity type form, only the Details tab is displayed. After a new entity

type is created, the Details tab and other related lists are displayed in the entity type
form.

5. To activate the entity type, do the following:

a. Click Activate.
The following message displays: Are you sure you want to activate this
entity type?

b. To activate the entity type, click OK.

6. To delete the entity type, click Delete.

Result
The entity type is created. The new entity type form is displayed with the Details tab and the
related lists:
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« Entities

« Risk Frameworks

* Risk Statements

« Policies

« Control Objectives
« Entity Filters

« Policy exceptions

e Content References

() Note: Some related lists appear in the entity type form only when certain applications are
installed. For example, the Risk Frameworks and Risk Statements related lists appear only
when the Risk Management application is installed. The Policies, Control Objectives, and
Policy exceptions related lists appear only when the Policy and Compliance Management
application is installed.

What to do next
You can also update an entity type.

Update an entity type

Update an existing entity type to add entity filters, policies, and control objectives.
Before you begin

Role required: (per product)

« In Environmental, Social, and Governance Management: sn_esg.program_manager
« In GRC: Metrics: sn_grc_metric.manager

« In Risk Management: sn_risk_workspace.|T_risk_manager and
sn_risk_workspace.operational_risk_manager

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace.
2. Under Scoping, click an entity type from Entity types.

3. On the form, update the fields as necessary.

Entity type tabs and related lists

Field Description

Tabs

Details tab Information on the entity. See Create an
entity for more information.

Related lists

Entities Details of the entity, the condition for the
entity if it was created manually, and the
compliance score as a percentage.

Entity Filters Details of the entity Filter type, table for the
entity, filter condition of the entity filter, use
owner field, and the owner field.
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Field Description

Risk Frameworks Details of the risk frameworks for the selected
entity type. Click Add to add a new risk
framework.

Risk Statements Details of the risk statements, such as title,

framework, category, and description. Click
Add to add a new risk statement.

Policies Details of the policies, such as name,
number, type, owner, state, valid from, valid
to, and the compliance score in percentage.
Click Add to add a new policy.

Control Objectives Details of the control objectives, such
as category, type, classification, and the
compliance score as a percentage. Click Add
to add a new control objective.

Policy exceptions Details of the policy exceptions, such as
name, number, requester, reason, policy,
control objective, issue, state, substate, valid
from, valid to, and risk rating.

Content References Details of the content references, such as
content reference, description, and version.
To add a new content reference, click Add.

() Note: Some related lists display in the entity type form only when certain applications
are installed. For example, the Risk Frameworks and Risk Statements related lists display
only when the Risk Management application is installed. The Policies, Control Objectives,
and Policy exceptions related lists display only when the Policy and Compliance
Management application is installed.

4., To save the updates to the entity, click Save.
5. To retire an entity, click Retire.
6. To delete an entity, click Delete.

7. To visually explore the relationship between the upstream entities, downstream entities, entity
class, and entity type that is associated with the entity, click 360° view.

Create an entity class

Create an entity class that is to be associated with an entity. Define the parent class, root entity,
and tier for an entity class.

Before you begin

Role required: (per product)

« In Environmental, Social, and Governance Management: sn_esg.program_manager

« In GRC: Metrics: sn_grc_metric.manager

« In Risk Management: sn_risk_workspace.|T_risk_manager and
sn_risk_workspace.operational_risk_manager

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

70



servicenow.

About this task

Entity classes are used to add conceptual information about an entity. Entity classes represent
a collection of entities that have the same attributes such as Department, Business Unit, or
Business Service. You can gather data about an entity based on its entity class.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Scoping >
Entity classes.

2. Click New.
3. On the form, fill in the fields.

New entity class form

Field Description

Name Name of the entity class.

Parent Parent class that is associated with the entity class, such as Company or

class Department.

Is root Condition to check if the new entity class has a root entity. Options are True or
False.

Tier Tier for the new entity class, such as Application or Business.

4, To save the entity class, click Save.

() Note: In the New entity class form, only the Details tab is displayed. Only after an entity
class is created, the Details tab, Entities related list, and Child classes related list are
displayed in the entity class form.

What to do next
Update an entity class

Update an entity class
Update an existing entity class that is associated with an entity. Entity classes are used to add
the conceptual information about an entity or tag the entity.
Before you begin
Role required: (per product)
« In Environmental, Social, and Governance Management: sn_esg.program_manager
« In GRC: Metrics: sn_grc_metric.manager

« In Risk Management: sn_risk_workspace.IT_risk_manager and
sn_risk_workspace.operational_risk_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Scoping >
Entity classes.

2. Select an entity class.

3. On the form, update the fields as necessary.
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Entity class tabs and related lists

Field Description

Tabs

Details tab Information on the entity. See Create an
entity class for more information.

Related lists

Entities Details of the entity, such as name, owned by,
and compliance score percentage. To add a
new entity, click New.

Child classes Details of the child classes for the selected
parent entity class. To add a new child entity
class for the parent entity class, click New.

4, To save the entity class, click Save.

5. To visually explore the relationship between the upstream entities, downstream entities, entity,
and entity type that is associated with the entity class, click 360° view.

Monitoring assessment data using ESG Management dashboards

You can monitor and analyze assessment data at various levels in the Environmental, Social, and
Governance Management application using the Analytics dashboard. The custom dashboards
you create provide tailored insights and deliver relevant information at a glance, improving the
decision-making process.

Analytics dashboard in ESG Workspace

You can view the page by navigating to All > Environmental, Social, and Governance > ESG

Workspace and selecting the Analytics dashboard icon m From the Analytics dashboards
page, you can create dashboards, customize them, and share them with others.

Analytics dashboard

The Analytics dashboard landing page opens as a blank canvas, allowing users to create

new dashboards. Once a dashboard is created, users can add various elements such as data
visualizations, bar charts, trend analyzes, and score reports to create custom sections and data
visualizations. ESG data owners and metric managers can create, edit, and share this dashboard.
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Analytics dashboard homepage

i Analytics dashboard

You don't have any dashboards yet

That's okay you can create one

Create new dashboard

To learn more about creating and using ESG Management dashboards, see:
« Create an ESG Management dashboard using the In-line editor

« Edit ESG Management dashboard details

« Edit ESG Management dashboards

« Edit ESG Management dashboard elements

» Share an ESG Management dashboard

 Delete an ESG Management dashboard
For more information on dashboards, see Dashboards in Platform Analytics &.

Create an ESG Management dashboard using the In-line editor

You can create dashboards with data visualizations, filters, and other elements that you can
share with others. You can also create elements and add existing elements from the in-line
editor.

Before you begin
Save your work regularly.

Role required: sn_esg.data_owner, sn_esg.metrics_manager

([ ) Note: Data visualizations based on table data are automatically shared with users that you
share a dashboard with.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Analytics
dashboard.

2, Select the Analytics dashboard icon E

3. Select the More actions menu icon [Z] and selectCreate new.

© 2026 ServiceNow, Inc. All rights reserved. 73
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


https://www.servicenow.com/docs/access?context=analytics-center-dashboards&version=xanadu&pubname=xanadu-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=analytics-center-dashboards&version=xanadu&pubname=xanadu-now-intelligence&ft:locale=en-US
https://www.servicenow.com/docs/access?context=analytics-center-dashboards&version=xanadu&pubname=xanadu-now-intelligence&ft:locale=en-US

servicenow.

4. Select the In-line editor tile and give the dashboard a name and a description.
The Technical editor option opens a page in Ul Builder that is treated as a dashboard, with a
list of available components. For more information, see Ul Builder & and Create a technical
dashboard in Ul Builder &.

5. Select Create new dashboard.

6. Select Add new element to add content to the dashboard.
See Platform Analytics dashboard overview B for information about what you can add to a
dashboard.

When you add a data visualization, select New data visualization to create a new visualization
or Saved data visualization to choose one from the library. When you add a filter, select New
filter to create the filter without pre-configured data or Saved filter to reuse an existing filter.

7. Select the View dashboard details icon to view all the details of the dashboard.
You can also edit the details as required. For more information, see Edit ESG Management
dashboard details

8. Arrange the data on the canvas to make it useful.
You can select and drag from the corners of the elements to resize them on the canvas.

9. Select Add a tab to create room for more information on additional tabs.

10. Select Save.
The dashboard in-line editor doesn’t automatically save your dashboard when you're creating

it. Be sure to save your work regularly.

What to do next
« Edit ESG Management dashboard details

« Edit ESG Management dashboard elements

Edit ESG Management dashboard details

You can change a dashboard name, add a description, certify it, configure visibility, and specify
the requester, the owner, the owner group.

Before you begin
Role required: sn_esg.data_owner, sn_esg.metrics_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Analytics
dashboard.

2, Select the Analytics dashboard icon m and then select the dashboard you want to edit.

3. Select the View dashboard details icon to open the Details panel.

4, Edit the fields as necessary.

Name Edit the name of the dashboard.
Description Fill in the description to provide further con
P text about the purpose of the dashboard.
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N ™ S

Mark the dashboard as certified to inform the
user that the dashboard is for use across the
organization.

Mark as certified @ Note: You must have an admin role to
mark a dashboard as certified. For more
information, see Certify a Platform Ana

View, add, or remove workspaces in which
the dashboard can be viewed.

() Note: If you have the admin role, you
can change the workspaces for any
dashboard. Other users can change
workspaces only for dashboards they
create. For more information, see Edit
ESG Management dashboards.

Dashboard visibility

Create new category Specify one or more dashboard categories.

Specify who requested the dashboard.

Note: This useris considered are
Requested by sponsible user. The data visualization
is shared with them, with editing permis
sions.

Specify the owner of the dashboard.

@ Note: By default, the owner is the cre
Owner ator of the dashboard, but the creator or
owner can assign ownership to another
user.

Specify an owner group.

(] Note: The owner of a dashboard can

Owner Gro
wnerLrotp be an entire group rather than a single
person.
Created by See who created the dashboard.
See who updated the dashboard along with
Last updated by the date and time details.
Shared with See who the dashboard has been shared

with.

Edit ESG Management dashboards

You can edit dashboard and dashboard tab information in the in-line editor. If the dashboard has
been shared, any changes you make are applied globally.
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Before you begin
Role required: sn_esg.data_owner, sn_esg.metrics_manager

About this task
You can edit the details of the dashboards you have created. When you edit the content of
dashboards created in the technical editor, you're redirected to Ul Builder.

© Important: By default, dashboards are subject to edit lock. Only one person at a time can
have the same dashboard in edit mode. If you’re viewing a locked dashboard, you aren’t
able to make edits even with edit permissions. You'll see the locking user's initials next
to the Refresh and View dashboard details icons. Hover on the initials to see the user's
name, company, and roles.

The More actions menu includes the option to clear the edit lock. Use this option with
caution.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Analytics
dashboard.

2, Select the Analytics dashboard icon m and then select the dashboard you want to edit.

3. Perform any of the following actions.

To edit the details of a dashboard created in the in-line edi
tor:

a. Select the View dashboard details icon .

b. Select Edit to put the dashboard into edit mode.

c. Edit the details of the dashboard and then select Exit
editing mode.

To edit the details of a technical dashboard:

a. Select the View dashboard details icon .

b. Select the arrow next to the Edit in Ul builder button and
then select Edit dashboard details to put the dashboard
into edit mode.

Edit dashboard details

@ Note: If you don't see this option, you don’t have
permission to edit the dashboard.

c. Edit the details of the dashboard and then select Exit
editing mode.

For more information, see Edit ESG Management dash
board details.

Select and drag an element's handlebars to resize it.
Configure the dashboard lay Select and drag an entire element to move it around the
out dashboard layout. Elements include data visualizations, fil
ters, and other dashboard content.
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Select Add a tab. A tab labeled New Tab is added next
to any existing tabs. When you add youir first tab to a dash
board, there’s a new part of the layout below the title and
above the tabs. Add elements above the tabs that are visi

Add a tab to a dashboard )
ble no matter which tab has focus.

Select the pencil icon to rename the tab.

You can reorder tabs by dragging and dropping them. You
can also reorder dashboard tabs using keyboard actions:

a. Select Edit to put the dashboard into edit mode.
b. Use the TAB key to move the focus to a dashboard tab.

Reorder a dashboard tab c. Use the LEFT and RIGHT arrow keys to select a tab to
move.

d. Use the SHIFT+LEFT arrow or SHIFT+RIGHT arrow com
mand to move the selected tab left or right.

e. Select Save.

You can duplicate a tab on the current dashboard.

a. Select Edit to put the dashboard into edit mode.

b. Select the More actions icon E] next to the tab's name
Duplicate a dashboard tab and choose Duplicate.

A new tab with the same content as the duplicated tab
opens with the name New Tab. Choose the pencilicon

to rename the tab.

a. Select Edit to put the dashboard into edit mode.

b. Select the More actions icon E] next to the tab's name
Delete a dashboard tab and choose Delete.

@ Note: There’s no confirmation message. The tab dis
appears from the dashboard.

a. Select the tab to make it active.
Rename a tab b. Point to the tab name and select the pencil icon.

c. Enter the new name.
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© Note:

If you rename a tab on a dashboard that has been
translated, the translations are replaced with the new
English tab name. To translate the new name:

a. Navigate to User Menu > Preferences.

b. On the Display tab, select the target language.

c. On the translated dashboard, rename the tab with
the translation of its new name.

Role required: admin.

a. Select Edit to put the dashboard into edit mode.

b. Select the Dashboard settings icon to open the Set
tings panel.

Configure the refresh settings | select Show refresh information to show the time of the
last refresh under the dashboard's title.

d. Select Scheduled repetition to configure the number of
minutes that the dashboard is automatically refreshed.

The minimum refresh interval is 10 minutes.

a. Select Edit to put the dashboard into edit mode.

b. Select the Dashboard settings icon to open the Set
tings panel.

. ¢. Open the Background Color menu to show the pre-con
Configure background colors figured colors.

d. Choose an existing color or select the Color Palette icon
to open the palette.

Specify Hex or RGBA values, or choose from the color
picker.

Choose whether and which analytics to show in the In
sights section.

When you select Show insights panel, an Insights button
is added to the dashboard and the selected analytics op
tions are shown. For more information, see Proactive analyt
€ @ DEDa & 2

Configure Insights

() Note: Ifyou aren’t able to edit, either you don’t have permission to edit the dashboard,
oritisin edit lock.

Edit ESG Management dashboard elements

You can edit the contents of a dashboard or dashboard tab, including data visualizations and
filters. Because dashboards are shared, any changes you make are applied globally.
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Before you begin

Role required: sn_esg.data_owner, sn_esg.metrics_manager

About this task

You can edit the details of dashboards created in the in-line editor and in the technical editor in
the ESG Workspace. When you edit the content of dashboards created in the technical editor,

you're redirected to Ul Builder.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Analytics

dashboard.

2, Select the Analytics dashboard icon E and then select the dashboard you want to edit.

3. Perform any of the following actions.

Add an element

Save a data visualization to the
Visualization Library

Delete an element from the
dashboard

a. Select Edit to put the dashboard into edit mode.

b. Select Add new element. From the list, select the compo
nent you want to add. Select Saved data visualization or
Saved filter to add one or more saved elements from the
library to the dashboard.

You can also select Add new element on any selected
dashboard element to see the list of elements.

c. Select the element. The element is added to the dash
board where you can edit it.

d. Drag to move the widget or resize it.

a. Select Edit to put the dashboard into edit mode.

b. Select Add new element. From the list, select Data visu
alization.

c. Create the visualization as described in Data visualiza
(AQARALARAN A

d. Select the More actions icon B and select Add to li
brary.

e. Give the visualization a name and a description.

f. Select Add to library.

The data visualization is available in the Visualization li

brary for use on other dashboards.

a. Select Edit to put the dashboard into edit mode

b. Select the element that you want to delete.

c. In the header, select the More actions icon @ and se
lect Delete.

() Note: There’s no confirmation message. The widget
disappears from the dashboard.
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a. Select Edit to put the dashboard into edit mode.

b. Select the element that you want to edit.

c. In the element's header, select the Configure icon to
open the Configuration panel.

d. Configure the element and choose Save. For more infor
mation about configuring an element, see one of the fol
lowing:

Configure an element AR AR~ AR AN A
" B & 0 a
" 0o e

@ Note: If you change a visualization from the Visu
alization Library, you have the choice to save the
change only to the dashboard or to the element in the
library. When you change an element in the library,
the change is reflected everywhere the element is
used. When you change only in the dashboard, you
create a copy of the visualization that exists only in
that dashboard.

When you have multiple tabs, you can move elements from
tab to another or to the pane above the tabs.

a. Select Edit to put the dashboard into edit mode.
Move an element between
tabs b. Select the More actions icon B and choose Move to a
different tab or Move above the tabs.

c. When you choose Move to a different tab, choose the
tab and select Move.

Filters let users filter data for all report widgets on a dash
. board that follow them. You can add filters to both the en
Add filters to the dashboard tire dashboard and to individual dashboard tabs.

For more information, see & & BED& &8 &

Data visualizations follow filters by default. A data visual
ization follows filters in the same tab as itself or above the
tabs. Data visualizations either follow all such tabs that tar
get their data sources, or none.

Configure a data visualization |a. Select Edit to put the dashboard into edit mode.

to follow or not follow filters b. Select the dashboard element that you want to follow or

not follow filters.

c. In the header, select the Configure icon B to open the
Configuration panel.
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d. In the Data update section, select or deselect Follow Fil
ters.

e. To show a filter icon V on the data visualization when it
follows an interactive filter, select the Show filter icon.

Choose what happens when a user selects a visualization
or one of its segments.

a. Select the Edit to put the dashboard into edit mode.
b. Select Allow chart interaction.

c. Select Go to data view to open the records view of the
associated segment or visualization.

Enable chart interaction d. Select Apply as filter to filter the visualizations on the
dashboard on the selected element.

@ Note: This option is only available on pie, donut,
semi-donut, horizontal bar, and vertical bar visual
izations. It’s available in the Dashboard inline edi
tor, but not in the Visualization Designer.

e. Select Go to URL to open a specified web page.

View the description of a dash Point to the element, then select the information icon .
board element If the element doesn’t have a description, the info icon
doesn’t appear.

() Note: If you're unable to edit the dashboard, you don’t have permissions to edit the
dashboard.

Share an ESG Management dashboard

Share a dashboard with other users, groups, or roles to create a shared view of data that you can
use to collaborate. You can grant viewing permissions or both viewing and editing permissions.

Before you begin
Role required: sn_esg.data_owner, sn_esg.metrics_manager

About this task

You can share dashboards that have been shared with you, if sharing is enabled. If you have
permissions to edit a dashboard that has been shared with you, you can pass that ability along to
whomever you share it with. Users with the administrator role can share all dashboards.

Edit permissions granted by sharing a dashboard don’t apply to the underlying data
visualizations on the dashboard. View permissions granted don’t apply to that dashboard's
visualizations outside of the dashboard itself.

Only admins can see roles in the Sharing panel.

() Note: Data visualizations based on table data are automatically shared with users that you
share a dashboard with.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Analytics
dashboard.

2, Select the Analytics dashboard icon M and then select the dashboard you want to share.

3. Select the More actions icon E] and select Share.
4, Enter the names of one or more users, groups, or roles you want to share the dashboard with.

5. To enable the people you share the dashboard with to share the dashboard as well, select
Allow recipients to add, edit, or delete sharing permissions associated with this dashboard.
When you add a user, group, or role as a viewer, they can only share the dashboard as a
viewer. When you add a user, group, or role as an editor, they can share the dashboard as a
viewer or as an editor.

@ Important: Granting permission to share a dashboard or data visualization includes
the ability to add, edit, and delete sharing permissions for any user, group, or role on that
dashboard or data visualization. A user can’t use this ability to give themselves or others
edit permissions if they weren’t originally given edit permissions.

6. Select one of the following options.

N ™ S

Grant only viewing permissions to the users,
Add as viewer groups, or roles you're sharing the dashboard
with. They can’t edit it.

Grant editing permissions to the users,
groups, or roles you're sharing the dashboard

. with.
Add as editor

You must be in the same application scope as
the dashboard to add a user as an editor.

7. Optional: Select Copy link with filter or Copy link to copy the dashboard's URL to the
clipboard.
The URL points to the tab that was open when you opened the Share dashboard dialogue.
Copy link with Flter also applies the filters as they're configured on the dashboard or
dashboard tab.

8. Select Confirm.

9. Optional: Select the View dashboard details icon to view who the dashboard has been
shared with and where it’s visible.

Delete an ESG Management dashboard

You can delete a dashboard that is no longer useful. The Analytics Center invokes the Workflow
Studio to remove the dashboard from your instance.

Before you begin
Inform any users who can view the dashboard that you're deleting it. Users who have
bookmarked a deleted dashboard see an error when they try to accessiit.

Role required: sn_esg.data_owner, sn_esg.metrics_manager
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Analytics

dashboard.

2, Select the Analytics dashboard icon M and then select the dashboard that you want to

delete.

3. From the More actions menu B, selectDelete.

4. Confirm the deletion.

You can’t undo this action. If you accidentally delete a dashboard associated with a plugin, an

admin can restore the original version of the dashboard.

a. Navigate to All > System Applications > All Available Applications > All.

b. Find the plugin using the filter criteria and search bar.

c. Select the More actions icon @ and choose Repair.

d. Select Repair in the Activate Plugin window.

GRC: Metrics

The ServiceNow® GRC: Metrics application enables organizations to track their goals and

targets, collect data, and report data.

Explore

Learn about how Metrics
administrators use the
GRC: Metrics application
for tracking their goals.
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Configure your GRC:
Metrics application.

Use

Use the GRC: Metrics
application for tasks
such as creating metric
definitions, providing data
for metrics, managing your
integrations, and so on.
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Reference

Get details about
components like fields,
tables, roles, and
properties installed
with GRC: Metrics.

Exploring GRC: Metrics

A metric is used to measure and evaluate the effectiveness of your organizational processes. A
metric or a combination of metrics can provide an insight into a system, component, or process.
The GRC: Metrics application enables other applications to assess, compare, and track the
performance of the processes.

Metrics

The GRC: Metrics application is installed automatically with the ESG Management
application from the ServiceNow® Store. The user role that is responsible to read, create,
and update the metric definitions and metrics is the ESG Management metrics manager
(sn_esg.metrics_manager).

With the GRC: Metrics application, you can define metrics by using the metrics form. Metrics
are a combination of a metric definition and an entity. Applying the metric definition to an entity
creates a metric. Once the metrics are defined, data is gathered to track the effectiveness and
performance of your processes. For example, consider a metric that measures the effectiveness
of an incident resolution process by calculating the time it takes to resolve an incident.

Every organization has a range of data sources for building and structuring their own metric
analysis. To establish a useful metric, the metrics manager must first assess and set the goals.
Next, the manager sets the targets for the metrics that are integrated with their business
decisions.

Qualitative and quantitative metrics
You can classify your metrics into qualitative and quantitative measurements.

Qualitative metrics in ESG Management are derived from the subjective opinion that you form
based on other information. Some examples of qualitative metrics in the ESG Management
sectors are brand credibility, corporate value, and so on.

Quantitative metrics in ESG Management are the metrics that you can measure in a specific
number through certain formulas. Some examples of quantitative metrics for an organization
include reporting total energy use, energy use by region, and so on.

© 2026 ServiceNow, Inc. All rights reserved. 84
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Examples of metrics

Consider the example of measuring greenhouse gas emissions for business entities in your
organization. Greenhouse gas emissions are categorized into three groups called Scopes by the
international Greenhouse Gas (GHG) Protocol.

You want to measure the metrics for Scope 3 Emissions for the following categories: employee
travel and purchased goods. The employee travel policy applies to all the employees in the
organization. You can collect the metrics for the employee travel policy manually by providing
instructions in the metric definition.

On the other hand, the metrics for the purchased goods are collected automatically based on
the specified conditions method, schedule, and core property in the metric definition. The metric
collection process is illustrated in the following image.

Define a metric

Formula
Frequency: Annually
Employee Travel + Purchased Goods

Calculated metric definition
Scope 3 emissions

Manual metric definition Automated metric definition
Scope 3 emissions: Scope 3 emissions:
Employee Travel Purchased Goods

Unit: MTCO2E Unit: MTCO2E
Direction: Minimize Direction: Minimize
Property Nature: Lagging Nature: Lagging

Precision: 0 Precision: 0
Category: Quantitative

Schedule
Schedule: Annually Schedule: Annually
Method Provide instructions Specify sources
(] *
Metric data by entity

The metric data by entity table (sn_grc_metric_data_by_entity) includes metric definition data
and metric data for entities and the aggregated data for parent entities defined in the entity
hierarchy. For example, if an ESG reporting disclosure manager wants to understand the total
emissions for an entire year for a particular location and if the location has sub-locations, you
can also aggregate the data and use it for reporting purposes. For example, consider that your
organization has a location Japan. Japan, in turn, has two sub locations, Tokyo and Kyoto.
Assume that you want to find your total yearly Scope 1 emissions for the year 2022 for Japan.
Using the time dimensions feature, you can aggregate your data and get a view of your total
emissions for a year. You can also aggregate the data for a quarter, week, or a month depending
on your reporting requirements. The data in this table is collected according to the calendar of
metric or entity.

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

85



servicenow.

Components of GRC: Metrics

A metric consists of several components such metric definition, metric data, metric definition
data, metric data tasks. All of these elements or parts contribute to the metric collection process
in various ways.

Metric definitions

A metric definition is a template-level record that helps set the core properties of a metric.
These properties include the unit, direction, nature, precision, frequency of data collection,

and category of the metric. The metric itself collects scores, which are then aggregated into

the defined metric template. The advantage of creating and using a metric definition lies in its
ability to streamline the process of creating metrics using these metric definition templates.

For instance, imagine you have several business units, and you need to collect revenue data

for each of them. Without a metric definition, you would have to create separate templates for
every business unit and repeatedly specify the metric properties. However, by using a metric
definition, you simplify this task. Once you've created the metric definition, you can easily attach
your entities (business units in this case) and collect the metrics without duplicating efforts.

The GRC: Metrics application provides the following types of metric definitions:
« Automated metric definition: Data is collected automatically.
« Manual metric definition: Data is collected manually.

« Calculated metric definition: Data is collected by aggregating data from other child metrics.

Metric data

When you execute a metric, the metric data gets created. In the case of manual metric
definitions, the values of metric data are copied from the metric data tasks when the metric data
tasks are closed. To address off-cycle requests for the most up-to-date information on existing
metric definitions and metrics, you can create ad hoc metric data tasks on manual metrics. On
the metric data form, the option Ad hoc denotes if the metric data task was created as an ad hoc
task. It is important to note that these ad hoc tasks do not contribute to the aggregated metric
definition data, are not considered for entity hierarchy rollup, and are not evaluated for threshold
rating, Variance(%). However, in a calculated metric definition, if the Calculation level is set

to Entity, and there are ad hoc tasks from the manual metric definitions, then these tasks are
aggregated to derive the calculated metric definition data.

For a scripted automated metric definition, the values are updated when you execute the script.
For a basic automated metric definition, the values are updated from the selected table. The
field Variance (%) shows the variation in between current period and the previous period metric
data. This difference is displayed in percentage. The field Last period data refers to the previous
period's metric data.

Metric definition data

Metric definition data gets automatically created when the metric definition gets executed and
aggregated. On the metric definition data page, the field Variance (%) shows the variation in
between the current period and the previous period's metric definition data. This difference

is displayed in percentage. The field Last period data refers to the previous period's metric
definition data.

Metric data tasks

Metric data tasks only apply to manual metric definitions. These tasks are generated whenever
manual metrics are executed and the data owners provide responses for these tasks manually.
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You can provide responses to multiple metric data tasks using the metric data table. For more
information, see Metric data table.

A metrics manager has the authority to determine whether a metric data task needs approval.

If approval is necessary, you can choose between two methods: Simple Approval or Advanced
Approval by using the Metric approval property. For more information about this property,
see Components installed with ESG Management.

Types of metric definitions

A metrics manager defines the metrics by creating a metric definition. A metric definition is a
template-level record. In the metric definition, you set the core properties of the metric, such as
unit, direction, nature, precision, and category. The metrics collect the scores, and these scores
get rolled up into the metric definition.

The GRC: Metrics application provides the following types of metric definitions:
« Automated metric definition: Data is collected automatically.
« Manual metric definition: Data is collected manually.

« Calculated metric definition: Data is collected by aggregating scores from other child metrics.
These types of metric definitions are further explained in the following sections.

Automated metric definition

In automated metric definitions, the data is collected automatically based on the conditions
defined in the metric definition, such as metric properties, method, and schedule. For the
method, the metrics manager specifies the source table or the script that is used for collecting
the metric data and the filtering criteria to filter the metric data. See the following video.

In an automated metric definition, you can enabled a metric data task, approval flow, and
collection of supporting data in the metric definition. If enabled, the metric data task is generated
depending upon the frequency defined in the metric definition. As a metrics manager, you

can assign the task to a data owner. See Create an automated metric definition for more
information. When a metric data task is created, the task owner receives a system-generated
email notification. As the metric data owner, you can verify and override automatically collected
data if needed. If approval is enabled, verified data is submitted for approval to the designated
approver from the metric definition.

0 Note: For automated metric definitions where the method type is "External" or "Scripted",
the "Supporting Data" option isn’t available.

Manual metric definition

In manual metric definitions, the mode of data collection is manual. The data owner for a
particular metric provides the metric data by going through the instructions. As the metrics
manager, you have to define the metric properties, method, and schedule for the metric
definition. In the method, specify the instructions for the metric definition as the metrics
manager. Also, specify the data collection details such as data owner type, data owner, and
approval details.

In a manual metric definition, a metric data task is generated depending upon the frequency
defined in the metric definition. As a metrics manager, you can assign the task to a data owner
who provides the data for the task. See Create a manual metric definition for more information.
When a metric data task is created, a system-generated email notification is sent to the task
owner. As a metric data owner, you can provide the data for multiple metrics using the Metrics

tasks module (ﬂ). For more information, refer to Provide data for multiple metrics.
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Each metric data task has a due date defined in the manual metric definition form. By
default, the due date follows the schedule of 8-5. However, an ESG administrator can also
modify the schedule. For more information, refer to Create a new schedule. If the ESG
administrator wants to overwrite the schedule, then the ESG administrator can modify the
sn_grc_metric.metric_data_task_schedule property.

Both quantitative and qualitative category of metrics can be created using the manual metric
definition.

It's possible to convert a manual metric definition to an automated metric definition and an
automated metric definition to a manual metric definition. In the event that a manual metric
definition has open tasks, it's necessary to first close them prior to converting the manual metric
definition.

When a manual metric definition is executed, the first metric data is created and then metric data
task is created. This task is then referred to the metric data.

Calculated metric definition

A calculated metric definition calculates the scores from its children. It can include the
automated and manual metric definitions, metrics (quantitative), and other calculated metric
definitions of identical frequency. As the metrics manager, you have to specify how you want

to calculate the metric definitions score and how frequently you want to calculate them.
Deactivating or activating a calculated metric definition automatically deactivates or activates all
its associated metrics.

The calculated metric definition rolls up the scores from its children. The rollup property defined
in the calculated metric definition consists of a rollup formula and schedule for the rollup
frequency. A calculated metric definition can include those automated and manual metric
definitions, and metrics as its children, which are of the same frequency as that of the parent
calculated metric definition. See Create a calculated metric definition for more information.

Applying the metric definition to the entities

You can apply the metric definitions to the entities in your organization. Instead of defining
the metric for each entity, you can define the metric definition once and then apply that metric
definition to your entities.

For example, assume that you want to measure the greenhouse gas emissions for the entities in
your organization. Defining the metric for each entity is a time-consuming process. By creating
a metric definition, you can define the metric once and then apply that metric definition to your
entities.

The following illustration shows how you can apply the metric data definition to an entity. If you
have an automated metric definition for the purchased goods metric category, the metric can
be applied to the Products entity and IT entity in your organization. If you have a manual metric
definition such as Employee Travel, the metric can be applied to the Enterprise entity in your
organization as the travel policy applies to everyone across the enterprise.
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Apply the metric data definition to an entity

Manual METRIC DEF. Autemated METRIC DEF.
Scope 3 Emissions - Employee Scope 3 Emissions - Purchased
T'-C]I\.'e| : Goods

x

Thresholds for metrics

In the context of metrics, thresholds refer to predetermined values or limits used to assess
the performance of a metric. These thresholds are typically defined based on specific criteria
or objectives and serve as reference points to determine whether the measured value or
performance meets, exceeds, or falls below the desired level.

The three colors of thresholds—red, amber, and green—are commonly used to indicate different
levels of performance or status. These colors indicate the status where green signifies the metric
is performing well according to expectation, amber signals caution or warning, and red signifies
a critical situation. For instance, consider a scenario where you have established a metric
definition aimed at decreasing pollution, with the metric direction set to Minimize. In this case,
the metric values should be lower than the specified threshold value. This requirement arises
from the intention to prevent pollution from increasing and instead promote its reduction. If the
metric value is higher than the defined limit, the value would appear in red or amber. Thresholds
only apply to quantitative metric definitions.

Types of threshold

There are two types of threshold for a metric.

« Static: A static threshold for a metric or a metric definition refers to a fixed value used as a limit
for tracking a metric.

« Dynamic: Dynamic thresholds are specified in percentages. This means that the percentage
variance is calculated based on two factors: direction and the previous period data. For
example, you want to track electricity consumption, from a particular region and in June 2023,
the electricity consumption value is 700 kWh. The direction of the metric and the metric
definition is Minimize. This means you want to minimize the consumption, so any increase
is considered undesirable. In July 2023, you collect new data and find that the consumption
value has increased to 1000 kWh. To evaluate the status of this threshold, you define different
thresholds that represent various levels of change. These thresholds are expressed as
percentage differences from the previous period's data, in this case, from June 2023. For
example, you can set a threshold range of 5% to 10%. If the percentage change between
June and July falls within this range, you classify the threshold status as "amber." This means
that there has been a moderate level of change, indicating that the metric is deviating from
the desired target value, but it's not critical yet. However, if the percentage change in the
metric value exceeds or reaches 15%, you classify the threshold status as "red." This increase
indicates a significant change that requires immediate attention or corrective action because it
deviates greatly from the desired target value.

Related topics

Create a threshold for a metric
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Metrics landing page

The metrics landing page offers an overview of all your metrics and metric definitions.

The metrics landing page provides a consolidated view of all your metrics and metric definitions
for the users with the following roles:
» sn_esg.metrics_manager

* sn_esg.program_manager

You can launch the metrics landing page using the metrics icon ().

Metrics landing page

@ Metrics

ESG metrics

Welcome, Oliver Jones

Overview Filterby | All ¥ ]
Open metrics Overdue metrics Metrics due in next 7 days Awaiting approvals Rejected

G 173 @ 34 re) @ ® 1

Name Frequency Data owner Approver Unit

Auto Entity count for Entity 1 Weekly (empty) (empty) #

Auto Entity count for Entity 2 Weekly (empty) (empty) #

Charitable causes supported - ACME Global Annually Gale Nolau (empty) #

CO2e emissions from energy usage for Brisbane DC Monthly (empty) (empty) Kilograms of carbon dioxide

CO2e emissions from energy usage for Frankfurt DC Monthly (empty) (empty) Kilograms of carbon dioxide

CO2e emissions from energy usage for Hong Kong DC Monthly (empty) (empty) Kilograms of carbon dioxide

CO2e emissions from energy usage for Melbourne DC Monthly (empty) (empty) Kilograms of carbon dioxide

CO2e emissions from energy usage for New York DC Monthly (empty) (empty) Kilograms of carbon dioxide

CO2e emissions from energy usage for Paris DC Monthly (empty) (empty) Kilograms of carbon dioxide

CO2e emissions from energy usage for San Diego DC Monthly (empty) (empty) Kilograms of carbon dioxide

Showing 1-10 of 413 1 2 3 4 5 > 3 10~ rows per page
Aggregated metric data Filter by [(an~

Metric definition groups

General 14 Energy 2 Emissions 13 Water 1 Biodiversity 0 ©
Name « Frequency Unit
Approach to Stakeholder Engagement Annually (empty)
Auto Entity count Weekly #
Charitable causes supported Annually #
CO2e emissions from energy usage Monthly Kilograms of carbon dioxide
CO2e from hardware assets by location Monthly Kilograms of carbon dioxide
CO2e from hardware assets by model category Monthly Kilograms of carbon dioxide
Corporate grants Annually $
CUE by Data Center Monthly Kilograms of carbon dioxide/Kilowatt-hour
WUE by Data center Daily (empty)
E-waste - Disposed Monthly Pounds.
Showing 1-10 of 82 12 3 4 5 5 o 10+ rows per page

The landing page displays the following sections:
« Overview

« Aggregated metric data

Overview section

The Overview section shows the data for the manual metrics in the following tiles.
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« Number of open metrics: Number of open tasks for manual metric definitions

« Number of metrics where the metric data tasks are past their due date: Number of metrics for

which the metric data tasks are overdue.

« Number of metrics due in the next seven days: Number of metrics for which metrics must be

submitted in the next seven days.

« Number of metrics awaiting approval for the metric data tasks: Number of metric data tasks

that have not been approved.

« Number of metrics rejected: Number of metric data tasks that have been rejected.

When you select a tile, the data on the page is filtered. You can also filter the data that is visible
using the reporting classification filters that are provided. The options displayed for the reporting
classification filter can be configured by the users. For more information on how to configure the
options, refer to Create a grouping for metric definitions.

The data displayed on this page is always the latest data.

Aggregated metric data

The Aggregated metric data section shows you the data for metric definitions. You can scroll

horizontally to select a tile to view the data related to that tile. The tiles display the groups that
you specify in the metric definitions. For example, you can select Emissions to see all the metric
definitions related to Emissions.

Metric data table

The metric data table enables data collection for metrics across the organization using an easy-

to-use interface like a spreadsheet with multiple filters and a task management workflow.

As a data owner, you can access the metric data table (ﬂ) and complete the

tasks assigned to you. The following image shows the metric data table interface.

()] Mectanks

My metric data tasks

Metric data entry  Approvals

Metric definition

Greenhouse Gas Emissions
sourcing and procurement?

details

The metric data table offers the following benefits:

« Simplifies data collection across the entire organization.

2 Does your entity prioritize sustainable

Provide Carbon neutrality strategy

End date

2024-11-26

2024-11-26

| Filters

No, we primarily focus o... | Yes, we source from sup. | We are wo

Overdue

Overdue

Overdue

Emissions (14)

M

Enter search criteria

fotric subprow
Greenhouse Gas Emissions (14)

V Filter (3)

]

Apply

» Enables you to view all the metrics that the data owner must respond to in a single place

instead of navigating across multiple tasks.

« Displays a maximum of 700 tasks at a time.

« Simplifies the process of providing data by enabling you to filter metric data tasks by entity,

metric groups, metric subgroups, start date, end date, and approval level.
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« Displays the open tasks with the number of open tasks in parentheses.
« Maintains an audit trail of all changes to the data and the users who made the changes.
« Enables you to view the metrics segregated by entities.

« Gives additional information to the data owner for reference such as instructions to follow
while providing the data.

« Provides the ability for the users to attach files in the Contextual side panel and attach the
relevant documents and links.

« Enables ESG program managers and metrics managers to view the data submitted by the data
owners and approve or reject multiple data tasks with comments.

« Enables data owners to view the rejection comments in the Activity tab.

« Helps you to view how the past three data for quantitative metrics is trending.

« Enables you to see the approvers of your task and the approval status.

« Displays the percentage variance of data when compared to the data of the previous period.
« Displays the threshold status if the metric exceeds the threshold.

« Enables you to view the last period's data.

Metric integration

The metric integration tool enables you to manage your third-party ESG Management data by
normalizing and mass loading data using fiat file. The terms flat file and normalized data refer to
how data is stored electronically.

Metric integrations is a common import utility tool for GRC: Metrics, which can be used by
multiple integrations to import data from an external source, such as a spreadsheet, into the
metric data. This tool uses different mapping configurations to obtain the data needed to create
or update existing metric data.

The following are the benefits of the metric integration tool:
« Provides fiat file normalization for bulk data uploads.

« Enables configurations for your own integrations or uses the default configurations provided by
ServiceNow, such as the Watershed integration.

 Enables the automatic creation of metric definitions.

« Provides the ability to automate the creation or update of data in bulk.

« Provides the ability to automate the creation of entity types and entities.

« Provides the ability to set up your own normalization and upload rules for metrics.
« Helps to stage data to verify the upload format of data being updated or created.

« Enables users to clean up data before loading to the database using the error log.

The Metric integration form also enables you to create data mappings. Data mappings enable
you to map the columns from any source of data such as the Watershed spreadsheet with

the metric definitions. You must ensure that the data is mapped according to your system. For
example, Watershed may name an entity as Office at Atlanta, US, whereas the metric definition
may have the entity name as Atlanta, US-office. This difference would result in a mismatch when
importing the data. To prevent this issue, you must ensure that the data mapping is accurate.
When you map data, it is important to understand that metrics are derived from the combination
of entity, entity type, and metric definition. Therefore, you must have the following tables in your
data mapping.
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e sn_grc_profile
« sn_grc_profile_type

« sn_grc_metric_definition

Managing different fiscal years

Many global organizations have operations in different countries and each country could follow
their own fiscal calendars instead of following the standard Gregorian calendar. When you create
fiscal calendars, you enable the entities in other locations to collect data according to their own
fiscal calendars.

You can create multiple fiscal calendars, including a reporting calendar for global reporting. This
reporting calendar must be used in the metric definition and set as the Target calendar. The other
calendars, known as Source calendars, are then mapped to the Target calendar.

Consider a parent organization in India with two subsidiaries operating in different countries:

the US and Australia. The US government's fiscal year runs from October 1 to September 30,
while Australia's fiscal year spans from July 1 to June 30. The parent organization adheres

to the Indian fiscal calendar, which is from April 1 to March 31. In this context, metric data is
collected according to each country's fiscal year and then aggregated according into the global
calendar used for data aggregation. If the metric data for the US is 100 and for Australia is 200,
the combined data on the global calendar used by the parent organization would be 300. Here,
the US and Australian fiscal calendars are considered source calendars, and the global calendar
used by the parent organization is the target calendar.

There are four data collection frequencies that are supported for the fiscal year and they are as
follows:

« Monthly

» Quarterly

« Semi-annually

e Annually

After you create fiscal calendars, you must map the calendars to specify which is your target
calendar and your source calendar. You can then use these calendars in metric definitions

and metrics. The calendar specified on the metric is used for data collection and the calendar
specified on the metric definition is used for data aggregation. This means that if the metric
definition has Global calendar specified, and the metric has US calendar specified, then the
Global calendar will be used for data aggregation. For more information on mapping calendars,
see Map target and source calendars.

@ Note: The calendars must begin on the first of every month.

Related topics

Create fiscal calendars

Configuring GRC: Metrics

You can configure GRC: Metrics to meet the needs of your organization.

As a metrics administrator, you can configure the following types of metric definitions.
» Automated metric definitions
« Manual metric definitions
« Calculated metric definitions
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Create a manual metric definition

Create a manual metric definition to collect the data manually for a metric.

Before you begin
Role required: sn_esg.metric_manager

About this task

In the manual metric definition, the mode of data collection is manual. An option is available to

set up the qualitative and quantitative metrics.
Note: The forms for creating an automated metric definition or a manual metric definition
point to the same sn_grc_metric_definition table. The difference between the two forms is
the method of the collection.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics >
Manual metric definitions.

2. Click New.

3. On the form, fill in the fields.
For information about the fields, refer to Manual metric definition fields.

4. Click Save.

Result
The metric definition is saved in the Metric definitions list.

What to do next
You can associate an entity type, create metrics, and add citations to the metric definition. See

Update a metric definition for more information.

Manual metric definition fields

Detailed explanation of the fields on the manual metric definition form.

New manual metric definition form

Field Description

Basic details

Name Name of the manual metric definition. For
example, Number of incidents.
Active Option to mark the manual metric definition as
active.
Description Brief description of the manual metric
definition.
Category Category of the metrics data. The choices are
as follows:
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New manual metric definition form (continued)

Field Description

Calendar

Aggregation method

© 2026 ServiceNow, Inc. All rights reserved.
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« Qualitative: Qualitative data is intangible
and non-numerical in nature. It's defined by
the characteristics of a process or business
activity.

« Quantitative: Quantitative data is tangible
and numerical in nature. It's defined by the
numbers or key performance indicators.

@ Note: This fields Nature, Direction,
Precision, and Unit are only displayed
only when the category of the manual
metric definition is Quantitative.

Calendar to use for metric aggregation. Only
the configured calendar options are available
for selection. This field is automatically set to
Standard Calendar.

@ Note: Standard calendar refers to the
Gregorian calendar.

Method used to calculate the metric data

for all the entities. For example, if you have a
metric that you want to measure for multiple
entities such as people, departments, or
regions, you might want to know how to
calculate the scores for each entity into

a single score that represents the overall
performance. Your choice of aggregation
method depends on your goal of metric
collection. For example, if you're interested in
overall performance and want to account for
differences in scale or size between entities,
the sum or average may be more appropriate.
If you're interested in identifying the best-
performing entity, the maximum may be
more appropriate, while if you're interested

in identifying the worst-performing entity,

the minimum may be more appropriate. The
aggregation happens across time periods
based on the frequency defined in the metric
definition. If the frequency is monthly, the
calculation takes place every month. The
four choices for aggregation methods are as
follows:

« Sum: The metric data for all entities are
added together to create a single score.

» Average: The metric data for all entities are
averaged to create a single score.
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New manual metric definition form (continued)

Field Description

« Maximum: The highest metric data among
all entities is used as the single score.

« Minimum: The lowest metric data among all
entities is used as the single score.

Unit Unit for the manual metric definition.

Precision
Number of decimal places after the decimal

point on a score. This field is automatically set
to 0.

When the Precision is set to O, the result is
rounded to the nearest whole number. For
example, if a metric definition with Precision
O calculates the values 7 + (5 / 2), the result
rounds up to 10.

When the Precision is set to greater than O, the
result is rounded to the nearest decimal point
for the given precision. For example, Precision
1rounds aresult of 4.45 as 4.5.

Frequency Frequency at which the metric definition
should collect the scores. The choices are as
follows:

« Daily

« Weekly

« Monthly
* Quarterly

« Semi-annually

« Annually

First run date Start date of the metric definition execution
for the collection of data according to the
frequency.

Data collection

Data owner assignment type Type of the data owner assignment for the

metrics within the metric definition. The
choices are as follows:

« Simple

The system assigns the specified Data
owner or Data owner group to the Metric.

« Advanced
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New manual metric definition form (continued)

Field Description

The system assigns a Data owner based
on the assignment configuration. ESG
admins [sn_esg.admin] or Risk admins
[sn_risk.admin] can set assignment
configurations to dynamically assign data
owners. For more information on creating
assignment configurations see, Create an
assignment configuration and Assignment
Configuration New Record @.

@ Note: Thisis available if you have
the GRC: Approver Configurator
application installed. For more
information see, Using Approver
Configurator for setting up approvals &.

Data owner type Type of the data owner responsible for the
manual metric definition. The choices are as
follows:

« User

« User group

@ Note: Only groups that include at
least one member with the ESG Metrics
Manager role or higher can be selected
for this field.

Data owner Data owner responsible for the manual metric
definition. Select a data owner from the list.

@ Note: If you selected the advanced
option for Data owner assignment type,
this will be the assigned data owner if the
assignment configuration doesn’t return
any results.

Result type The format that you want to be available for
responses in assigned metric data tasks.
This applies to responses and overridden
responses.

« Text: Users can enter a plain text response.

¢ HTML: Users can enter HTML code as a
response.

« Choice: Users can select a choice from a list.

This field appears when the Category field is
set to Qualitative.
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New manual metric definition form (continued)

Field Description

Choice table Table the choices are being populated from.
This field appears when the Category field is
set to Qualitative.

Choice field Field and its values from the selected table
that are displayed for each choice. This field
appears when the Category field is set to
Qualitative.

Choice condition Option to only show certain fields or certain
values within the Choice field under set
conditions. Select Set conditions to open the
condition builder. This field appears when the
Category field is set to Qualitative.

Instructions Instructions for the data owner. Method of
collection for the manual metric definition.

Approval required Option to indicate if an approval is required for
the manual metric definition.

© Note: When the Approval required
option is enabled, the Approver type
and Approver fields are displayed.

Approver type Type of the approver of the metric definition.
The choices are as follows:

« User

« User group

@ Note: This field appears only when the
Metric approval property is set to Simple.
For more information see, Components
installed with ESG Management.

© Note: Only groups that include at
least one member with the ESG Metrics
Manager role or higher can be selected
the User Group.

Approver Approver user or approver group that is
responsible to approve the metric definition.
The choices are as follows:

« Approver: Displayed when the User option
is selected.

» Approver group: Displayed when the User
option is selected.
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New manual metric definition form (continued)

Field Description

@ Note: This field appears only when the
Metric approval property is set to Simple.
For more information see, Components
installed with ESG Management.

@ Note: Only users with the ESG Program
Manager role or higher can be selected.

Metric Properties

Type Method used to determine if the score is
collected manually or in an automated manner.
The choices are as follows:

o Automated

« Manual
Select Manual.

Enterprise Owner Type Type of enterprise owner responsible for the
manual metric definition. The choices are as
follows:

« User

« User group

() Note: Only groups with at least one
member with the ESG Metrics Manager
role or higher can be selected in this
field.

Direction Direction that you want to see the metric in.
The choices are as follows:

* None: If you don’t want any change in the
metric direction, select this option.

« Minimize: If the desired metric direction is
downward, select this option.

« Maximize: If the desired metric direction is
upward, select this option.

« Milestone: When the metric direction isn’t
applicable, but the metric is tracked against
a milestone, select this option.

@ Note: Thresholds can be set for all
directions excluding Milestone. For more
information on creating thresholds, see
Create a threshold for a metric

Group Area that the metric relates to.
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New manual metric definition form (continued)

Field Description

Reporting classification

Due date offset

Enterprise owner

Nature

© 2026 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.

Tag used to categorize the metric.

Number of business days after the schedule
end date when the metric data task becomes
overdue. For example, if the frequency of a
metric definition is monthly and if you enter 15
in this field, then the due date for metric data
task will be overdue 15 business days after the
month ends. If set to O, the due date is set to
one day after the end date.

@ Note: The offset is based on the
applied schedule.

Enterprise owner of the manual metric
definition.

() Note: Only users with the ESG Metrics
Manager role or higher can be selected
in this field.

Nature of the manual metric definition. The
choices are as follows:

* None: If you don’t want any change in the
metric direction, select this option.

« Leading (Predictive) Metric: Is predictive
and helps anticipate future outcomes. In this
case, the company may use a leading metric
related to GHG emissions, such as the
amount of energy consumed per production
unit. By tracking energy consumption,
the company can predict its future GHG
emissions based on the energy sources
used and the efficiency of its production
processes. This leading metric enables the
company to proactively identify areas for
improvement and make informed decisions
to reduce emissions.

L]

Lagging (Measures Impact) Metric:
Measures the impact of past actions or
events. In the example, a lagging metric
related to GHG emissions could be the
total emissions produced by the company
in a given year. This metric provides an
assessment of the company's historical
environmental impact. By monitoring this
metric over time, the company can evaluate
the effectiveness of its emission reduction
efforts and identify areas where further
improvements are needed. Lagging metrics
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New manual metric definition form (continued)

Field Description

help measure the outcomes of past actions
and inform future strategies.

o Current metric: Monitors ongoing processes
and identifies real-time improvement
areas. For GHG emissions, a current metric
could be the emissions intensity, which
measures the emissions generated per
unit of production. By tracking emissions
intensity, the company can identify specific
areas within its operations that contribute
to higher emissions. This metric helps the
company identify real-time improvement
opportunities, such as optimizing energy
usage, implementing energy-efficient
technologies, or adopting renewable energy

sources.

Subgroup Subgroup that the metric relates to

Key metric Option to indicate if it's a key metric for your
business.

Confidentiality

@ Note: This section only appears when:

eThe sn_grc.enable_record_confidentiality property is enabled under
GRC properties.

e The record is in Draft state.

Confidential Option to mark the record as confidential.

Allowed users Users who can view the record.

@ Note: By default, the logged-in user is
added to the list of confidential users.

Allowed groups Groups that can view the record.

Set up estimation for manual metric definition
Enable or disable the estimation property to enable the use of estimated data when actual data
is unavailable, using either pre-defined or custom methods in manual metric definitions.

Before you begin
Role required: admin

Procedure
1. Navigate to All > System Properties > All Properties.
2. Select the Metric estimation property (sn_esg.metric_estimation).
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This property is enabled by default, enabling you to add estimated data when actual data isn’t
available. To restrict data entry to actual values only, disable this property by setting it to False.

3. Select the Value filed and set it to true.

4, Select Update.
Based on your selected settings, the estimation property is configured in your system.

Create an assignment configuration

Create an assignment configuration for a manual metric definition to have data owners
dynamically assigned to metrics.

Before you begin
Role required: admin, sn_esg.admin, or sn_risk.admin

About this task

In the manual metric definition, you can choose between a simple or advanced option for the
assignment of data owners. For the advanced option, you must configure how the data owner
is assigned by creating a new assignment configuration record. For more information, on the
manual metric definition form and fields, see Manual metric definition fields.

Procedure
1. Navigate to All > Assignment and Approval Configurations > Assignment configurations.
2, Click New.

3. On the form, fill in the fields.
For information about the fields, refer to Assignment Configuration New Record .

Note: You cannot have more than one approval configuration applying to the table with
the same priority.

4. Select Save.

Result

Data owners will be assigned to metrics based on the parameters set in your assignment

configuration.

o Note: If the assignment configuration does not return any results the user defined in the
Data owner field of the metric definition record will be the assigned as the data owner.

Create an automated metric definition

Create an automated metric definition to collect the data for a metric. A metric definition
specifies the method and key properties of the metric, such as the unit, direction, or nature of the
metric.

Before you begin
Role required: sn_grc_metric.manager, sn_risk.user, and sn_compliance.user

About this task

In automated metric definitions, the data is collected automatically based on the conditions that
you define in the metric definition. In the conditions, you could specify the tables that are used
for collecting the metric data. For example, if you want to obtain data for all the incidents logged
in a particular month, you can specify the Incident table as a source for data collection.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics >
Automated metric definitions.

2. Select New.

3. On the form, fill in the fields.
For information on the fields of the form, see Automated metric definition fields.

4. Select Save.
() Note: In the new automated metric definition form, only the Details tab is displayed.

After a new automated metric definition is created, additional related lists are displayed
with the Details tab in the form.

Result
The automated metric definition is saved in the Metric definitions list.

What to do next
You can associate an entity type, create metrics, and add citations to the metric definition. See

Update a metric definition for more information.
Automated metric definition fields

The fields of the automated metric definition form are explained in this topic.

New automated metric definition form

Field Description

Basic details

Name Name of the automated metric definition. For
example, Number of incidents.

Active Option to mark the automated metric definition
as active. When enabled, the metric definition
becomes active and ready for use.

Description Brief description of the automated metric
definition.

Unit Unit for the automated metric definition. You
can define the units in which the data is
shown.

Aggregation method The Aggregation method refers to the method

used to calculate the metric data for all the
entities. For example, if you have a metric
that you want to measure for multiple entities
such as people, departments, or regions,
you might want to know how to calculate the
data for each entity into a single score that
represents the overall performance. Your
choice of aggregation method depends on
your goal of metric collection. For example,

if you are interested in overall performance
and want to account for differences in scale
or size between entities, the sum or average
may be more appropriate. If you are interested
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New automated metric definition form (continued)

Field Description

in identifying the best-performing entity, the
maximum may be more appropriate, while if
you are interested in identifying the worst-
performing entity, the minimum may be more
appropriate. The aggregation happens across
time periods based on the frequency defined
in the metric definition. If the frequency is
monthly, the calculation will take place every
month. The four choices for aggregation
methods are as follows:

* Sum: The metric data for all entities are
added together to create a single score.

« Average: The metric data for all entities are
averaged to create a single score.

« Maximum: The highest metric data among
all entities is used as the single score.

« Minimum: The lowest metric data among all
entities is used as the single score.

Class Class to which the metric definition belongs.
The choices are as follows:

« KPI: Indicates how well the risk exposure is
managed against objectives. Use this option
to add entities and additional entities to the
metric definition.

« KRI: Indicates the amount of exposure to a
given risk or set of risks. Use this option to
add risks and risk statements to the metric
definition. This option is available if the
Advanced Risk plugin is activated.

« KCI: Indicates the effectiveness of any
controls that have been implemented to
reduce or mitigate a given risk exposure.
Use this option to add controls and
control objectives to the metric definition.
This option is available if the Policy and
Compliance Management plugin is
activated.

© Important: This field appears only
when the metric definition is created
from the IRM suite of applications. It does
not appear for Environmental, Social, and
Governance Management.

Precision
Number of decimal places after the decimal

point on a score.
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New automated metric definition form (continued)

Field Description

When an indicator has a Precision of O, the
indicator rounds the result to the nearest
whole number. For example, if an indicator
with Precision O calculates the values 7 + (5 /
2), the indicator rounds the result up to 10.

When an indicator has a Precision greater
than O, the indicator rounds to the nearest
decimal point for the given precision. For
example, an indicator with Precision 1 rounds a
result of 4.45 as 4.5.

Calendar Calendar to use for metric aggregation. Only
the configured calendar options are available
for selection. This field is automatically set to
Standard Calendar.

@ Note: Standard calendar refers to the
Gregorian calendar.

Frequency Collection frequency with which the metric
is executed. Indicates how often the metric
definition should collect the data. The choices
are as follows:

« Daily

» Weekly

« Monthly

* Quarterly

« Semi-annually

« Annually

First run date Start date for the collection frequency
schedule for the automated metric definition.

Data collection

Method Type Type of automated metric. The choices are as
follows:

« Basic: Indicates using aggregation methods
such as sum, average, maximum, minimum,
and count distinct.

« Scripted: Indicates using a script to collect
the data. This option can be used when,
for example, you want to collect data from
multiple tables.

« External Source: Indicates that the data
will be collected from external sources.
For example, if you want to source data
about the number of employees in your

© 2026 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

105



servicenow.

New automated metric definition form (continued)

Field Description

Table

Criteria

Aggregate
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organization and their gender ratio, you
can obtain the information from an external
source such as Workday which is an
application that stores human resources
data.

@ Note: If you select Scripted, you must
save the form and select Add script
to add your script. Only users with the
sn_grc_metric.developer role can add
scripts.

Table from which data is obtained for the
metrics. This field only appears if the Method
Type field is set to Basic.

Condition for the record from which data is
collected. Build a filter by adding conditions
that contain a field, operator, and values and
then click Set. For example, you can build a
condition that you want to collect data for only
those incidents the due date for which is in the
current month.

@ Note: Select a value for the Table field
before modifying this field.

Method or the calculation used to aggregate
the data from the chosen table. When an
option is selected in the Aggregate field, a
new Aggregation Field is displayed next to
the Aggregate field. The Aggregation Field
displays the selected record. The choices for
the Aggregate field are as follows:

« Count: Count of the number of records
that are obtained from the chosen table.
For example, if you want a count of the
incidents, you can select this option.

© Note: The Aggregation Field is not
displayed when Count is selected.

« Sum: Sum of the column that is selected in
the Aggregation Field.

« Average: Average of the values of the
column that is selected in the Aggregation
Field.
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New automated metric definition form (continued)

Field Description

« Maximum: Maximum of the values of
column that is selected in the Aggregation
Field.

» Minimum: Minimum of the values of the
column that is selected in the Aggregation
Field.

« Count Distinct: Number of groups in
the result set that is grouped by the
Aggregation Field.

Table field Column or field of the table that is selected in
the Table field. For example, you can select
the Caller column in the Incident table. This
selection enables you to understand that
which callers are associated with the Incident
table and compare them with the callers of
your entities.

@ Note: Select a table before modifying
this field.

Aggregation field Column or field from the table that is selected
in the Table field on which the aggregation
must be performed.

@ Note: This field does not appear if
Count is selected in the Aggregate field.

Entity field Column or field from the entity table. The
entities are matched based on the field
selected in the Table field and the field
selected in the Entity field. This field is
automatically set to Applies to record. In the
context of the Incident table in this procedure,
this field enables you to compare, for example,
which particular incident has been logged by

which caller.

Create metric data task Option to mark the creation of metric data
task.

Data owner assignment type Type of the data owner assignment for the

metrics within the metric definition. The
choices are as follows:

« Simple

The system assigns the specified Data
owner or Data owner group to the Metric.

+« Advanced
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New automated metric definition form (continued)

Field Description

Data owner type

Data owner

Instructions

Collect supporting data
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The system assigns a Data owner based
on the assignment configuration. ESG
admins [sn_esg.admin] or Risk admins
[sn_risk.admin] can set assignment
configurations to dynamically assign data
owners. For more information on creating
assignment configurations see, Create an
assignment configuration and Assignment
Configuration New Record @.

@ Note: Thisis available if you have
the GRC: Approver Configurator
application installed. For more
information see, Using Approver
Configurator for setting up approvals &.

Type of the data owner responsible for the
metric definition. The choices are as follows:

« User

» User group

Data owner responsible for the metric
definition. Select a data owner from the list.

@ Note: If you selected the advanced

option for Data owner assignment type,
this will be the assigned data owner if the
assignment configuration doesn’t return
any results.

Instructions for the data owner.

Option to enable collection for supporting
data.

@ Note: Collected supporting data is

automatically deleted after a certain
period, with the retention time varying
according to the data frequency.

« Daily: After 30 days

» Weekly: After 30 days

« Monthly: After 3 months

» Quarterly: After 3 quarters

« Semiannually: After 3 semi-annual
periods

« Yearly: After 3 years
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New automated metric definition form (continued)

Field Description

Supporting data fields

Approval required

Approver type

Approver

Metric Properties

Type
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Specifies the data fields to be shown in the
supporting data.

o Note: For optimal performance, please
limit your selection to 4-5 fields if your
data is extensive. Selecting more fields
may result in performance issues.

Option to indicate if an approval is required for
the metric definition.

@ Note: When the Approval required
option is enabled, the Approver type
and Approver fields are displayed.

Specifies the type of approver for the metric
definition. The choices are as follows:

« User

« User group

@ Note: This field appears only when the
Metric approval property is set to Simple.
For more information see, Components
installed with ESG Management.

Approver user or approver group that is
responsible to approve the metric definition.

The choices are as follows:

» Approver: Displayed when the User option
is selected.

« Approver group: Displayed when the User
option is selected.

@ Note: This field appears only when the
Metric approval property is set to Simple.
For more information see, Components
installed with ESG Management.

Method used to determine if the data is
collected manually or in an automated manner.

The choices are as follows:
o Automated
« Manual

Select Automated because the procedure is
to create an automated metric definition.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

109



servicenow.

New automated metric definition form (continued)

Field Description

Enterprise Owner Type

Direction

Group

Reporting classification

Enterprise owner

Nature
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Type of enterprise owner who is responsible
for the automated metric definition. The
choices are as follows:

« User

« User group

Direction that you want to see the metric in.
The choices are as follows:

« None: If you don’t want any change in the
metric direction, select this option.

« Minimize: If the desired metric direction is
downward or descending, select this option.
For example, you want to minimize the fuel
consumption.

« Maximize: If the desired metric direction is
upward or ascending, select this option. For
example, you want to maximize the use of
natural resources in your organization.

« Milestone: When the metric direction isn’t
applicable, but the metric is tracked against
a milestone, select this option. For example,
if your organization is going to launch a new
renewable energy product in the market, the
upcoming launch date is considered as a
milestone.

Area that the metric relates to. For example,
the metric may be related to the area of
gender diversity, energy, water consumption,
or may be related to Scope 3 emissions, and
so on.

Tag used to categorise the metric.

User who is the owner of the metric and is
responsible for the metric. For example, for
a metric such as revenue collection, the vice
president or the general manager of the
business unit could be the enterprise owner.

Nature of the automated metric definition. The
choices are as follows:

* None: If you don’t want any change in the
metric direction, select this option.

« Leading (Predictive) Metric: Is predictive
and helps anticipate future outcomes. In this
case, the company may use a leading metric
related to GHG emissions, such as the
amount of energy consumed per production
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New automated metric definition form (continued)

Field Description

unit. By tracking energy consumption,

the company can predict its future GHG
emissions based on the energy sources
used and the efficiency of its production
processes. This leading metric enables the
company to proactively identify areas for
improvement and make informed decisions
to reduce emissions.

Lagging (Measures Impact) Metric:
Measures the impact of past actions or
events. In our example, a lagging metric
related to GHG emissions could be the
total emissions produced by the company
in a given year. This metric provides an
assessment of the company's historical
environmental impact. By monitoring this
metric over time, the company can evaluate
the effectiveness of its emission reduction
efforts and identify areas where further
improvements are needed. Lagging metrics
help measure the outcomes of past actions
and inform future strategies.

Current metric: Monitors ongoing processes
and identifies real-time improvement

areas. For GHG emissions, a current metric
could be the emissions intensity, which
measures the emissions generated per

unit of production. By tracking emissions
intensity, the company can identify specific
areas within its operations that contribute

to higher emissions. This metric helps the
company identify real-time improvement
opportunities, such as optimizing energy
usage, implementing energy-efficient
technologies, or adopting renewable energy

sources.
Subgroup Subgroup that the metric relates to.
Key metric Option to indicate if the metric is a key metric

for your business.

Confidentiality

@ Note: This section only appears when:

«The sn_grc.enable_record_confidentiality propertyisenabled under
GRC properties.

« The record is in Draft state.

Confidential Option to mark the record as confidential.
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New automated metric definition form (continued)

Field Description

Allowed users Users who can view the record.

@ Note: By default, the logged in user is
added to the list of confidential users.

Allowed groups Groups that can view the record.

Create a calculated metric definition

Create a calculated metric definition by aggregating the automatic metric definitions, the manual
metric definitions, and the calculated metric definitions.

Before you begin
Role required: sn_esg.metric_manager

About this task

You can create calculated metric definitions which can be a combination of other metric
definitions and use the data collected in child metric definitions to calculate and aggregate data
for complex scenarios. You can also specify the frequency and the method to aggregate the
metric definitions.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics >
Calculated metric definitions.

2. Click New.

3. On the form, fill in the fields.
For a detailed explanation of the fields, see Calculated metric definition form.

4, Click Save.
5. To aggregate the data, select Aggregate.

Result
The metric definition is saved in the Metric definitions list.

What to do next
Specify the formula for metric calculation. Refer to Formula building in a calculated metric
definition.

Calculated metric definition form

The fields of the calculated metric definition form are explained in this topic.

New calculated metric definition form

Description

Basic details

Name Name of the calculated metric definition. For
example, Number of employees.
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New calculated metric definition form (continued)

Field Description

Active Option to mark the calculated metric definition
as active.

Description Brief description of the calculated metric
definition.

Unit Unit for the metric definition. You can define
the units in which the scores are shown. The
most commonly used units are provided by
default.

Precision
Number of decimal places after the decimal
point on a score. This field is automatically set
to 0.

When the Precision is set to O, the result is
rounded to the nearest whole number. For
example, if a metric definition with Precision

O calculates the values 7 + (5 / 2), the result
rounds up to 10.

When the Precision is set to greater than O, the
result is rounded to the nearest decimal point
for the given precision. For example, Precision
1rounds aresult of 4.45 as 4.5.

Calendar Calendar to use for metric aggregation. Only
the configured calendar options are available
for selection. This field is automatically set to
Standard Calendar.

@ Note: Standard calendar refers to the
Gregorian calendar.

Frequency Frequency for the calculated metric definition.
This field indicates how often the metric
definition should roll up the scores. The
choices are as follows:

« Daily

* Weekly

« Monthly

* Quarterly

« Semi-annually
o Annually

Calculation

Calculation level Level at which the calculation is performed.
The choices are as follows:
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New calculated metric definition form (continued)

Field Description

« Metric definition: If you calculate the data
at the metric definition level, then the data
across all child metric definitions or child
metrics is used for calculation.

« Entity: If you calculate data at the entity
level and specify the calculation method
using the formula builder, then the common
entities across all the child metric definitions
are matched and the data is calculated for
each entity. To aggregate the data to get an
overall score at the metric definition level,
select Entity.

Aggregation method Method to aggregate the metric score at the
entity level. The choices are as follows:

* None

e Sum

« Average

« Maximum

o Minimum
This field only appears when the Calculation
level field is set to Entity.

Metric Properties

Enterprise Owner Type Enterprise owner responsible for the
calculated metric definition. The choices are
as follows:

« User

« User group

Enterprise owner Enterprise owner of the metric definition.

Direction Direction that you want to see the metric in.
The choices are as follows:

» None: If you do not want any change in the
metric direction, select this option.

« Minimize: If the desired metric direction is
downward, select this option. For example,
if you want to minimize the carbon emission
from the datacenters.

« Maximize: If the desired metric direction
is upward, select this option. For example,
if you want to maximize the use of energy-
efficient resources in your organization.
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New calculated metric definition form (continued)

Field Description

Nature
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« Milestone: When the metric direction is not
applicable, but the metric is tracked against
a milestone, select this option. For example,
if your organization has a goal to use 100%
renewable energy by the end of 2029, the
upcoming date for the goal is considered as
a milestone.

Nature of the calculated metric definition. The

choices are as follows:

+ None:

« Leading (Predictive) Metric: Is predictive
and helps anticipate future outcomes. In this
case, the company may use a leading metric
related to GHG emissions, such as the
amount of energy consumed per production
unit. By tracking energy consumption,
the company can predict its future GHG
emissions based on the energy sources
used and the efficiency of its production
processes. This leading metric enables the
company to proactively identify areas for
improvement and make informed decisions
to reduce emissions.

Lagging (Measures Impact) Metric:
Measures the impact of past actions or
events. In our example, a lagging metric
related to GHG emissions could be the
total emissions produced by the company
in a given year. This metric provides an
assessment of the company's historical
environmental impact. By monitoring this
metric over time, the company can evaluate
the effectiveness of its emission reduction
efforts and identify areas where further
improvements are needed. Lagging metrics
help measure the outcomes of past actions
and inform future strategies.

Current metric: Monitors ongoing processes
and identifies real-time improvement
areas. For GHG emissions, a current metric
could be the emissions intensity, which
measures the emissions generated per
unit of production. By tracking emissions
intensity, the company can identify specific
areas within its operations that contribute
to higher emissions. This metric helps the
company identify real-time improvement
opportunities, such as optimizing energy
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New calculated metric definition form (continued)

Field Description

usage, implementing energy-efficient
technologies, or adopting renewable energy
sources.

Group Area that the metric relates to. For example,
the,metric may be related to the area of
energy, water emissions, and so on.

Reporting classification Tag used to categorise the metric.

Subgroup Subgroup that the metric relates to.

Key metric Option to indicate if it is a key metric for your
business.

Confidentiality

() Note: This section only appears if the following situations are true:

«The sn_grc.enable_record_confidentiality propertyisenabled under
GRC properties.

« The record is in Draft state.

Confidential Option to mark the record as confidential.

Allowed users Users who can view the record.

© Note: By default, the logged in user is
added to the list of confidential users.

Allowed groups Groups that can view the record.

Formula building in a calculated metric definition

In a calculated metric definition, you can create formulas to perform calculations for any data that
you may require.

A formula consists of operands, operators, and functions. For example, if you want to calculate
the total employee count from two metric definitions namely number of male employees and
number of female employees, then the selected metric definitions are the operands and the
operator is the symbol or function that performs a specific operation on the operands to obtain a
result. Examples of operators include addition (+), subtraction (-), multiplication (*), and division

).

You can set default values for operands in the Calculated Metric Definition Settings table to
ensure metric calculations continue smoothly even when data is missing or undefined. When a
formula encounters an empty operand, the system automatically applies the configured default
value from this table, allowing the calculation to proceed without interruption. Users can activate
the shipped default record or create custom entries with preferred values for specific operands.
This setup enhances the reliability and flexibility of metric logic, reduces manual intervention,
and supports consistent results across varying data conditions.

When you build a formula in a calculated metric definition, you can choose to build it at either the
metric definition level or at the entity level. Before you save the calculated metric definition form
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and build the formula for metric definition score calculation, you must specify the calculation
level in the calculated metric definition form. The two levels are as follows:

 Metric definition: If you select Metric definition in the Calculation level field, then
the data across all child metric definitions or child metrics is used for calculation.
When you select Execute, the formula is applied and the calculated metric definition
data is generated. For more information, see Configure the formula builder. The

following image shows how calculation occurs at the metric definition level:

Calculated metric definitions
Aggregate at different levels — Metric definition

Calculation level: Metric definition
Calculation method: Sum

METRIC DEF DATA METRIC DEF DATA
""""""""" > 300 S 700

Aggregation method: Sum

Aggregation method: Sum | i
MDI forEntity1 MERSATA - CERIETHIT T N

MD1 for Enfity2 Harfgei - MD2for Enfity3 MeTRIC DATA

Calculated metric Metric definition (can be
. definition Automated/Manual) ) 5 N
servicenow. ©2022 ServiceNow, Inc. All Rights Reserved. Confidential.

« Entity: If you select Entity in the Calculation level field and specify the calculation method
using the formula builder, then the child metrics are created for the calculated metric
definition. These metrics are created for each distinct entity that is associated with the
metric definitions that have been used as operands in the formula. When you Execute
the metric definition, the formula is applied and the metric data is generated. When
you Aggregate the metric definition, the metric data is aggregated and the calculated
metric data is generated. The following image shows how calculation occurs at the entity

Calculated metric definitions
Aggregate at different levels — Entity

Calculation level: Entity ~Enliyl
Calculation method: Sum
Aggregation methed: Sum e .

METRIC DATA
,,,,,,,, MD2 for Enfity 3 - =
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level:
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General guidelines for formula building

While building a custom formula in a calculated metric definition, keep these general guidelines
in mind to easily create your formulas.

Overview of formula building

A formula consists of operands, operators, and functions. Examples of operators include addition
(+), subtraction (-), multiplication (*), and division (/).

Tips to use the formula builder

« As an administrator, when you start using the formula builder, you must begin by typing \
(slash) in the text area.

« It's better to select the operands from the available list instead of typing the operand names.

« Ensure that before you build a formula, the configurations are done by specifying the formula
context, the tables, and the identifiers.

« If there are large formulas, it’s easier to use the Copy button instead of manually selecting the
whole formula as manual copy may result in an omission of certain parts of the formula.

« To reset the formula, use the Reset button to revert the formula to its last saved state.

« Use the Preview button to view the formula in a neat format without the visual clutter of
identifiers.

« While each identifier is an abbreviated two-letter combination of lowercase letters, don’t use fn
as an identifier because generally the fn refers to a function

« Use the formula builders on all browsers except Safari.

« Specify the primary and the secondary columns to identify the right emission factors in case
of emission factors with duplicate names. When defining calculated metric definitions, you can
use emission factors with different units than the collected data.

Configure the formula builder

Specify the formula context, the tables, and the identifiers before you can build a formula.

Before you begin
Role required: admin

About this task

It's necessary to configure the formula builder before a formula can be built in a calculated metric
definition. During configuring, you can specify the formula context, the tables to use, and their
conditions. In the context of ESG Management, if you build the formula at the metric definition
level, you must select the metric definition table and the metric table during configuration. To
build the formula at the entity level, you must select the metric definition and the emission factor
table. Other applications can use the tables that are required for their use. You can configure the
columns and their labels that you want to display along with the emission factor during building
the formula. These labels help in easily identifying the emission factors.

Procedure

1. Navigate to All > Formula builder > Configuration.
2. Select New.

3. On the form, fill in the fields.
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Formula builder configuration form

Field Description

Formula context Configuration available to create the formula
for a specific option. The choices for ESG are
as follows:

o Calculation level - entity
o Calculation level - metric definition

@ Note: Users of other applications can
select different context options.

Application Scope of the application. This field is
automatically set.

Table Tables that you want to use while building the
formula.

Condition Criteria using which the records are filtered

from the selected table when building
the formula. For example, you can build a
condition that Domain is ESG.

Display field Unique display name for the operands such
as the Name field or the ID field.

Identifier An abbreviated two-letter combination of
lowercase letters that is associated with a
specific table name. For example, if your table
name is Hardware accessories, your identifier
can be ha.

@ Note: Using fn as an identifier isn't
permitted as fn refers to function.

Show additional columns Option to decide if you want additional
columns to be displayed.

@ Note: This option is useful in cases
where there are duplicate emission
factor names. Showing additional
details can help metric managers to
select the right emission factor.

Primary column Primary column that you 'd like displayed for
the emission factor during formula building.
For example, if you select From unit, then the
emission factor's From unit will be displayed
along with the factor name.

Secondary column Secondary column that you'd like displayed
for the emission factor during formula
building. For example, if you select To unit,
then the emission factor's To unit will be
displayed along with the factor name.
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Field Description

@ Note: When defining calculated
metric definitions, you can use emission
factors with different units than the
collected data.

Primary column label Preferred label of the primary column
selected. For example, if you selected Short
Description in the Primary column field, you
can provide the preferred label as Shoxrt
Desc.

Secondary column label Preferred label of the secondary column
selected.

4. Select Submit.

Import a formula into a calculated metric definition
Directly import any formula that is stored in Microsoft Excel spreadsheets into a calculated metric
definition. This import helps in quickly building your formula for performing calculations.

Before you begin
Role required: system admin

About this task

Sometimes, you might have a formula saved in a spreadsheet that you want to include into a
calculated metric definition for use in formula building. In these instances, the formula import
functionality proves beneficial. It's crucial to verify that the spreadsheet includes the following
columns with precisely the same column names.

e Name

» Frequency

e Formula

« Calculation level

« Domain area

Procedure

1. Navigate to All > System Import Sets > Administration > Data Sources.

2, Select Metric definition data source.

3. Select the Manage attachment icon and upload the file that contains the formula.
4, Select the Load All Records related link.

5. Select Run Transform.

6. Select Transform.

Result
The calculated metric definition becomes available with the formula in the list of all the metric

definitions.
Create a formula

Build your own formula using either entities or metric definitions.
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Before you begin
Role required: sn_esg.program_manager

sn_risk.user (for Risk users).

About this task

When creating a formula, you can utilize functions like maximum, minimum, or average, as well as
operators such as +, -, /, or * to define the method of computation. To build a formula successfully,
it’s important that at least one metric definition operand or an entity operand is present.

@ Note: The formula can be built using all browsers except Safari.

Procedure

1. Navigate to one of the following locations depending on which application you're using for
creating the formula.

o All > Environmental, Social, and Governance > ESG Workspace > Metrics > Calculated
metric definitions.

o All > Risk Management > Risk Workspace > Metrics > Calculated metric definitions.

2. Open the metric definition for which you want to build a formula and select Build formula >
Formula builder.

3. In the formula text field, type \ to start building your formula.

4. To build the formula either at the metric definition level or the entity level, perform the following
steps.

a. To build a formula at the metric definition level, select two metric definitions or metrics, and
an operator between them.

Example
For example, you can select GHG emissions from employee commuting + Data Center
emissions (market-based) to calculate a sum.

b. To build a formula at the entity level, select two metric definitions or emission factors, and an
operator between them.

5. To copy, reset, or preview the formula, do the following.

a. To copy the formula, select Copy.

b. To reset the formula to its initial state, select Reset.

c. To view the formula without any identifiers in a neat format, select Preview.
6. To save the formula, select Save formula.

7. To execute the formula, select Execute.
It's important to save the formula before you execute it.

8. On the formula builder page, select Need help? to receive guidance on the necessary steps to
build the formula.

Activate default values for CMD calculations

Activate default values for missing operands in CMD formulas using the Calculated Metric
Definition Settings table, or configure new records as needed. This ensures uninterrupted
calculations and allows customization for specific operand requirements.
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Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > Administration > Metric

Definition Settings.

2, To setup default values you can do one of the following:

o Select the default record on the list and activate the record.

@ Note: If required you can make updates to the default record.

o Select New.
3. On the form, fill in the fields.

For information on the fields of the form, see Metric definition setting record fields.

4. Select Submit.

Metric definition setting record fields

The fields of the metric definition setting record form are explained in this topic.

Metric definition setting record

Field Description

Name

Active

One for null record

Order

Skip null record

Zero for null record
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Name for the record. For example, Default
record for CMD calculations.

Option to mark the default values record as
active.

You can select relevant operators in the field.
If a metric operand is null or undefined during
formula execution, and the adjacent operator
matches the one selected, the system assigns
a default value of 1 to that operand—ensuring
the calculation proceeds without error.

Determines the priority of the record when
multiple records are available. The record
which has the highest number is selected

You can select relevant operators in the field.
If a metric operand is null or undefined during
formula execution and the adjacent operator
matches the one selected, the system will
skip that operand from the calculation. This
prevents errors and ensures the formula
continues without interruption.

You can select relevant operators in the field.If
a metric operand is null or undefined during
formula execution and the adjacent operator
matches the one selected in this field, the
system assigns a value of O to that operand.
This ensures the calculation proceeds without
error and maintains consistency in results.
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Metric definition setting record (continued)

Field Description

Type Displays the type of metric definition. This
field is automatically set to Calculated metric
definition.

Table name Specifies the name of the table where the
default values are stored. This field is auto-
populated.

Filter Specifies the condition under which the
default values defined in this record should be
applied during CMD formula execution. You
can setup multiple criteria conditions.

Update a metric definition
Update an existing metric definition to collect the new metrics. You can associate new goals,
targets, and entities with the metric definition.

Before you begin
Role required: sn_esg.metric_manager

About this task
You can use the same form for updating the automated metric definition, manual metric

definition, and calculated metric definition.

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics.

2. Select a metric definition from the list.

3. To update the metric definition Name field, do the following:

a. Select the CJ/ edit icon on the Name field.
b. Update the metric definition name.
c. Optional: Select Apply name changes to selected metrics.

d. Optional: Select the associated metrics where you want the name change should apply.

e. Select Update.

Note: After creating a metric, its name is read only but can be edited via a pop-up
modal. When updated, you can choose which associated child metrics to apply the
change to, and their related tasks are updated automatically.

4. On the form, update the fields as necessary.

Update metric definitions tabs and related lists

Description

Tabs and related lists
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Field Description

Details tab
Details of the metric, such as metric definition

name, metric properties, method, and
schedule in the automated metric definition.

Details of the metric, such as collection
method, schedule, data collection details, are
approved in the manual metric definition.

Details of the metric, metric properties, and
roll up properties in the calculated metric
definition. The fields on the Details tab are
explained in the Metric definition forms.

Entity type Details of the entity type to be associated
with the metric. For example, provides the
name, description, and conditions, such as
active, need update, and processing entities.
To add a new entity type, select Add.

@ Note: The Entity type related list
is displayed only for an automated
metric definition and a manual metric
definition. It isn’t displayed for the
calculated metric definition.

Entities Entities that can be associated with the
metric definition. Provides details, such as
name, owned by, class, and compliance
score in percentage (%). To add new entities,
select Add.

@ Note: This related list is displayed
only for an automated metric definition
and a manual metric definition. It isn’t
displayed for the calculated metric
definition.

Metrics Details of the metrics, such as name,
associated entity, and active state of the
metric. To add a new metric, select New.

Citations Details of the citations such as reference,
name, authority document, description, and
compliance score in percentage (%). To add a
new citation, select Add.

Goals Details of the goals, such as name, state,
category, start date, end date, owner, and
status. To add a new goal, select Add.

Targets Details of the target, such as name, owner,
state, status, progress, actual value, target
value, and end date. To add a new target,
select Add.
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Field Description

Metric definition data Details of the metric definition data, such as
collection frequency, collection definition,
interval end date, value, and state.

@ Note: This related list is displayed
only for an automated metric definition
and a manual metric definition. It isn’t
displayed for the calculated metric
definition.

Calculated metric data Details of the calculated metric data, such
as interval end date, roll up frequency, and
value.

© Note: This related list is displayed
only for the calculated metric definition.
It isn’t displayed for the automated
metric definition and the manual metric
definition.

Thresholds Details of the metric definition thresholds,
such as threshold type, metric definition,
valid from, valid until, red threshold, amber
threshold, and target value.

@ Note: This related list is displayed
only for an automated metric definition
and a manual metric definition. It isn’t
displayed for the calculated metric
definition.

5. To save the metric definition, select Save.

6. To calculate the calculated metric data for the calculated metric definition, select Aggregate.
The Aggregate action calculates the calculated metric data for the current interval end date
and roll-up frequency to its parent metric definition. The calculated metric data record is
displayed under the calculated metric data related list. A calculated metric definition score is
created if it doesn’t exist for the current interval.

7. To delete the metric definition, select Delete.

8. To visually explore the 360° relationship view of the metric definition, select 360° view.

Create a metric

Create a metric to perform calculations on your data.

Before you begin
Role required: sn_esg.metric_manager

About this task

To create a metric, you need a metric definition and an entity. A metric definition defines the
method for collecting the score for an entity. When a metric definition gets associated with an
entity, it creates a metric.
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics.

2. Select New.
3. On the form, fill in the fields.

New metric form

Field Description

Name

Description
Active

Key metric

Metric definition

Type

Entity

Enterprise Owner Type

Enterprise owner

Metric Properties

Direction
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Name for the metric. For example, Number
of incidents- ACME Asia.

Brief description of the metric.
Option to mark the metric definition as active.

Option to mark the metric definition as a key
metric.

Metric definition associated with the metric.

Method used to determine if the score

is collected manually or in an automated
manner. This field is automatically set to
Automated but the value changes when you
select the metric definition and gets updated
to the type of the metric definition.

Entity associated with the metric.

Enterprise owner type who is responsible for
the metric. This field is automatically set.

Enterprise owner of the metric definition. This
field is automatically set.

Direction of the automated metric definition.
The choices are as follows:

© None: If you don’t want any change in the
metric direction, select this option.

o Minimize: If the desired metric direction
is downward or descending, select this
option. For example, you want to minimize
the fuel consumption.

o Maximize: If the desired metric direction
is upward or ascending, select this option.
For example, you want to maximize the use
of natural resources in your organization.

o Milestone: When the metric direction
isn’t applicable, but the metric is tracked
against a milestone, select this option. For
example, if your organization is going to
launch a new renewable energy product
in the market, the upcoming launch date is
considered as a milestone.
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Field Description

Precision
Number of decimal places after the decimal

point on a score.

When an indicator has a Precision of O, the
indicator rounds the result to the nearest
even, whole number. For example, if an
indicator with Precision O calculates the
values 7 + (5 / 2), the indicator rounds the
result up to 10. However, if the formula
calculates 2 + (5 / 2), the indicator rounds the
result down to 4.

When an indicator has a Precision greater
than O, the indicator rounds to the nearest
decimal point for the given precision. For
example, an indicator with Precision 1 rounds
aresult of 4.45 as 4.5.

Unit Unit for the automated metric definition. You
can define the units in which the scores are
shown. The most commonly used units are
provided by default.

Nature Nature of the automated metric definition.
The choices are as follows:

© None

o Leading: If the metric is an indicator
of future events, select this option. For
example, consider the number of sales
that a store makes on new solar batteries.
This number is a leading indicator for the
support requests that the store may receive
in the future.

o Lagging: If the metric is an indicator of past
events, select this option. For example,
consider the number of sales that a store
has made in the previous year. This number
is a lagging indicator for the support
requests that the store has received in the
past year.

o Current: If the metric is an indicator of
the current state of the events, select this
option. For example, consider the number
of sales that a store has made in the
current year. This number is an indicator of
the current support requests received by
the store.

Method

Table Table that is queried for creating the metric
definition. This field is automatically set.
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Field Description

Method Type

Table

Criteria

Aggregate

© 2026 ServiceNow, Inc. All rights reserved.
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Type of automated metric. The choices are as
follows:

o Basic

o Scripted

@ Note: If you select Scripted, you must
save the form and select Add script
to add your script. Only users with the
sn_grc.developer role can add scripts.

Table that is queried for creating the metric
definition. This field is automatically set.

Condition for the record from which a score is
obtained. Build a filter by adding conditions
that contain a field, operator, and values and
then select Set.

@ Note: Select a value for the Table field
before modifying this field.

Method to aggregate the automated metric
definition score. When an option is selected
in the Aggregate field, a new Aggregation
Field is displayed next to the Aggregate field.
The Aggregation Field displays the selected
record. The choices for the Aggregate field
are as follows:

o Count: Count of the number of records that
are rendered by the table query that is set
in the filter criteria.

© Sum: Sum of the values of the parameters
based on the selected value in the
Aggregation Field.

o Average: Average of the values of the
parameters based on the selected value in
the Aggregation Field.

o Maximum: Maximum of the values of the
parameters based on the selected value in
the Aggregation Field.

o Minimum: Minimum of the values of the
parameters based on the selected value in
the Aggregation Field.

o Count Distinct: Number of groups in
the result set that is grouped by the
Aggregation Field.
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Field Description

Reference field

Schedule

Calendar

Frequency

First run date

Due date offset

Next run date

Period date

Data Collection Details
Data owner type
Data owner

Approval
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@ Note: The Aggregation Field is
displayed for all the options except
Count.

Field based on which the metric data can be
segregated. This field connects the entity to

the selected scoring table and it calculates a
score that is specific to an entity.

@ Note: Ensure that the table that the
reference field points to matches
with the table of the records that the
associated entities point to, through the
Applies to field in the entity form.

@ Note: It's the user's responsibility to
validate the criteria mentioned in the
note as the system doesn’t validate
it. Select a table before modifying this
field.

Calendar to use for metric collection.

Only the configured calendar options are
available. This field is automatically set to
Standard Calendar. Standard calendar refers
to the Gregorian calendar. This field can be
modified only if the metric definition for this
metric doesn’t use the standard calendar.

Collection frequency for the metric definition.
This field is automatically set based on the
frequency of the selected metric definition.

Date the metric is run the first time.

Number of days after the schedule end date
when the metric data task becomes overdue.
For example, if the frequency of a metric
definition is monthly and if the you enter 15
in this field, then the due date for metric data
task will be overdue 15 days after the month
ends. This field only appears when the metric
definition associated with the metric is of
type Manual.

Date when the metric going to be executed.

Date used to specify the start and end dates
for the data collection period.

Data owner type, such as User.

Name of the user as the data owner.
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Field Description

() Note: This section appears only when the Metric approval property is set to Simple.
For more information see, Components installed with ESG Management.

Approval required Option to indicate if an approval is required.

Approver type Type of the approver of the metric definition.
The choices are as follows:

o User
o User group

User Approver user or approver group that is
responsible to approve the metric definition.
The choices are as follows:

o Approver: Displayed when the User option
is selected.

o Approver group: Displayed when the User
group option is selected.

@ Note: By default, the approver is the
user specified in the metric definition,
but this can be overridden at the metric

level.
Classification
Group Area that the metric relates to.
Reporting classification Tag used to categorise the metric.
Subgroup Subgroup that the metric relates to.

Confidentiality

@ Note: This section only appears when:

o The sn_grc.enable_record_confidentiallity propertyis enabled under
GRC properties.

o The record is in Draft state.
Allowed users Users who can view the record.

@ Note: By default, the logged in user is
added to the list of confidential users.

Allowed groups Groups that can view the record.

4. Click Save.

() Note: After a new metric is created, the related lists along with the Details tab are
displayed on the form. You can view the metric data overview in the Overview tab. The
Metrics overview page displays the metrics data details when you execute a metric along
with the duration for which the data is collected.
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Result
The metric is saved in the Metrics list.

Create a threshold for a metric

Create thresholds such as amber threshold and red threshold for metrics and metric definitions.

Thresholds refer to predetermined values used to assess the performance of a metric. These
thresholds are typically defined based on specific criteria or objectives and serve as reference
points to determine whether the measured value or performance meets, exceeds, or falls below

the desired level.

Before you begin
Role required: en_esg.metric.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics.

2. Open the quantitative metric definition for which you want to add thresholds.

3. Select the Thresholds related list.

a. Select New.

b. On the form, fill in the fields.

Metric definition threshold form

Field Description

Threshold type

Amber threshold

Valid from

Target value

Red threshold

Valid until

Type of threshold. The choices are the
following.

= Static: A static threshold for a metric or
a metric definition refers to a fixed value
used as a limit for tracking a metric.

= Dynamic: Dynamic thresholds are
specified in percentages. This means that
the percentage variance is calculated
based on two factors: direction and the
previous data

For more information, see Thresholds for

metrics

Percentage value that signifies moderate
change in the variance of target value.

Date the data is valid from.

Previous data against which the percentage
variance is compared.

Percentage value that signifies critical
change in the variance of target value.

Date the data is valid until.

4. Select Submit.

5. To copy the thresholds to the metrics, select Copy threshold.
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Create a metric unit

Define the units in which the metric scores are displayed. The units can be numbers,
percentages, currencies, quantities of time, or any other unit that you define. The commonly
used units are provided with the ESG Management application by default.

Before you begin
Role required: sn_esg.metric_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics >
Units.

2. Click New.
3. On the form, fill in the fields.

New unit form

Name Name of the unit. For example, Megawatt -
hour.

Format Format of the unit. For example, {0} MWh
gives you the number of Megawatt-hours with
the abbreviation MWh.

Unit family Family to which the unit belongs. For
example, Gallon can be associated with the
Volume unit family.

4. To save the metric unit, click Save.

Result
The metric unit is saved in the Units list.

Create a unit family

Create a unit family to group similar units together. For example, the various units of distance
such as miles and kilometers can be grouped. Unit families help you to organize units during unit
conversion.

Before you begin
Role required: sn_esg.metric_manager

About this task

Creating unit families also supports conversion of units. Sometimes, the unit in which metric
data is entered may be different from the reporting unit of the metric definition. In such cases,
the units must be converted. For example, the metric data may be entered in US gallons and
the reporting unit in the metric definition is Liters. If US gallon and liters belong to the same unit
family such as Volume, you can convert the units.

Various formulas are used to convert different units. If the reporting unit of a metric definition
belongs to a unit family that has the conversion factor as Calculated, then the metric data tasks
for that metric must be provided in the same unit as the metric definition. For example, if the
reporting unit for temperature in a metric definition is Celsius, and if the conversion factor of
temperature is set to Calculated, then all the metric data tasks for that metric definition can only
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be provided in Celsius. In such cases, users can specify the formula that must be used for the
conversion. For more information see, Configure the formula builder.

Procedure
1. Navigate to All > Environmental, Social, and Governance > Administration > Unit family.

2. Select New.
3. On the form, fill in the fields.

Unit family form

Field Description

Name Name of the unit family. For example,
Temperature.
Conversion factor Conversion factor that must be applied when

converting units from the family. The choices
are as follows:

o Direct: Use this option if the conversion of
the units in the family can be done directly.
For example, you can convert kilometers to
miles using direct conversion.

o Calculated: Use this option if the
conversion formulas are complex. For
example, to convert temperatures in
degrees Celsius to Fahrenheit, the formula
is °F = °C x (9/5) + 32.

4. Select Submit.

Create fiscal calendars

Collect, aggregate, and report data based on your fiscal calendars, which may differ from the
standard Gregorian calendar. Global organizations often operate in countries with unique fiscal
calendars. By creating fiscal calendars in the ESG Management application, you enable local
entities to collect data according to their own schedules.

Before you begin
Role required: sn_grc_metric.admin

Procedure
1. Navigate to All > Environmental, Social, and Governance > Metric Calendar Configurations.

2. Select New.
3. On the form, fill in the fields.

Metric calendar configuration form

Description
Name Calendar name. For example, Australia
calendar.
Description Brief description of the calendar.
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Field Description

Start month Month the fiscal year begins.

End month Month the fiscal year ends. This field is
automatically set based on the start month.
This field cannot be modified.

Year representation Specify how you want to represent the fiscal
year. In some countries, such as India, the
fiscal year starts in one calendar year and
ends in the next. For instance, the fiscal year
in India starts on April 1, 2024, and ends on
March 31, 2025.

In this field, the choices are as follows:

o Start year: Represents the fiscal year by
its starting year. For example, 2024 for the
fiscal year starting April 1, 2024.

o End Year: Represents the fiscal year by
its ending year. For example, 2025 for the
fiscal year ending March 31, 2025.

4. Select Submit.

What to do next

Map the source and target calendars. For more information, see Map target and source
calendars.

Map target and source calendars

Map target calendars with source calendars to establish the data roll up hierarchy. You can
create multiple calendar mappings depending on your requirements.

Before you begin
Role required: sn_grc_metric.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > Metric Calendar Configurations.
2. Select the Map Calendars related link.

3. On the form, fill in the fields.

Metric calendar configuration mapping form

Description
Target calendar Calendar to which data will roll up.
Source calendar Calendar from which data will roll up.

4. Select Submit.

5. Navigate back to the Metric calendar configurations page.
a. Select the calendars you created.
b. Select Generate metric calendars.
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Result
The metric calendars with the frequencies annually, semi-annually, and quarterly are generated.

Add entities for fiscal calendars
Identify the entities that will follow the fiscal calendars you have created. This ensures that data
collection is consistent, as each entity follows the designated calendar.

Before you begin
Role required: sn_grc_metric.admin

Procedure
1. Navigate to All > Environmental, Social, and Governance > Metric Calendar Configurations.
2, Open the calendar configuration for which you want to add entities.
3. Select the Entities related list.
a. Select Edit.
b. Move the required entities from the Collection list to the Entities list

c. Select Save.

Importing historical metric data

Import historical metric data by using a pre-defined import template with instructions. This
process helps with updating and managing metric data within an organization, helping ensure
that all data complies with established business rules and maintains integrity throughout the
process.

Importing data and task creation

The metric import process involves you downloading a template, filling it out with required data
per the instructions, and you importing it back to the system. As shown in the following example,
you can download the template by navigating to the list of Metric import templates, selecting

the Metric data template, and then selecting the download icon £ to download the Metric data
upload template.xlsx file.

Example of downloading a template

= List > Import template: Metric data template

Metric data template © B

Record type
Import template

Details

Import template

Name >

Metric data template ’

Document %

Metric data upload template.xIsx Z U

® Download this template and fill in the data
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You can import the completed template by navigating to the Metric import jobs list, selecting
New, providing a name and description for the job, attaching the completed template by

selecting the attachment icon @, and then selecting the .xIsx file from your file browser. The
following example shows an import job and how to attach the completed template.

Example of importing a template

= List > Metricimport job: Demo job

Demo job &

Record type
Metric import job

Details

Attachments

Metric import job ~

Name % ©

| Demo job ]

Description ®

No attachments available

Drag or select files to upload

State Sel il
elect file

The system then performs validations to check for mandatory fields like metric start date, end
date, and state, as well as duplicate records. If the data meets these criteria, it is imported into
the metric data table, and corresponding metric data tasks are created if you specified a task as
required in the template. You can review import job details such as metrics that were ignored,
skipped or updated as well as import log information by navigating to the transform history and
import log tabs as shown in the following example.

Example of complete import job

= List > Metricimport job: Demo job

Demojob © E]

Record type State
Metric import job Completed

Details ITransform history I Ilmport log I

Metric import job ~ Attachments | @

Name % ®
- [ Q_Search attachments X ]
{ Demo job ]
Description ® v Metric data upload tem...
V,
State
Completed

() Note: When the due date for metric data tasks are calculated during an import job, non-
working days are not included.
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To learn more about importing historical data, see:

Download a metric import template

Download and populate a metric import template that you can use for importing historical metric
data and tasks. This template includes directions and is formatted specifically for this type of
data import.

Before you begin
Role required: sn_esg.metric_manager or esg.program_manager

About this task
The metric import template must be used for importing historical metric data and tasks.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Metric
Import templates.

2. Select the metric data upload template from the list and download the metric data upload

template by selecting the download icon

3. Fill out the metric data upload template.
You can view directions for filling out the template by navigating to the Directions tab of the
template file.

© Important: If approval is required for any of the imported metric data tasks, select
pending for the state and confirm that the Is metric data task required field is set to true.

What to do next
Upload the complete metric import template as part of an metric import job. For more information,
see Import historical metric data and tasks.

Import historical metric data and tasks

Import historical metric data with or without corresponding metric data tasks.

Before you begin

Download the metric template and follow the instructions to fill it out. You must use this .xIsx

template for importing historical metric data. For more information on creating a metric data
template, see Download a metric import template.

Role required: sn_esg.metric_manager or esg.program_manager

About this task

Importing historical metric data enables program managers and metric managers to manage and
analyze past performance, identify trends, and make informed decisions. This process includes
downloading a template, filling it with necessary data, and uploading it back into the system,
which then creates metric data tasks.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Metric
Import jobs.

2, Select New to create a new metric import job.

3. Fill in the form and then select Save.
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Create New Metric import job form

Field Description

Name Provide a name for the metric data import job.

Description Provide a brief description of the metric data
import job.

State The state of a job is updated as the metric
import job is processed.
o Draft

° |n progress

o Completed with errors

o Completed

4, Attach the completed template file by selecting the attachments icon and selecting the file
from your local hard drive.

© Important: The questionnaire template is downloaded in the .xIsx format and after
being completed must be uploaded in the same format.

5. Select Save.
The template file has been uploaded and a metric import job has been created.

6. Navigate to the Transform history tab and Import log tab to review potential errors, the
number of metrics processed, ignored, or skipped, error messages, and their levels of severity,
and soon.

a. Correct any errors in the Microsoft Excel spreadsheet.

b. Attach the updated template file by selecting the attachments icon @ and selecting the file
from your local hard drive.

c. Select Re-import and repeat until all errors are resolved and the import metrics job is
completed successfully.
Select the help icon @ for additional instructions on re-importing a metric job.

The metrics are imported and their associated metric data task records are created.

() Note: Metric data tasks are assigned based on the state of the metric data and the
approval requirements. If data is provided, the state of the metric data task moves to
Work In Progress. You must submit the task for the state to update to Awaiting approval
or closed. Approval records are created and assigned according to the metric definition
approval. If approval is not required, the task is created in a new state. Additionally, if the
metric data is completed, a metadata task is created for audit purposes.

Convert metric data to a different unit

Convert any metric data into a preferred reporting unit.

Before you begin
Role required: sn_esg.program_manager
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About this task

The preferred reporting unit for any data is specified in a metric definition. When users enter the
data in a metric data task, they may do so in a unit that is different from the unit set in the metric
definition. For example, a user may enter data about water usage in liters but the organization
needs the report in US gallons. And therefore, the metric definition is also set to gallons. In this
case, liters must be converted to US gallons.

Note: In the metric data task, only those units that belong to the same unit family are
available for the data. Unit conversion only applies to units that have the unit family
conversion factor set to Direct.

Procedure

1. Navigate to All > Environmental, Social, and Governance > Administration > Unit
Conversions.

2. Select New.
3. On the form, fill in the fields.

Unit conversion form

Field Description

Name Name of the unit conversion. For example,
Litres to gallons.

From unit Unit to convert.

To unit Unit to convert to.

Unit family Unit family to which the unit belongs. For
example, Volume.

Value Conversion value. For example, the
conversion value from liters to gallons is
0.264172.

4. Select Submit.

Using GRC: Metrics to provide data

Using the GRC: Metrics application you can track your business goals, define your key
risk indicators (KRIs) and key performance indicators (KPIs), and generate reports for the
management to provide insights into the progress.

Update a metric

Update a metric to add goals, metric data, and targets. Associate citations to the metric.

Before you begin
Role required: sn_esg.metric_manager

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics.
2. Select a metric from the list.

3. On the form, update the fields as necessary.
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Update metric tabs and related lists

Field Description

Tabs

Name

Description

Metric definition

Entity

Enterprise Owner Type

Type

Active

Key metric

Enterprise owner

Metric Properties

Direction

Precision

Unit

Nature

Method
Method Type

Table

Criteria

Aggregate

Reference field

Schedule
Schedule

Name for the metric. For example, Number
of incidents- ACME Asia.

Brief description of the metric.
Metric definition associated with the metric.
Entity associated with the metric.

Enterprise owner type who is responsible for
the metric. This field is automatically set to
display the enterprise owner type.

Type of the automated metric definition. This
field is automatically set.

Option to mark the metric definition as active.

Option to mark the metric definition as a key
metric.

Enterprise owner of the metric definition. This
field is automatically set.

Direction of the metric definition. This field is
automatically set.

Precision for the metric definition. This field is
automatically set.

Unit for the metric definition. This field is
automatically set.

Nature of the metric definition. This field is
automatically set.

Type of method used to collect the metric
data.

Table that is queried for creating the metric
definition. This field is automatically set.

Conditions for querying the table. This field is
automatically set.

Method to aggregate the metric definition.
This field is automatically set.

Reference field for the metric definition
method. This field is automatically set.

Collection frequency for the metric definition.
This field is automatically set.
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Field Description

First run date

Next run date

Data Collection Details
Data owner type

Data owner

Approval

Approval required

Metric data tasks tab

Related lists

Goals

Metric data
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Date for the first run time. This field is
automatically set.

Date for the next run time.

Data owner type such as User.

Name of the user as the data owner.

Option to be enabled if an approval is
requested for the metric.

Information about the metric data task, such
as name, number, assigned to, priority, and
state.

Details of the goals associated with the
metric, such as name, state, category, start
date, end date, owner, and status. To add a
new goal, click Add.

Details of the metric data such as start
date, end date, value, collector metric data,
collection frequency, and type.

Start date: The start date is the date the data
collection begins.

End date: The end date is the end of the
period date that determines the interval for
which the score is calculated. The end date
depends on the frequency of the metric
definition. The end date is used for tracking
the scores. Every score is time-dependent
and it has a reference to the interval end
date.

Collection frequency: The options in the
collection frequency field are:

o Daily: Score that gets created for each day.

o Weekly: Score that gets created by the end
of the week date (Sunday). Monday is the
start of the week and Sunday is the end of
the week.

© Monthly: Score that gets created by the
end of the month.

© Quarterly: Score that gets created by the
end of the quarter. For example, Q1 ends
on March 31, Q2 ends on June 30, Q3
ends on September 30, and Q4 ends on
December 31in a year.
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Field Description

o Semi-annually: Score that gets created
by the end of the 6-month period. The
end date for the semester is June 30 and
December 31in a year.

o Annually: Score that gets created by the
end of the year. The end date for the year is
December 31.

Targets Details of the targets associated with the
metric, such as name, state, owner, start date,
end date, type, and measure. To add a new
target, click Add.

Citations Details of the citations, such as reference,
name, authority document, description, and
compliance score percentage (%). To add a
new citation, click Add.

4. To save the metric, click Save.
5. To delete the metric definition, click Delete.

6. To execute the metric, click Execute.
A metric data score is created if it doesn’t exist for the current interval. Re-executing a metric or
a metric definition for the current interval only updates the score.

7. To visually explore the 360° relationship view of the metric definition, click 360° view.

Update a manually created metric

Update a manually created manual metric to add goals, metric data, and targets. Associate
citations to the metric.

Before you begin
Role required: sn_esg.metric_manager

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics.
2. Select a manually created metric from the list.

3. On the form, update the fields as necessary.

Update metric tabs and related lists

Field Description

Tabs
Name Name for the metric. For example, Number
of incidents- ACME Asia.
Description Brief description of the metric.
Metric definition Metric definition associated with the metric.
Entity Entity associated with the metric.
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Field Description

Enterprise Owner Type

Type

Active

Key metric

Enterprise owner

Metric Properties

Direction

Precision

Unit

Nature

Method

Instructions

Schedule

Calendar

Frequency

© 2026 ServiceNow, Inc. All rights reserved.
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Enterprise owner type who is responsible for
the metric. This field is automatically set to
display the enterprise owner type.

Type of metric definition. This field is
automatically set.

Option to mark the metric definition as active.
This field is automatically set.

Option to mark the metric definition as a key
metric. This field is automatically set.

Enterprise owner of the metric definition. This
field is automatically set.

Direction of the metric definition. This field is
automatically set.

Precision for the metric definition. This field is
automatically set.

Unit for the metric definition. This field is
automatically set.

Nature of the metric definition. This field is
automatically set.

Instructions for the data owner. Method of
collection for the manual metric definition.
This field is automatically set.

Calendar to use for metric aggregation. Only
the configured calendar options are available
for selection. This field is automatically set to
Standard Calendar.

@ Note: Standard calendar refers to the
Gregorian calendar.

Collection frequency with which the metric
is executed. Indicates how often the metric
definition should collect the data. The
choices are as follows:

o Daily
o Weekly
Monthly

@]

© Quarterly
© Semi-annually

© Annually
This field is automatically set.
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Field Description

First run date Date for the first run time. This field is
automatically set.

Next run date Date for the next run time.

Period date Date used to specify the start and end dates
for the data collection period.

Due date offset Number of days after the schedule end date
when the metric data task becomes overdue.
For example, if the frequency of a metric
definition is monthly and if you enter 15 in
this field, then the due date for metric data
task will be overdue 15 days after the month
ends. This field is automatically set.

Data Collection Details

Data owner type Data owner type such as User.

Data owner Name of the user as the data owner.

Approval

Approval required Option to be enabled if an approval is
requested for the metric.

Metric data tasks tab Information about the metric data task, such
as name, number, assigned to, priority, and
state

Classification

Group Area that the metric relates to. This field is
automatically set.

Subgroup Tag used to categorise the metric. This field is
automatically set.

Reporting classification Tag under which the metric definition and
metric is categorized. For example, GRI,
SASB, or Steering Committee Review.

Related lists

Goals Details of the goals associated with the
metric, such as name, state, category, start
date, end date, owner, and status. To add a
new goal, select Add.

Metric data

Details of the metric data such as start
date, end date, value, collector metric data,
collection frequency, and type.

Start date: The start date is the date that the
data collection begins.

End date: The end date is the end of the
period date that determines the interval for
which the score is calculated. The end date
depends on the frequency of the metric
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Field Description

definition. The end date is used for tracking
the scores. Every score is time-dependent
and it has a reference to the interval end
date.

Collection frequency: The options in the
collection frequency field are:

o Daily: Score that gets created for each day.

o Weekly: Score that gets created by the end
of the week date (Sunday). Monday is the
start of the week and Sunday is the end of
the week.

© Monthly: Score that gets created by the
end of the month.

© Quarterly: Score that gets created by the
end of the quarter. For example, Q1 ends
on March 31, Q2 ends on June 30, Q3
ends on September 30, and Q4 ends on
December 31in a year.

o Semi-annually: Score that is created by the
end of the 6-month period. The end date
for the semester is June 30 and December
31in ayear.

© Annually: Score that gets created by the
end of the year. The end date for the year is
December 31.

Targets Details of the targets associated with the
metric, such as name, state, owner, start date,
end date, type, and measure. To add a hew
target, select Add.

Citations Details of the citations, such as reference,
name, authority document, description, and
compliance score percentage (%). To add a
new citation, select Add.

Thresholds Details of the thresholds associated with the
metric, such as type, related metric, valid
dates, threshold color, and target value. To
add a new citation, select Add.

4. To save the metric, select Save.
5. To delete the metric definition, select Delete.

6. To execute the metric, select Execute.
A metric data score is created if it doesn't exist for the current interval. Re-executing a metric or
a metric definition for the current interval only updates the score.

7. To visually explore the 360° relationship view of the metric definition, select 360° view.
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Provide data for a metric data task

Use the metric data task to provide data for a manual metric. Metric data helps you analyze your

progress toward your goals.

Before you begin

« To enable support for data estimation refer to Set up estimation for manual metric definition.

« Role required: sn_esg.data_owner

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics > My

metric data tasks.

2, Open the task for which you want to provide the data.

3. Select Move to In Progress.

4, On the Metric information form, under the Metric input section, fill in the following fields.

Field Description

Type of Data

Estimation method

Number of past periods

© 2026 ServiceNow, Inc. All rights reserved.
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Indicates whether the data provided is actual
or estimated.

Estimation value for the data. You can choose
from the following options:

o Manual: Enter a custom estimated value
manually.

o Average: Calculate the estimated value
based on the average of historical data.

o Same period as last year: Use the value
from the same period in the previous year
as the estimated value.

This field appears only when Estimate is

selected in the Type of Data field in the

metric form.

Number of past periods data to be included
in the average calculation. This field appears
only when Average is selected in the
Estimation method field in the metric form.

© Note: The maximum past period limit
varies by frequency, confirm that your
selection is within these limits:

o Daily: Up to 180 days

e}

Weekly: Up to 52 weeks
Monthly: Up to 36 months

e}

[¢]

Quarterly: Up to 12 quarters

o Semiannually: Up to 6 semi-annual
periods

(e]

Yearly: Up to 3 years

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
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Field Description

Same period last year Specifies the period from the previous year
to use as the estimated value. This field
appears only when Same period as last year
is selected in the Estimation method field in
the metric form.

Metric data Value for the metric. This field appears
only when Quantitative is selected in the
Category field in the metric form.

© Note: When Estimate is selected
in the Type of Data a refresh icon is
available on Metric data field. Selecting
that calculates the estimated metric
data value.

Unit Unit of the data. For example, US gallon.

@ Note: You can provide the data in
any unit and it gets converted to the
reporting unit specified in the metric
definition.

Variance (%) The variation between the current period and
the previous period's metric data.

Response Response for the metric. This field appears
only when Qualitative is selected in the
Category field in the metric form.

| certify and acknowledge that the response | Option to certify data accuracy.
have submitted is accurate.

Additional comments (Customer visible) Additional information for the metric data.

5. Select Save.

6. To provide evidence or supporting information, in the Related documents, related list, select
New.

7. On the Related Document form, fill in the fields.

Related Document form

Field Description

Name Provide a name for the supporting
information.

Url Select the lock icon to add a supporting URL.

Metric data task This field is automatically set to the name
of the metric data task for which you're
providing information.

8. Select Submit.
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Provide responses for multiple metrics

Use the metric tasks module to provide responses for multiple metrics in an easy-to-use format.

Before you begin
Role required: sn_esg.data_owner

About this task

As a data owner, you have to provide data or responses for multiple metric data tasks. The data
that you provide comes from multiple sources and there can be multiple data owners. In such a
scenario, it’'s hard to maintain the audit trail for data input. The metric tasks module enables you
to provide data for multiple metric data tasks. Use the filters such as metric data tasks by entity,
metric groups, metric subgroups, start date, end date and approval level to select the metrics for
which you want to provide data. You can view the responses that you've entered, submitted, and
also if the dates for data or for response submission are overdue. You can only provide metric
data responses for tasks that aren’t in the Closed or Awaiting approval state.

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace.

2. Select the Metric data table icon (ﬂ).

3. Select the filter icon V and set the Entity, Metric group, Metric subgroup, Task type, Start date,
End date, and Approval level filters to show the tasks for which you want to provide data.

Only those Groups which have open metric data tasks appear in the filter.

4, Select Apply.
5. Double-click the cell for the entity in which you want to provide data.

6. Enter the information needed for your response and select Save.
Perform this step for each cell for which you want to provide data. You can scroll the cells to
provide responses for all the tasks.

(] Note: You have the option to select a choice or enter HTML depending on how the
related metric definition has been set up. These formats are available when the manual
metric definition Category field is set to Qualitative. For more information, see Create a
manual metric definition and Manual metric definition fields.

7. Select the tasks for which you want to submit the responses.

Press the Command key and then click the
cell to select.

If you’re a macOS user

Press the Control key and then click to select

If you're a Windows user the cell in focus.

8. To provide any evidence for the data that you’ve entered, select the Attachments and links
tab on the Contextual side panel and add the links and attachments as required.

After selecting the cell, press the Control
key and then and then the | key to open the
side panel.

After selecting the cell, press the Command
key and then the | key to open the side panel.
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Press the Escape key to close the side pan

el Press the Escape key to close the side panel.

If you're a Windows user ‘

9. Select Submit.
To select all cells for each individual metric definition for submission, select the check box in
the corresponding row. To select all cells for submission, select the check box in the header
row of the Metric data tasks table.

10. Optional: Select the check boxes that you want and then select Submit.

(Optional) Press the Tab key to get the focus
on to the select all check box. Press the Enter
key to select the select all check box.

If you don’t want to use the select all check
box, press the Tab key again to get focus on
to the table body. After getting focus on to the
body, you can use the arrow keys to navigate
between the cells. Press enter to select each
check box.

If you’re a macOS user

(Optional) Press the Tab key to get the focus
on to the select all check box. Press the Enter
key to select the select all check box.

If you don’t want to use the select all check
box, press the Tab key again to get focus on
to the table body. After getting focus on to the
body, you can use the arrow keys to navigate
between the cells. Press enter to select each
check box.

If you're a Windows user

Review a metric data task

Review a metric data task for a manual or automated metric definition, and then either approve or
reject the task based on your review.

Before you begin
Role required: sn_esg.data_owner, sn_esg.program_manager, or sn_esg.metric_manager

About this task
If you have been assigned as an approver as part of a metric definition record, your approval task
appears in the approvals tab of a metric data task.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace.

2. Select the Metric data table icon (ﬂ).
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3. Review the metric data tasks and perform one of the following actions.

a. Select the cell for which you want to reject

. the data.
Reject
b. Select Reject and provide your reason for
rejection.
a. Select the cell for which you want to accept
Approve the data.

b. Select Approve.

You can approve or reject cells in bulk at the individual metric definition level or for all cells
by selecting the check box for each row or the check box in the header row of the Metric data
tasks table.

4, Optional: Select the check boxes that you want and then select Reject or Approve.

Create ad hoc metric data tasks

Handle off-cycle requests for up-to-date information on existing metric definitions and metrics by
creating ad hoc metric data tasks. These tasks address off-cycle requests and provide the latest
information.

Before you begin
Role required: sn_grc_metric.manager

About this task

When you create an ad hoc task, it is automatically assigned to the data owner specified in the
metric definition form. It is important to note that for manual metric definitions these ad hoc
tasks:

« do not contribute to the aggregated metric definition data.
« are not considered for entity hierarchy rollup.

« are not evaluated for threshold rating, Variance(%)

However, for calculated metric definitions that have the Calculation level field set to Entity, the
ad hoc tasks data contribute to the metric score.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Metrics
> Manual metric definitions.

2. Select and open the required metric definition.
3. Open the metric for which you want to create ad hoc tasks.
4, Select Create ad hoc task.

5. In the Ad hoc metric data task dialog box, provide the start date, end date, and due date of the
task.

6. Select Submit.
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Override metric data
Modify or override the metric data if it's inaccurate, whether provided by the data owner or
automatically collected based on the conditions defined in the metric definition.

Before you begin
Role required: sn_esg.admin

About this task
After a metric data task is closed, the ESG administrator can modify the metric data as needed.
The administrator must also provide a valid justification for modifying the data.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > List > Metrics >
My metric data tasks.

2. Open the record that you want to modify.

3. On the Metric information form, under the Metric input section, select the Override Metric
Data option.

4. In the Overridden metric data field, provide a new value.
5. In the Justification field, provide a valid justification for overriding the data.
6. In the Additional comments field, provide additional comments, if any.

7. Select Save.

Result
The metric data task value is overridden and the same value is updated in the metric data.

Override metric data task response
As a metrics administrator, if the response provided for a quantitative or qualitative metric must
be modified, you can edit the data and provide a justification for the modification.

Before you begin
Role required: admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Metrics >
Metric data tasks.

2. Open the task for which you want to edit the data.

3. Under the Metric input section, select the Override Response option.

4. In the Overridden response field, provide the new response.

5. In the Justification field, provide a justification for overriding the previous data.

6. In the Additional comments field, provide any additional comments that you have.

7. Select Save.

Create a grouping for metric definitions

Create a group and a subgroup for similar metric definitions. Creating these groups facilitates
easy reporting and tracking. You can set the values for the group and the subgroup through
choices.
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Before you begin
Role required: sn_esg.admin

About this task

If you have many metric definitions that are similar, then you can create groups and or subgroups
for those metric definitions. For example, Scope 1, Scope 2, and Scope 3 are all different types of
emissions but they can be grouped together under one group titled Emissions and a subgroup
titled Greenhouse gas emissions.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Administration > Choices.

2. Select New.
3. On the form, fill in the fields.

GRC Choice table

Set Area where you want to create the choice.
This field is set to ESG Metrics. You can
modify this field.

Name Name of the choice. For example,
Emissions.

Reporting classification Tag under which the metric definition and
metric is categorized. For example, GRI,
SASB, or Steering Committee Review.

Choice category Classification of the choice. Example, groups,
subgroups, labels.

Order Order of the metric definition within the sub-
group. By default, the order can be given from
100, 200, and so on as they are added to the
group and sub-group.

Parent Parent choice.

Result

The grouping is ready to be used in the metric definition form under the Classification section.

Create a unique metric definition name

Specify the value formula in the sn_grc_metric_definition in the required record table to create
unique metric definition names to import data from an external source such as Watershed
spreadsheets.

Before you begin
Role required: sn_grc_metric.admin

About this task
Any external source that contains data must be imported into the metric definitions and each
metric definition must have a unique name. The metric definition name can either use a single
column from the spreadsheet or it can be a combination of multiple columns. This procedure
uses the Watershed Integration for ESG and the sn_grc_metric_definition table as an example.
You can specify the formulae in the sn_grc_metric_definition table to create the unique metric
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definition names. The same procedure can be repeated for the other tables as well. The following
tables are installed by default.

e sn_grc_profile
» sn_grc_profile_type

« sn_grc_metric_definition

The following image shows the string and value columns from a sample spreadsheet.

Value formula combinations

A B € D E) F G
1 year ighg_protocol_category [+| business_categoi v | location [+]Sum of kgco2e [+] Sum of renewable KW[~| Sum of non-renewable KW(~|
2 2020 String ~~"1Scope 1 offices Adelaide, AU 1223.6833: - 260057.3277
3 2020 1 Scope 1 offices Arlington, US 1115.097139 Value - 8911.607406
4 2020 1Scope 1 offices Augsburg, DE 265093.8515 - 1308976.813
5

2000 1Scone 1 offices Aurara 11§ AR57 RN5272 - 5A104 9R315

Procedure
1. Navigate to All > Metrics > Metric Integrations.
2, Select Watershed Integration.

3. In the Data Mappings section, select the data mapping for which you want to specify the
formula.

4. On the Required Records form, in the Value Formulas section select New.

5. On the form, fill in the fields.

Value Formula form

Field Description

Source table. Name of the source table. This field is
automatically set to Watershed Data
[sn_esg_watershed_data].

Required record Name of the table being modified.

@ Note: In this procedure, the example
used is the sn_grc_metric_definition

table.
Column Column containing GHG protocol category.
Format Format of the name. The choices are as
follows

o String: Use this option to specify a text
string.

© Value: Use this option to use any value of
the column.

o String+Value: Use this option prepend text
to beginning of column value.

o Value+String: Use this option to append
text to end of column value. Specify the text
in the String field.

String Text to use in the format.
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Description

Sequence Specify the sequence of the formula. Multiple
value formula under same required record
will be concatenated following the sequence
specified.

6. Select Submit.

Metric and metric definition overview pages

The metric and the metric definition overview pages provide visualization for the metric trends
and help you to monitor the tasks and activities that need attention.

The overview pages are available for the following.
« Quantitative automated, manual, calculated metric definition

« Qualitative metrics

The overview pages display the latest data in the form of lists and charts only when the latest
metric data tasks are closed. Charts are displayed for quantitative metric definitions and lists
are displayed for qualitative metrics. For qualitative metric definitions, only the description of the
metric definition appears on the overview page. The data displayed shows the start date and

the end date of the data collection period. The following image shows the overview page for an
automated metric definition.

Quantitative metric definition overview page

=LUst > Metrc Definition: Employee engagement

Employee engagement © Aggregate || Execute  save || 360°view
Tpe  Colecton requency Entepriseowner Category Vo
Manual Annually Elisa Gracely Quantitative 95

Overview Details  Entitytype  Additional Entities ~ Metrics (1)~ Citations ~ Goals  Targets  Thresholds  Metric definition data (5)

Description

Employee engagement

Metric definition data overview

Latest Data

?5

Latest data as of
2019-07-10 - 2020-06-30

The following image shows the qualitative metric overview page with the data start date and end
date.
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Qualitative metric overview page

= List > Metric: Name of the organization - ACME Global

Bl Name of the organization - ACME Global © (-]

© Collection frequency  Enterprise owner  Metric definition
Manual Annually Elisa Gracely Name of the organ...

Overview Details Metric Data Tasks (1) Goals Targets Citations

0y

e Attachments
Description
Name of the organization
Metric data overview

Start Date End Date Data State 0o

[
2022-01-24 2023-01-23 ACME Global Completed
No Attachments Available
Showing 1-1 of 1 1 20~ rows per page Browse for afile to add it as an attachment

Qualitative metric definition

= List > Metric Definition: Approach to Stakeholder Engagement

Type Collection frequency  Enterprise owner  Category

Manual Annually Qliver Jones  Qualitative

Overview Details Entity type Additional Entities Metrics Citations Goals

Description

The organization shall describe its approach to engaging with stakeholders, including
i. the categories of stakeholders it engages with, and how they are identified;

ii. the purpose of the stakeholder engagement;

iii. how the organization seeks to ensure meaningful engagement with stakeholders.

Reviewing calculation details with formula trees

Review calculated metric definitions by viewing a structured and visual representation of the
entire calculation chain. By using a formula tree, you can access the calculation details and view
how the different metrics and emission factors are interconnected.

The formula tree is a tool that enhances transparency in calculated metric values. Navigate to
the calculated metric data record you want and view the formula tree, which shows a detailed
breakdown of the calculation. It displays the values of the operands and how they’re combined
to produce the final result. This feature helps users and auditors understand and verify the
accuracy of complex calculations.

0 Note: Formula trees are available for the generated Calculated metric data when the
Calculation level is set to Metric Definition and for the generated metrics when the
Calculation level is set to Entity. For more information on Formula building, see Formula
building in a calculated metric definition.

As shown in the following examples, you can navigate to the calculated metric data record and
select Show formula tree to view the associated formula tree.
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Example of accessing a formula tree

=Ust > Calculated Metric Definition: Historical MD_Level C.. > Metric definition data: 25432

] =

Record type Start Date End Date Value
Metric definition d... 2019-01-01 2019-12-31 25,432
Details
G
i Metric definition data

Metric definition State

Historical_ MD_Level CMD (c] Completed v
Start Date Frequency
2019-01-01 8 Annually
End Date Value
2019-12-31 ] 25432
Variance (%)
2%
Last period data
32456 o]
Example of a formula tree
= Ust > Calculated Metric Definition: Historical MD_Level C... > Metric definition data: 25432 > Formula tree
Find on map X
+
fx Historical_MD_Level CMD =
AMD1_20_Entities_Annually + MMD2_20_Enti
ties_Annually
25432
A
— T N
v N
& Metric Definition & Metric Definition
AMD1_20_Entities_Annually MMD2_20_Entities_Annually
12716 12716
® 150% v

() Note: A formula tree displays the values of operands by applying the level of precision
provided in the CMD.

For example, if the CMD specifies a precision of 2 decimal places, the formula tree displays
all operand values with two decimal places, even if the actual values have more or fewer
decimal places.

As shown in the following examples, if you're seeing an empty page, it's because the formula tree
or formula operands are currently empty and are being updated asynchronously. If you're seeing
an error page, it's due to errors in the formula operands that need to be corrected.

() Note: If a value is missing for any operand in a CMD formula, you can use the Calculated
Metric Definition Settings table to define a default value for that operand. The system will
automatically retrieve and apply the specified default value, ensuring the formula executes
without interruption. Users can customize these default values or add new records as
needed to suit their calculation requirements. For more information, refer to Activate default
values for CMD calculations.
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Example of an empty page
G;] Q Home > Metric: Total GHG emissions for 1007 Green Street So... > Metric Data: 170 > Formula tree

Formula tree is being generated.

Refresh the page after some time

Example of an error page

Q (A Home > Metric: Total GHG emissions for 1007 Green Street So... > Metric Data: 170 > Formula tree

@

Errors

The following records do not have data. Update them as necessary and click the button to regenerate the formula tree:

E 1. Metric definition: Scope 3 GHG emission

Regenerate formula tree

To learn more about formula trees, see:
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View the calculation breakdown in a formula tree
View a structured and visual representation of the entire calculation chain.
Before you begin

Role required: sn_esg.admin, sn_esg.metric_manager, sn_esg.program_manager,
sn_esg.reporting_disclosure_manager

sn_risk.user (for Risk users).

About this task

A formula tree provides transparency by displaying the detailed breakdown of how values are
calculated, including all the operands and operations. This is especially helpful for auditing data
and debugging.

Procedure
1. Navigate to one of the following locations depending on which application you're using.

o All > Environmental, Social, and Governance > ESG Workspace > Metrics > Calculated
metric definitions.

o All > Risk Management > Risk Workspace > Metrics > Calculated metric definitions.

2, Open the metric definition for which you want to view formula tree data for and select
Calculated Metric Data.

3. Select the calculated metric data record that you want and then select Show formula tree.
You can view a visual representation of the entire calculation chain. The formula, associated
metric definitions, sub formulas, functions, and so on, are shown.

Q Note: If you're seeing an empty page, it's because the formula tree or formula operands

are currently empty and are being updated asynchronously. If you're seeing an error
page, it's due to errors in the formula operands that need to be corrected.

GRC: Metrics reference

Several properties, tables, and roles are installed with the GRC: Metrics application.

Components installed with the GRC: Metrics application

When the ESG Management application is activated, the GRC: Metrics application is
automatically installed. The GRC: Metrics application adds several tables, properties, and roles
that are listed here.

Roles installed

The following roles are installed with the GRC: Metrics application.

Roles installed with the GRC: Metrics application

Description Contains

sn_grc_metric.admin This role is the admin role for  sn_grc_metric.manager,
the application. This role can  sn_grc.library_admin
do the following:
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Roles installed with the GRC: Metrics application (continued)
Role Description Contains

« Create, read, write, and
delete metric definitions,
metrics, and metric units.

« Override the results in
metric data tasks.

« Read metric data.

e Create schedule.

sn_grc_metric.manager Enterprise owner and sn_grc_metric.user
approver role for the
application. This role can do
the following:

« Create, read, write, and
delete material topics,
goals, targets, metric
definitions, metrics,
citations, and metric units.

« Override the results in
metric data tasks.

« Read metric data, metric
data tasks, disclosures, and
authority documents.

If there's an integration with
Project Portfolio Management

« Create, read, and write,
projects and programs

« Delete projects and
programs

If there's an integration with
Integrated Risk Management,
this role can do the following:

« Create, read, write, and
delete control objectives,
controls, risk statements,
and policies.

« Read risks and issues.

sn_grc_metric.user This role is a read-only role. None
Users with this role can't
create, edit, or update any
metric definitions or metrics

sn_grc_metric.developer User with this role can edit None
the script in automated metric
definition.
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Tables installed

The following tables are installed with the GRC: Metrics application.

Tables installed with the GRC: Metrics application

Name Description

Base table for all metric definitions.
Base Metric Definition

(sn_grc_metric_base_definition)

) L Calculated metric definitions that are used
Calculated Metric Definition to aggregate data for two or more metric

. . - definitions.
(sn_grc_metric_composite_definition)

) o Metric definitions that are used to define
Metric Definition automated and manual metrics.

(sn_grc_metric_definition)

) Metric instances that are generated when a
Metric metric definition is applied to an entity.

(sn_grc_metric_metric)

Unit for a metric definition or metric.
Metric Unit

(sn_grc_metric_unit)

Parent table for metric data.
Parent Data

(sn_grc_metric_parent_data)

Data for automated and manual metric
Metric definition data definitions.

(sn_grc_metric_collector_data)

Data for metric instances.
Metric Data

(sn_grc_metric_metric_data)

Task to collect data for manual metrics.
Metric Data Task

(sn_grc_metric_data_task)

Association between Entity type and Metric
Entity type to Metric Definition definition.

(sn_grc_metric_m2m_definition_profile_type)

Association between Entity and Metric
Entity to Metric Definition definition.
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Tables installed with the GRC: Metrics application (continued)

Name Description

(sn_grc_metric_m2m_definition_profile)

Association between Metric and Calculated
Metric to Calculated Metric Definition Metric definition.

(sn_grc_metric_m2m_metric_composite_defnition)

Association between Metric and Metric
Child Metric Definition definition.

(sn_grc_metric_m2m_metric_definition)
Control objective to Metric Definition Association between Control objective and
Metric definition.

(sn_grc_metric_m2m_definition_control_objective)

Association between a control and a metric
Control to Metric Definition definition

(sn_grc_metric_m2m_definition_control)

A unit family to group similar units together.
Unit family

(sn_grc_metric_unit_family)

Convert any metric data into a preferred
Unit Conversion reporting unit.

(sn_grc_metric_unit_conversion)

Association between a metric and calculated
Metric to Calculated Metric Definition metric definition.

(sn_grc_metric_m2m_metric_composite_definition)

Metric data process queue Indicates the metric definitions that are in the
) queue for refreshing the data for calculated
(sn_grc_metric_data_process_queue) metric definitions or updating the entity
hierarchical data for all the types of metric
definitions.
Metric data by entity Includes data for entities in metric definition
) ) and aggregated data for its parent entities
(sn_grc_metric_data_by_entity) defined in the entity hierarchy.
Time dimension Includes date, week, quarter, month,

semi_annual, year for each day in the year.
(sn_grc_metric_time_dimension)

Metric import job Table that holds the details of import jobs for

metrics.
(sn_grc_metric_import_job)

Metric data import Staging table that stores the records parsed
from input data file.
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Tables installed with the GRC: Metrics application (continued)

Name Description

sn_grc_metric_data_import

Metric import log
sn_grc_metric_st_import_log

Metric transform history
sn_grc_metric_st_transform_history

Metric import template

sn_grc_metric_import_template

Remote table that has data for showing import
logs for import jobs.

Remote table that has data of transaction
history for import jobs.

Table that stores the import templates used for
preparing input data file for import job.

Scheduled jobs

The scheduled jobs installed with the GRC: Metrics application run automatically at a specific
time or schedule. Scheduled jobs can be set up to perform a wide variety of tasks such as
running reports or data exports on a regular schedule.

Scheduled jobs installed with GRC: Metrics

Name Description

Aggregate metric definitions

CMD validity check

Execute calculated metric definitions

Execute metrics

Generate metric data by entity

Generate time dimensions

This job is executed every 30 minutes. It pulls
all types of metric definitions data which

are active and have the state as Pending. It
updates the "state" and "value" for each metric
definitions data based on the aggregation of
its corresponding metric data for that period.

This job is executed once everyday at 12AM.
For Each calculated metric definition, it
updates the "status" to valid/invalid and the
"notes" based on its duplicate child metric
definitions and child metrics.

This job is executed for each calculated metric
definition for both the entity level as well as
the metric data definition level and updates
with the calculated value.

This job is executed daily once at 4:30PM.
This executes for each metric definition and its
metrics that create metric data and the metric
data task if it does not exists for that period.

This job runs daily to do entity hierarchy rollup
for all the metric definitions.

This job runs on first day of every year and
creates time dimensions for that year.
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Properties installed

Properties installed with GRC: Metrics

Name Description Default value

sn_grc_metric.metric_data_$peicifebadhledule to 08fcd0830a0a0b2600079f56b1adb%ae
be used for due date
calculation

sn_grc_metric.all_words Is used to replace all (blank), blank, na, all, empty, (empty)
comma separated
defined string in value
to 'All' while importing
metric data using Metric
Integration.

com.glide.event_manager.gscusestriosdigtrdugeven.loaB@bstribution.enabled
the events in the
'grc_metric_queue'
queue equally between
two worker threads.

com.glide.event_manager.doefinefrite quesdeataim_lirtitie
number of events that
one worker thread can
claim from the event
queue.

Using ESG Management

By using the ESG Management application, you can import citations from various frameworks
and create disclosures.

Using the ESG Management application, you can perform the following tasks:

« Set up the ESG program with all the material topics, goals and targets, activities and emission
factors.

 Define metrics to start collecting data, both automatically and manually, for the entire ESG
program across the enterprise.

« Create disclosures for internal and external stakeholders.

« Use content packs such as Global Reporting Initiative (GRI) Content Accelerator for ESG or
Sustainability Accounting Standards Board (SASB) for ESG frameworks.

Disclosures in ESG Management

An ESG disclosure refers to the practice of companies and organizations providing information
and reports on their environmental, social, and governance (ESG) performance. These
disclosures are designed to offer insights into how a company manages and addresses various
ESG-related issues. Users with the sn_esg.reporting_disclosure_manager role are responsible to
manage the disclosure reports.

Disclosure requirements

Disclosure requirements refer to the specific expectations or obligations an organisation must
meet when preparing ESG (Environmental, Social, and Governance) reports. These requirements
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ensure that the organisation transparently communicates its sustainability performance, risks,
and impacts. They are prerequisites for creating disclosures and are often defined by external
regulatory bodies or frameworks. In your context, these are surfaced in the ESG Workspace
as a separate entity to guide what needs to be reported. There are two types of disclosure
requirements:

Authority document

An Authority Document is a regulatory framework or standard that outlines what an
organisation should report in its ESG disclosures. It acts as a reference point for
compliance and reporting. Examples include: GRI (Global Reporting Initiative), SASB
(Sustainability Accounting Standards Board), and CSRD (Corporate Sustainability
Reporting Directive).

Citations

Citations are the individual reporting requirements or metrics defined within

an authority document. They represent the specific items an organisation must
disclose. Each authority document can have multiple citations, forming a one-to-
many relationship. These citations are what the organisation responds to in its ESG
report, often with quantitative or qualitative data.For example from GRI: “Energy
consumption from renewable sources” and from SASB: “Total energy consumed
(TCSI 220)".

Importance of ESG disclosures

ESG disclosures are important for several reasons.

 Transparency and accountability: ESG disclosures enhance transparency, allowing
stakeholders such as investors, customers, employees, and the public to understand a
company's performance in key ESG areas. This transparency fosters accountability and trust.

« Risk management: Companies that disclose ESG information can better identify and manage
potential risks associated with environmental, social, and governance factors. This is crucial for
long-term sustainability and resilience.

« Investor decision-making: Investors are increasingly considering ESG factors in their decision-
making processes. ESG disclosures provide investors with information to assess a company's
sustainability, ethical practices, and long-term viability.

« Corporate reputation: Positive ESG performance can enhance a company's reputation and
brand value. Conversely, poor ESG practices can lead to reputational damage, affecting
customer and investor confidence.

« Regulatory compliance: In some regions, there are regulatory requirements for companies to
disclose ESG information. Compliance with these regulations is essential to avoid legal and
financial consequences.

« Stakeholder engagement: ESG disclosures facilitate communication with various stakeholders
by demonstrating a company's commitment to responsible business practices. Engaging with
stakeholders on ESG issues can lead to improved relationships and collaboration.

Narrative disclosures

Starting with version 18.0.3 all new users of ESG Management have access to only narrative
disclosures. Narrative disclosures refer to disclosures that are created using the Microsoft 365
for ServiceNow Reporting add in. When you create a narrative disclosure, you have the option to
store the disclosure either on Microsoft SharePoint or on your local system. Microsoft SharePoint
integration in narrative disclosures is available for ESG Management version 18.0.3 and the
Xanadu release. The document that is generated when you create a narrative disclosure can

be opened using Microsoft Word and the data points that are configured can be inserted in

the document using the ServiceNow Reporting add-in. If there is any change in the data that is
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inserted, an email is automatically sent to the owners of the disclosure data notifying them that
the data has changed and that they must refresh the Microsoft Word document.

In a narrative disclosure, multiple collaborators can contribute to create the disclosure. You can
also define templates for each type of disclosure report. Refer to Types of disclosure reports to
understand each report type. Each disclosure can be approved by one or more approvers.

When generating a disclosure, it is important to note that the automatically generated document
is considered the primary document. Additionally, you have the option to attach secondary
documents as part of the disclosure process.

To create narrative disclosures on remote storage, you must install and activate the
sn_docs_onedrive plugin.

For steps to integrate the ServiceNow®

articles.

instance and Microsoft OneDrive, refer to the following

« Setup Microsoft OneDrive for Document Services &
« Connecting to Microsoft Sharepoint [KB1646310] & article in the Now Support Knowledge Base.

You can download the disclosures in an Excel format from the overview tab in the ESG
Workspace.

Additional information about disclosures

The following list provides detailed information about disclosures.

Types of disclosure reports

The ESG Management application provides the multiple types of disclosures reports and each
type is used for a specific purpose.

The ESG Management application supports the following types of disclosures reports.

« Annual report: An annual report is a comprehensive document that companies publish at
the end of each fiscal year to communicate their financial performance and overall business
activities to shareholders and other stakeholders. It typically includes financial statements,
management discussions and analysis, corporate governance information, and may also touch
upon sustainability and ESG matters.

ESG report: An ESG report, also known as a sustainability report or corporate social
responsibility (CSR) report, focuses specifically on a company's environmental, social, and
governance performance. It provides detailed information on the company's efforts, initiatives,
and performance related to sustainability, ethical practices, and social responsibility. ESG
reports are increasingly important for companies looking to communicate their commitment to
responsible business practices.

Regulatory and framework: Companies are often required to disclose specific information in
accordance with regulatory requirements or established frameworks. Regulatory disclosures
are mandated by government authorities and may include financial reporting, environmental
impact assessments, and other relevant information. Framework disclosures refer to reporting
standards or guidelines set by organizations or industry groups, such as the Global Reporting
Initiative (GRI) or the Sustainability Accounting Standards Board (SASB), which provide a
structured framework for reporting on ESG matters.

Request for information: A request for information is a formalized process where a company

seeks detailed information from its suppliers or partners. In the context of ESG, an RFl may

include questions about the supplier's sustainability practices, environmental impact,

labor standards, and other ESG-related factors. This helps the company assess the ESG

performance of its supply chain and make informed decisions about its business partners.
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« Rating and indices: Ratings and indices disclosures involve a company providing information
to external organizations that assess and rank companies based on their ESG performance.
Companies may disclose data and details to entities that compile sustainability ratings,
indices, or rankings. These assessments are often used by investors, stakeholders, and
customers to make decisions based on a company's ESG standing.

« Supplier questionnaire: A supplier questionnaire is a document or set of questions that a
company uses to gather information from its suppliers regarding various aspects of their
business, including ESG-related practices. The questionnaire may cover topics such as
environmental impact, social responsibility, labor practices, and governance. Companies use
this information to evaluate the ESG performance of their supply chain and make informed
procurement decisions aligned with sustainability goals.

« Others: Any other type of disclosure.

Approval workfow of a disclosure

If a narrative disclosure specifies a single approver or multiple approvers during its creation, it is
mandatory for those designated approvers to grant approval before the disclosure can transition
to the next state.

When creating a disclosure, you have the choice to specify one or multiple approvers. If multiple
approvers are designated, all the approvers must give their approval for the disclosure to
transition to the Completed state. In the event that any approver rejects the disclosure, it moves
back to the Work in Progress state, requiring resubmission to the approvers for approval.

Create a disclosure template

Create your own unique Microsoft Word disclosure templates tailored to different types of
disclosures. Utilize these templates that you create when you generate specific disclosures. The
templates help to streamline the disclosure process by implementing customized templates for
efficiency and consistency.

Before you begin
Role required: admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > Administration > Disclosure
Templates.

2. Select New.
3. On the form, fill in the fields.

Disclosure template form

Field Description

Disclosure type Type of disclosure. The choices are as
follows:

© Annual report
o ESG report
© Regulatory and framework

o Request for information

o Ratings and indices
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Field Description

o Supplier questionnaire
© Others

Template document Document to add.

@ Note: The file extension must be .docx.

4. Select Click to add....

5. Select Choose file.
a. Select a file of your choice from your local system.
b. Select Open.
c. Select OK.

Note: Ensure that the size of the file does not exceed 10 MB and only one template for
each disclosure type is defined.

Create a narrative disclosure on remote storage

Create an ESG Management narrative disclosure for your organization and store it on remote
storage such as Microsoft SharePoint. Disclosures can be of several types such as ESG report,
annual report, and so on.

Before you begin
Ensure that you follow the procedure to integrate the ServiceNow ™ instance and Microsoft
OneDrive. Refer to Setup Microsoft OneDrive for Document Services & and Connecting to
Microsoft Sharepoint [KB1646310] & article in the Now Support Knowledge Base.

®

Role required: sn_esg.reporting_disclosure_manager or sn_esg.program_manager

About this task

When you create a disclosure, you can specify if you want to save the disclosure on your local
system or on some remote storage such as Microsoft SharePoint. The disclosure that is created
serves as the primary document. This procedure provides the instructions for creating a narrative
disclosure on remote storage.

o Note: After you create a disclosure, you must not use Ctrl+A and delete to delete the
content in the Disclosure document. If this is done, the metrics associated with the
document would not be deleted and will be tracked. Ensure that the custom properties
Document ID and Disclosure Number are not updated or deleted after the disclosure
document is created.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosures > Narrative disclosures.

2. Select New.
3. On the form, fill in the fields.
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New disclosure form

Field Description

Number Identification number for the disclosure. This field is automatically set.
State State of the disclosure. This field is automatically set to Draft.
Name Name of the disclosure.

Description  Description of the disclosure.
Type Type of disclosure. The choices are as follows:
© Annual report
o ESG report
o Regulatory and framework
© Request for information
o Ratings and indices
o Supplier questionnaire
o Others

() Note: If a template is available, the disclosure document is created
based on the template. Otherwise a blank document is created.

Owner User responsible to move the disclosure to different states and perform
actions such as synchronizing the disclosure.

() Note: Only users with the sn_esg.reporting_disclosure_manager role
can be selected in this field.

Upload Option to decide if the disclosure must be stored on remote storage such
to remote Microsoft SharePoint. If this option is selected, the Remote storage section
storage appears on the form.

Data Classification of the disclosure information. The choices are as follows:

classification o Public: Determines if the disclosure will be made public.

o Private: Determines if the disclosure must remain private.

Approvers Users who must approve the disclosure.

() Note: Only users with the sn_esg.reporting_disclosure_manager role
can be selected in this field.

Remote storage

Storage type Location of where the disclosure must be stored. The available option is
Sharepoint. If this option is selected, a blank document is created.

Document Path on Microsoft SharePoint in the user’'s home folder. This field appears
path only when the Upload to remote storage option is selected.

Collaborators Users who contribute to the disclosure document. This field appears only
when the Upload to remote storage option is selected.
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Description

() Note: Only users with the sn_esg.reporting_disclosure_manager role
can be selected in this field.

4. To save the disclosure, select Save.
Ensure that the custom properties, Document ID and Disclosure Number of the disclosure
documents for a disclosure record are not updated or deleted.

5. To open and edit the document that is created, Open document.
To insert data points in the document, open the add-in in the Word document. For details, refer
to Import data in to a Microsoft Word disclosure report. If the link does not open the disclosure,
see the Troubleshooting checklist for narrative disclosures [KB1702819] & article in the Now
Support Knowledge Base.

6. Close the document before syncing data.
Before you perform the next step, wait for one minute for the data to reflect in the tracking
table.

7. Select Sync disclosure data to synchronize any modifications made to the disclosure
document, ensuring that the changes are reflected on the Overview page under Disclosure
summary.

The Sync disclosure data button is only available if the Storage type field is set to Sharepoint.

8. To move the disclosure to the next state, select Move to Work in Progress.

9. To request approval from the necessary approvers, select Request Approval.

Create a narrative disclosure on local system

Create an ESG Management narrative disclosure for your organization and store it on your local
system. After you create a disclosure, you can download the document, edit it, add metrics to it,
and upload it back into the ESG Management instance.

Before you begin
Role required: sn_esg.reporting_disclosure_manager or sn_esg.admin

About this task

When you create a disclosure, you can specify if you want to save the disclosure on your local
system or on some remote storage such as Microsoft OneDrive. The disclosure that is created
serves as the primary document. This procedure provides the instructions for creating a narrative
disclosure on local storage.

() Note: After you create a disclosure, you must not use Ctrl+A and delete to delete the
content in the Disclosure document. If this is done, the metrics associated with the
document would not be deleted and will be tracked. Ensure that the custom properties
Document ID and Disclosure Number are not updated or deleted after the disclosure
document is created.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosures > Narrative disclosures.

2. Select New.
3. On the form, fill in the fields.
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New disclosure form

Field Description

Number Identification number for the disclosure. This field is automatically set.
State State of the disclosure. This field is automatically set to Draft.
Name Name of the disclosure.

Description  Description of the disclosure.
Type Type of disclosure. The choices are as follows:
© Annual report
o ESG report
o Regulatory and framework
o Request for information
o Ratings and indices

o Supplier questionnaire

o Others
Owner Assignee of the disclosure.
Upload Option to decide if the disclosure must be stored on remote storage such
to remote Microsoft OnebDrive. If this option is selected, the Remote storage section
storage appears on the form. For this procedure, do not select this option.
Data Classification of the disclosure information. The choices are as follows:

classification o Public: Determines if the disclosure will be made public.

o Private: Determines if the disclosure must remain private.

Approvers Users who must approve the disclosure.

4. To save the disclosure, click Save.
Before you perform the next step, wait for one minute for the data to reflect in the tracking
table. Ensure that the custom properties, Document ID and Disclosure Number of the
disclosure documents for a disclosure record are not updated or deleted.

5. To modify and upload the document that is created, refer to Upload a disclosure document.

6. To move the disclosure to the next state, select Move to Work in Progress.

7. To request approval from the necessary approvers, select Request Approval.

Upload a disclosure document
Upload locally created disclosures in the ESG Management application instance.

Before you begin
Role required: sn_esg.admin or the owner of the disclosure

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosures > Narrative disclosures.

2, Open the locally created disclosure.
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3. Select Upload disclosure document.
4, Open the document and copy the unique document ID by selecting the copy icon.

a. In the Document ID field, provide the unique ID by opening the document and copying the
ID.

b. Select Save.
5. Select the download icon to download the document.
6. Delete the document already present.
7. Make the necessary edits to the document.
8. To upload the new document, select Attach file and browse for the document to upload.

9. Select Save.

Result
« The disclosure document is synced. The data takes some time to sync.

» The corresponding claim records are synced and created in the disclosure.

Add disclosure documents

Add secondary related or supporting documents for any disclosure that you create. Supporting
documents for a disclosure report may include sustainability reports detailing environmental and
social metrics, corporate governance documents illustrating governance structures, and third-
party certifications validating a company's ESG performance. Additionally, relevant policies, such
as those on ethics and supply chain practices, contribute to a comprehensive ESG disclosure.

Before you begin
Role required: sn_esg.admin or the owner of the disclosure

About this task

When you create a disclosure, that disclosure is the primary document. While you can add
secondary documents, you cannot delete the primary document. Every time a document is
updated, only the latest version of the document is stored in the instance.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosures > Narrative disclosures.

2. Open the disclosure for which you want to add documents.
3. Select the Documents related list.

4. Select Add.

5. On the form, fill in the fields.

Disclosure documents form

Field Description

Name Name of the document.

Type Type of document. This field is automatically
set to Secondary because the primary
document is always the blank document for
the disclosure that is automatically created.
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Description

URL URL of the document if the document is
hosted elsewhere.

Document Supporting files to attach.

6. Select Save.

7. To view the document details, select the document and on the Attachments side panel, the
details are displayed.

Add metrics to a disclosure
Add any metrics to the disclosure that would help to contribute to the disclosure data.

Before you begin
Role required: sn_esg.admin or the owner of the disclosure

About this task

After you manually add metrics to the disclosure, you can also delete those metrics if they no
longer contribute to the disclosure or if you add them by mistake. However, you cannot delete a
metric that is added from the Microsoft 365 for ServiceNow Reporting application.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosures > Narrative disclosures.

2, Open the disclosure for which you want to add related metrics.
3. Select the Related metrics related list.

4, Select Add.

5. Select the metrics to add.

6. Select Add.

7. Select Save.

Create a authority document using ESG Workspace
The authority document is a regulatory framework or standard issued by a recognized
organization or governing body that outlines the reporting obligations for ESG disclosures.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosure requirements.

2. Select Authority document and select New.
3. On the form, fill in the fields.
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Create New Authority document form

Field Description

Number Read-only field that is automatically populated with a unique identification
number.

Name Name of the document.

Source A non-editable field with the source of the policy. For example, if the statement

is from the UCF import, the source is UCF.

Source ID  The unique identification number used by the source to catalog this authority
document.

Category Category for this authority document.

Common Abbreviated version of the Name field.
name

Type The document type:
o Audit Guideline
o Best Practice Guideline
o Bill or Act
o Contractual Obligation
o International or National Standard
© Not Set
o Organizational Directive
o Regulation of Statute
o Safe Harbor
o Self-Regulatory Body Requirement
o Vendor Documentation

Version The unique version number used by the source to identify this authority
document.

Active The Active option in a authority document indicates whether the authority
document is active or inactive. It is set to Active by default.

Description More information about the authority document.

Url The URL of the stored authority document.

Schedule

Valid From The date and time for which the policy becomes valid.
Valid To The date and time for which the policy is no longer valid.
Settings

Functional Functional domain for the authority document, for example, ESG.

domain

4, Select Save.
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Result
The authority document is created, the Overview page opens, displaying its description along
with the related lists for easy reference and further configuration. The following related lists are
available:

« Details

« Citations

« Content reference

Create a citation using ESG Workspace

The citations are the individual reporting requirements or metrics defined within an authority
document. They specify the exact data points or qualitative information an organization must
disclose.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Disclosure requirements.

2. Select Citations and select New.
You can also open citation by navigating to a authority document and select New in the
Citations related list.

3. On the form, fill in the fields.

Create New citation form

Field Description

Name User-defined name that identifies this citation.

Source Source of the policy. For example, if the statement is from a third-party
provider, indicate which one.

Source ID Unique identification number used by the source to catalog this authority
document.

Type Type of citation created. Optional field not used for any processing. Use the

value in this field in reports or to query for records of a specific type.
o Core Topic

o Process

o Control Objective

o Control

o Supporting information

Reference Content reference.

Parent References the parent content.

Authority Name of the parent authority document for this citation. When you create
document citations from the authority document form, the system completes this field

automatically.
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Field Description

Active Option that indicates if a policy is active. A policy is marked active if it is not
in the Draft or Retired state. To deactivate a citation, clear the check box
marked Active. It is set to Active by default.

Description Description of the citation.
Reporting

Reporting Guidelines about the reporting requirements provided by the reporting
requirement  organization.

Supplemental Additional guidance about the citation.
guidance

4, Select Save.

Resulit
The citation is created, the Overview page opens, displaying its description along with the
related lists for easy reference and further configuration. The following related lists are available:

« Details

« Citations

« Content references
» Goals

» Metric definitions

e Metrics

Claims for reporting

Claims for reporting are narrative statements or data points that organizations wish to document
and track for potential future use in disclosures.

Using claims

Claims for reporting allows organizations to create, manage, and track narrative statements
(claims) used in ESG Management reporting and disclosures. A claim could be any assertion
a company makes aboult its achievements, commitments, events, or activities. For example, a
statement like “25 employees from ACME Inc. attended the UN conference on sustainability
in New York on August 21, 2024” would constitute a claim. These claims can be used across
multiple reports and help provide credibility and specificity to disclosures by clearly detailing
actions or accomplishments. It serves as a centralized repository for narratives that can be
reused in annual reports or sustainability disclosures.

Benefits of claims for reporting

Claims for reporting in ESG Management offers numerous benefits, enabling structured and
efficient way to manage the factual narratives for disclosures.

« Streamline reporting through reusable claims, reducing redundancy and increasing efficiency.

« Improve accuracy and consistency by centrally tracking and approving claims for uniform use
across disclosures.

« Enhance discoverability by allowing users to search and leverage existing claims.
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« Enhances organizational reputation and trust by supporting better, more consistent
disclosures that reflect various projects and initiatives.

« Helps large organizations manage narratives across global teams, reducing silos and ensuring
awareness of all relevant initiatives.

« Provides HAexibility to create both qualitative and quantitative claims, not limited by reporting
cadence, and supports review and approval workflows.

« Allows tracking of which claims are used in which disclosures and supports associating related
claims for comprehensive reporting

Create or edit a claim
Create or edit a claim that accurately documents a specific achievement, commitment, event, or
activity performed by your organization, suitable for use in future disclosures or reports.

Before you begin
Role required: sn_grc_claims.manager

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists > Claims.
2, Create or edit a claim.

o To create a claim, select New.

o To update details of an existing claim, select the claim.

3. On the Claims for reporting form, fill in the fields.
For more information regarding the field descriptions, see Claims for reporting fields.

4. Select Save.

Claims for reporting fields

Learn about the fields of the Claims for reporting form. Use this form to create a new claim.

Create New Claims for reporting

Field Description

Name Name of the claim.

Start date The date when the claim process or period
begins.

End date The date when the claim process or period
ends.

Due date The date by which the claim needs to be
completed.

Owner type The category or classification of the owner
responsible for the claim (e.g., individual,
team).

Owner The person or entity responsible for managing
or overseeing the claim. This field appears
only when User is selected in the Owner type
field.
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Create New Claims for reporting (continued)

Field Description

Owner Group The group or department to which the owner
belongsThis field appears only when Group is
selected in the Owner type field.

Group The group of the claims that shows the
classification of the claim.

Subgroup A more specific categorization within the
group.

Claim The specific statement or assertion being

made about an achievement, commitment,
event, or activity performed by your
organization.

Footnotes Additional explanatory notes or references
related to the claim, providing further context
or supporting information.

Approval required Option to indicate if an approval is required for
the metric definition.

@ Note: When the Approval required
option is enabled, the Approver type
and Approver fields are displayed.

Approver assignment type The method or rule used to assign an approver
to the claim (e.g., simple, advanced)

Approver type Specifies the type of approver for the metric
definition. The choices are as follows:

« User

« User group

© Note: This field appears only when
Simple is selected in the Approver
assignment type field.

Approver Approver user or approver group that is
responsible to approve the metric definition.
The choices are as follows:

« Approver: Displayed when the User option
is selected.

» Approver group: Displayed when the User
option is selected.

@ Note: This field appears only when
Simple is selected in the Approver
assignment type field.
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Create New Claims for reporting (continued)

Description

Additional comments Any extra remarks or observations related to
the claim.

Reporting frameworks

The ESG Management application uses several sustainability reporting frameworks to help
organizations report their economic, environmental, social, and governance performance.

The ESG content accelerator application is a centralized repository of frameworks, citations,
metric definitions, and emission factors. Using this application accelerates the adoption of ESG
frameworks.

© Important:

Starting with the Xanadu release, Sustainability Accounting Standards Board (SASB) Global
Reporting Initiative (GRI) content accelerator are deprecated. It will be hidden and no
longer activated on new instances but will continue to be supported. The ESG content
accelerator application provides the latest experience for this functionality.

The GRI Standards enable any organization to understand and report on their impacts on the
economy, environment, and people in a comparable and credible way, thereby increasing
transparency on their contribution to sustainable development.

The Sustainability Accounting Standards Board (SASB) is an ESG guidance framework that sets
the standards for the disclosure of financially material sustainability information by companies
to their investors. SASB Standards enable businesses to identify, manage, and communicate
financially material sustainability information to their investors.

The ESG Management application is shipped with the Global Reporting Initiative (GRI) Content
Accelerator for ESG and Sustainability Accounting Standards Board (SASB) content pack.

Updates in the citation form

When the ESG Management application is installed in the instance, the citation form displays
a new field titled as Reporting requirements and recommendations in the Reporting section.
This field provides the guidelines about the reporting requirements provided by the reporting
organization.

() Note: The Reporting requirements field is displayed only when the ESG Management
application is installed.

See the following sample information that is provided by the reporting organization in the
Reporting requirements field in the citation form: The reporting organization shall
report the following information: a. GHG emissions intensity
ratio for the organization. b. Organization-specific metric
(the denominator) chosen to calculate the ratio. c. Types of GHG
emissions included in the intensity ratio; whether direct (Scope
1), energy indirect (Scope 2), and/or other indirect (Scope 3).
d. Gases included in the calculation; whether CO2, CH4, N20,
HFCs, PFCs, SF6, NF3, or all. 2.7 When compiling the information
specified in Disclosure 305-4, the reporting organization shall:
2.7.1 calculate the ratio by dividing the absolute GHG emissions
(the numerator) by the organization-specific metric (the
denominator); 2.7.2 if reporting an intensity ratio for other
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indirect (Scope 3) GHG emissions, report this intensity ratio
separately from the intensity ratios for direct (Scope 1) and
energy indirect (Scope 2) emissions. Reporting recommendations

2.8 When compiling the information
the reporting organization should,
comparability over time, provide a
intensity ratio by: 2.8.1 business
country; 2.8.3 type of source;

specified in Disclosure 305-4,
where it aids transparency or
breakdown of the GHG emissions
unit or facility, 2.8.2

2.8.4 type of activity.

Set up analysis contexts and analyses

To simulate different analyses, create an analysis context and define the metric and forecast
periods, then create analyses. Use the forecast planning and analysis tools to generate and
compare the outcomes of these analyses, evaluating the impact of different interventions.

Create an analysis context

Create an analysis context to group different analyses for a specific use case. By setting up an
analysis context, you can help ensure that all relevant analyses are considered and compared
systematically, providing a comprehensive view of potential outcomes.

Before you begin

Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >

Analysis contexts.
2. Select New.
3. On the form, fill in the fields.

Create New Analysis context form

Field Description

Name

Metric definition

No. of periods to be forecasted

Previous periods

Name for the analysis context.

Metric definition associated with the metric.

© Note: Only calculated metric
definitions are supported.

Number of periods to be forecasted.

Number of periods in the future to see
forecast data for.

Number of previous periods to be used as
historical data.

You must have at least 12 periods of historical
data for forecast planning analysis. This
provides the necessary foundation for
simulating different analyses.
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4, Select save.
Your analysis context record has been created. An analysis tab has been added where you can

start to create scenarios.

What to do next
Create analyses to use for forecasting. For more information, see Create an analysis.

Create an analysis

Create analyses to model different outcomes based on specific interventions or changes. You
can generate forecasts for each analysis and use that information to compare the different
outcomes and better understand the impact of potential interventions.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Analysis contexts.

2. Select an analysis context record that you want and navigate to the Analysis tab.
3. Select New.
4. On the form, fill in the fields.

Create New Analysis form

Field Description

Name Name for the analysis. For example, Best
case.

Forecast Method Method used to generate forecasting data.
o Auto

By default, the instance chooses the best
method for you automatically, based on the
fit of the method. For more information, see
Automatic selection of forecast methods &.

o Linear

Generates a linear regression forecast
based on the historical scores, using
constant and trend as explanatory
variables.

o Seasonal

Generates a linear regression forecast
based on the historical scores, using
seasonal dummies as explanatory
variables. A 'season’ for this analysis is one
period.

o Seasonal Trend
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Field Description

As Seasonal, but includes a trend as an
explanatory variable.

o Seasonal Trend Loess (STL)

Generates a seasonal forecast based on a
best-fit function. This method fits a trend,

a season, and a random noise process to
the data using an exponentially weighted
moving average approach. The forecast

is based on the full data set, with more
weight given to more recent observationsA
'season!' for this analysis is one period.

o Random Forest (RF)

Creates a combination of decision trees
where the predictions produced by

these trees are averaged to get a single
prediction. The randomness comes from
each tree being built from a random subset
of the available data and inpults.

o Autoregressive (AR)

The autoregressive (AR) model forecasts
future values of an indicator by using a
linear combination of a trend, seasonal
dummies, and past values. Like the
Random Forest (RF) model, the AR model
checks for the best number of lags.
However, the AR model relates current to
past values linearly, whereas the RF model
is non-linear.

For more information, see Forecast
methods &.

State State of the analysis record.
© Draft
° |n progress
© Published

Description Description of the analysis.

5. Select save.

6. Optional: Navigate to the Emission factor analysis tab.
This tab is only available if a formula associated with the analysis uses an emission factor.

a. Enter the location in the Emission Factor location field.

b. Select Save.
This step is only required if a formula associated with the analysis uses an emission factor.
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7. Select Forecast.
Your analysis record has been created. A Forecast tab has been added where you can view
the generated standard forecast.

What to do next
Adjust parameters to model different outcomes based on specific interventions or changes. For
more information, see Adjust parameters.

Adjust parameters

Adjust parameters to model different outcomes based on specific interventions or changes.
When you update these parameters it enables your organization to explore the potential impacts
of different decisions, providing a clear comparison of outcomes.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Analysis contexts.

2, Select the Analysis context record that you want and navigate to the Analysis tab.

3. Select the Analysis record that you want and then navigate to the Forecast tab.

4, Select the information icon @ to open the forecast sidebar and fill in the parameter fields.

Input fields

Period The timeframe used for simulating the
adjusted forecast information.

Parameter The parameters that were used in the

formula.

Original values used for the forecast are
displayed for each of the parameter fields.
You can adjust each parameter to model
different interventions and their outcomes.

For example, if your formula is as follows:

(Total electricity
consumption - Solar panel
contribution) * Emission
factor

, the following parameter fields would

be available to adjust: Total electricity
consumption, Solar panel contribution,
Emission factor. By modifying these
parameters, you can simulate various
analyses to assess the impact of different
sustainability interventions on emissions.

5. Select save.
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The updated parameters are used to simulate the calculation based upon the updated values
that were entered. The forecast graph shows the original standard forecast and the new
adjusted forecast and the formula parameters for each are shown in the Formula parameters
section.

6. Repeat steps 4 and 5 until the new adjusted forecast and formula parameters meet your
requirements.

7. Select Publish.
After publishing, you will not be able to make any changes to the parameters.

What to do next

After creating and publishing multiple analyses and forecasts, you can compare the analyses
and view a graph that captures the data for each analysis you select. For more information on
viewing a Comparison graph see, Create a forecast comparison graph. For more information on
creating analyses, see Create an analysis.

Create a forecast comparison graph

Create a forecast comparison graph to compare the different outcomes based on specific
interventions or changes.

Before you begin
Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Analysis contexts.

2. Select the Analysis context record that you want and navigate to the Analysis tab.

3. Select the Analysis records that you want to compare and then select Compare.
You can select up to five analysis records for comparison. If the selected analyses have
adjusted values, those are plotted in the comparison. Otherwise, the standard forecast values
are plotted.

4. Select Confirm.
A graph has been generated showing the data for each analysis record that you selected.

Integrating ESG Management with other applications

You can integrate ESG Management with Project Portfolio Management and Integrated Risk
Management (IRM). These integrations provide you with more options to track your goals.

Integration with Project Portfolio Management

If you integrate ESG Management with Project Portfolio Management, you can plan, build a
roadmap, and prioritize activities to achieve your ESG goals. You can view all the programs and
projects associated with ESG under All > Environmental, Social, Governance > ESG Workspace
> Lists > Program Setup.

When you create goals for your material topics, you perform some activity to accomplish those
goals. The work that you do is captured in the form of programs and projects. When you integrate
with Project Portfolio Management, you can create programs and projects for your goals. To learn
more about program management and how to create programs, see Program Management &.

To see the configurations that you must perform on the project form, see Display the priorities
and goals on the project form.
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To see the tables installed with Goal Framework, see Roles installed with the Goal Framework.

The following image shows the ESG home page with Project Portfolio Management integration.
The integration adds new actions in the Quick Actions section, and it creates the Programs/

Projects column in the Top Level Goals Summary section.

ESG home page with PPM integration

G Home
Overview Show all goals v Quick actions
_ ) Document a material topic
All Environmental Social Governance
Create a program
Create a project
Create a narrative disclosure
21 12 3
Tasks View all tasks
My pending tasks
Green VYellow Green Yellow Yellow Green Green
I 16 l 9 2 l1 I 6 Open Overdue
Material Top-level Sub-geals| Material Top-level Sub-goals Material Top-level Sub-goals| Material  Top-level Sub-goals|
Topics Goals Topics Goals Topics Goals Topics Goals
Approvals
5 7 14 1 4 8 2 2 1 2 1 5
Top Level Goals Summary All goals data ~
Goal Classification Status Progress Off-track goals Off-track targets Overdue metrics gl jects
Accelerate a sustainable future Environmental = 64 0 0 0 0
through our products
Accelerate circular economy and Environmental oo 42 0 0 0 0
reduce waste
Accelerate Decarbonization Environmental  Yellow 27.51 2 0 20 5
Act with integrity Governance ® Green 57.8 0 0 o] o]
Create equitable opportunity Social ® Green 15 4] 0 o) o]

After you integrate with Project Portfolio Management, you can see the Programs/Projects list on

the Goal form.

Accelerate Decarbonization =

Record type  Classification Status Owner State

Goal Environmental s Yellow

~ General
I B Overview
B Details

~ Program setup

GHG
I Programs/Projects I

Material Topics

Sub-goals.

Targets

Entities

> Reporting requirements

Tracking

> Metrics
> Risk posture

> Compliance posture

Karla Ken In Progress

Description

Programs/Projects

ACME Inc. continually endeavours to address its environmental and social impacts by conserving its use of natural resources, reducing its

and strengthening its frameworks for responsible lending, greening its operations and building a sustainable supply chain. In

In-scope entities

Company
1

Integration with IRM

Aroanicatinn ctrivec tn rlncaly alien ite hiicinace tn olnhal framewnrlee ci

Goals summary

Total sub-goals

6

Comp...

0 4 2

Ontra.. Atrisk

o0

Offtr...

Targets summary

Total targets

3

Comp... Ontra... Atrisk

0 3 0

Off tr...

e0

order to integrate Environmental, Social and Governance (ESG) considerations into its core business and mainstream sustainable finance,
rh ac the lnitad Natinn'e Siictainahle Davalanment Gnale (KNG

Open metrics

Total Due in...

o °
Overd...
0

If you integrate ESG Management with IRM, you can add risks, risk statements, policies, control
objectives, and issues to your goals. For example, if you add a policy to your goal, then all the
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related control objectives and controls get associated with this goal. This integration helps you to
identify and assess the risks that pose threats to your goals.

() Note: As an ESG user, you are not required to create policies. The policies are created by
the IRM administrators. You only need to associate the policies to your goals.

After you integrate with IRM, the Goal form lists additional

Accelerate Decarbonization =

Record type  Classification Status Oumer State
Goal Environmental e Yelow KarlaKen In Progress

~ General

[ overview | Description

B Details

> Program setup ACME Inc. continually endeavours to address its environmental and social impacts by conserving its use of natural resources, reducing its
. . GHG emissions, and strengthening its frameworks for responsible lending, greening its operations and building a sustainable supply chain. In
> Reporting requirements order to integrate Environmental, Social and Governance (ESG) considerations into its core business and mainstream sustainable finance,

S Metrics Aroanicatinn ctrivac ta rlacaly alion ite hiicinace tn olnhal framawnarke ciich ac tha | Initad Natian'e Giistainahla Navalanmant Gasls (GNGE)
>

Risk statements

[ Risk: .
s Tracking

Additional risks
« Compliance posture In-scope entities Goals summary Targets summary Open metrics

Policies Total sub-goals Total targets Total Duein...

6 3 o °

Overd...

Control Objectives
Additional Control O...
Controls

Additional Controls

';.; mpany Comp... Ontra.. Atrisk Offtr... Comp... Ontra.. Atrisk Off tr...
1 O
0 04 2 0 0 ®3 0 0

Issues

options.

For more information on the roles and tables that are installed with the ESG Management, see
Components installed with ESG Management.

Related topics

Migrate existing goals data to Goal Framework

Integrating Microsoft 365 with ServiceNow reporting

The Microsoft 365 for ServiceNow Reporting (sn_esg_msoff_intg) integration provides disclosure
reporting capabilities to ESG reporting disclosure managers to seamlessly report ServiceNow
ESG Management system data, list reports, charts, pivot, and multi pivot reports using Microsoft
Word.

An ESG reporting disclosure manager may need to create disclosures to be transparent with the
stakeholders about the impact of their activities. For example, if an organization is planning to
engage in an activity that requires them to drill for oil in a protected area, the disclosure manager
may create a disclosure that outlines the potential impacts of the activity on the environment and
local communities as well as the measures being taken to mitigate those impacts.

This integration allows the reporting managers to view the inventory of the ServiceNow

ESG Management data links on the disclosure report and refresh the inserted data to be

in synchronization with the latest ServiceNow ESG Management data. An audit trail is also
established between the data imported and the ServiceNow instance. The audit trail provides
any auditor the ability to click the links in the document and access the source of the data in the
ServiceNow instance.

You can also track any changes made to the data inserted using configuration and log those
changes in the log table. For more information see, Set up Microsoft 365 reporting configuration.
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() Note: This integration is compatible with the desktop version 16.71 (23031200) and the
web version 16.0.16412.41005 of Microsoft Word. However, the charts are not interactive in
the web version. This means that you cannot modify the chart colors, formats, and so on.
The supported Windows Office version is 2303 (Build 16130.20394).

You can change the format, style, and colors of the imported data. The following chart styles are
supported in this integration:

Supported chart styles

Pie chart « Chart color
« Display data label
e Chart title
* Show legend

Bar chart

» Chart color
« Display data label
o Chart title
» X-Axis and Y-Axis
o Title
o Title bold
o Display grid
© Label bold

Horizontal bar chart « Chart color

« Display data label
» Chart title
* X-Axis

o Title

o Title bold

o Display grid

o Label bold
 Y-Axis

o Display grid

o Label bold

The following image shows how the imported data appears in a document.
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How various types of imported data appears in a document

Material Topics By Classification Targets by Type

Maximize

Milestone

0 1 2 3 a4 5 6
= Environmental Governance = Social I
Classification | Environmental | Governance | Social Total
Priority Low Low Low
Status
Green 9 6 1 16
Yellow 3 2 5
Total 12 6 3 21
F A lly Daily Quarterly  Semi- Weekly  Total
annually

Data owner

Albert Washington 51 9 4 2 66

Happy Singh 1 1

Adam Haro 12 3 2 17

Brandon Hardley 3 3

Felipe Gould 5 5

Gale Nolau 3 1 4

Oliver Jones 20 24 6 50

Rene 6 6

Dummermuth

Valli Raman 4 2

Total 82 33 7 24 6 4 156

Metrics by State
390
Pending Completed

Workfow of Microsoft 365 for ServiceNow Reporting

The Microsoft 365 for ServiceNow Reporting integration utilizes a workflow that requires
participation from multiple user roles such as system administrators, ESG administrators, and
disclosure managers. By defining a clear workflow, individuals and teams can better understand
their roles and responsibilities and generate the necessary disclosures.

The following figure displays the complete workflow of using the Microsoft 365 for ServiceNow
Reporting integration to generate disclosures in a Microsoft Word document.

© 2026 ServiceNow, Inc. All rights reserved. 187
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Process flow for Microsoft 365 for ServiceNow Reporting integration

Download

System ServiceN Upload manifest
)::l inistrat: ;:;ziinogw —»| to Microsoft Word
acdministrator Manifest/Add-in (online/desktop)

. )

Create Microsoft 365 Is Configure the “time
ESG reporting items Configure rectz:iﬁnguirteem reporting item on Yes dimension for Reporting item
administrator for tables, charts reporting item > B > < “metric data by entry” metric data set-up complete
and reports. table aggregation” filter
1
|
o e e e )
)
'
— Yes —> Select the Add ServiceNow
reporting item —>» | dataandlink to
and filters Word report
- Open Microsoft
ESG reporting & Word and launch

disclosure manager > ServiceNow
reporting add-in

User > Authentication
authentication successful

End
L No —3»

To generate Microsoft Word disclosures:

1. Download the ServiceNow Reporting add-in: As a system administrator, download and install
the ESG manifest file. A manifest file contains information about the files included in a software
application or package. It is used by the software installer to ensure that all the necessary files
are installed in the correct locations. At this stage, you must also work with your Microsoft 365
administrator to upload the manifest file to the Microsoft Word application. The Microsoft 365
administrator has the necessary access rights.

2, As an ESG administrator, set up the Microsoft 365 reporting configuration records to specify
which tables, reports, and charts from your ServiceNow ™ instance must be used to import data
into your Microsoft Word. You can also specify the columns from a table from which you want to
import data.

3. As an ESG administrator, you can configure additional reporting filters. These filters specify at a
granular level what data must be imported to the disclosure report from a table.

4. As an ESG reporting and disclosure manager, go to your Microsoft Word document,
authenticate yourself, and import the data from your instance to the document. You can alter
the formatting of the data according to your preferences.

Install the ServiceNow Reporting add-in

Install the ServiceNow Reporting add-in to your Microsoft Word document. This add-in is
required to import reports and data from your ServiceNow® instance to Microsoft Word
documents to create disclosure reports.

Before you begin

Ensure that the following plugins are activated:
* sn_esg

e sn_esg_msoff_intg

e sn_outlook_addin

Role required: sys_admin
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Procedure

1. Navigate to All > ServiceNow Add-Ins for Office > Office Add-In Manifests.
2. From the Office Manifests list, select ServiceNow Reporting.

3. Select Download Manifest.

4. To enable the add-in, contact your Microsoft 365 account manager who can use the manifest
file you downloaded in step 3.

What to do next
For detailed instructions on how to deploy the manifest file, see the Deploy add-ins in the
Microsoft 365 admin center [KB1307378] & article in the Now Support Knowledge Base.

To configure the HTTP response headers for add-in for Microsoft Word in the browser, see the
Response header resolution [KB1434453] & article in the Now Support Knowledge Base.

Set up Microsoft 365 reporting configuration
Set up the Microsoft 365 reporting configuration records to specify the data points and reports
that you want to import in to a Microsoft Word document for disclosure reporting purposes.
Before you begin

Role required: (per product)

« In Environmental, Social, and Governance Management: sn_esg_msoff_intg.admin

« In Audit Management: sn_audit.admin

About this task

Data is imported into a Microsoft Word document for disclosure reporting purposes. When
creating these Microsoft Word disclosures, you must specify which tables, reports, and data
visualizations from your ServiceNow instance must be used to import data into your Microsoft
Word document. You can also specify the columns from a table from which you want to import
data. Only those reports that are either created by or shared with the ESG administrator are
available for selection.

Procedure
1. Navigate to once of the following locations:

o All > Environmental, Social, and Governance > Microsoft 365 Reporting Integration >
Reporting Configurations

o All > Audit > Audit report > Reporting Configurations
2. From the Microsoft 365 reporting configurations list, select New.

3. On the Microsoft 365 reporting configuration form, fill in the fields.

Microsoft 365 reporting configuration form

Field Description

Business domain Domain from where the configuration is
created. This field is automatically set to ESG.

Reporting item Name of the configuration. For example, if
you want to get data about your ESG goals in
your word document, you can provide a name
suchasMy ESG goals.
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Field Description

Source type Source from which you want to fetch the data.
The choices are as follows:

o Table: Select this option when you want to
import data from a table.

o Report: Select this option if you want to
import data from a predefined report or
chart. For more information on how to
create a report, see Create a report with
Analytics Q&A &.

o Data visualization: Select this option
if you want to import data from a data
visualization in the Performance Analytics
library. For more information, see Overview
of data visualization types &.

@ Note: Only list reports, pivot reports,
multi-level pivot reports, horizontal and
vertical bar charts, and pie charts are
available for selection. Stacked bar
charts and grouped bar charts are not
supported.

Source table Source table to fetch data from. This field
only appears when Table is selected from the
Source type field.

Filter Filter conditions to filter the records. This field
only appears when Table is selected from the
Source type field.

Columns Column from the table whose values are to
be inserted. This field only appears when
Table is selected from the Source type field.

Source report Available report to be inserted in the
disclosure report. This field only appears
when Report is selected from the Source
type field.

Active Option to indicate if the record is active. Only
active records are available for selection in
the document.

Track configuration Option to track any changes made to the data
inserted using configuration and log those
changes in the log table.

4. Select Submit.

What to do next

Add additional reporting configuration filters to the reporting configuration. These filters help
to fetch the data into your Microsoft Word disclosure report. For more information, see Add
additional reporting configuration filters for a Microsoft 365 configuration record.
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Configure a business domain role

Configure the business domain roles so that users of a particular domain can select the domain
for which they want to import the data. Only those users who are added during the configuration
are able to view the domain on the Microsoft Word document.

Before you begin
Role required: sn_esg_msoff_intg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > Microsoft 365 Reporting
Integration > Business Domains.

2, Select the default ESG domain name record.
3. Select the Roles field.

4. Add or remove the roles as required.

5. Select Update.

Add additional reporting configuration Filters for a Microsoft 365
configuration record

Add additional reporting filters to specify at a granular level what data must be imported to the
disclosure report from a table.
Before you begin
Role required: (per product)
« In Environmental, Social, and Governance Management: sn_esg_msoff_intg.admin

« In Audit Management: sn_audit.admin

About this task

When you specify that you want to import data from a particular table, you must also specify from
which exact record of the table you need the data. For example, assume that you specify that you
want to fetch data from the sn_gf_goal table. This table may have multiple records. Therefore, you
must specify the exact record from which you want to fetch the data. You can specify as many
filters as you require.

Procedure
1. Navigate to once of the following locations:

o All > Environmental, Social, and Governance > Microsoft 365 Reporting Integration >
Reporting Configurations

o All > Audit > Audit report > Reporting Configurations
2. Open the record for which you want to add the additional reporting configuration filters.
3. On the Microsoft 365 reporting configuration filters related list, select New.
4. On the form, fill in the fields.

Microsoft 365 reporting configurations Ffilter form

Description

Reporting configuration Name of the configuration to which you're
adding additional filters. This field is
automatically set.
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Field Description

Field name Name of the field from which data must be
fetched. For example, for the goals table,
you can specify the Name field. If you select
name, then all the names of the goals are
available for selection during data import.

Related fields Fields in the add-in pane that are dependent
on the selected Field name. Only records
relevant to the selected Field name will
be displayed as choices. For example,
only entities related to a selected metric
definition will be available as a choice. For
more information, see Add related fields to a
Microsoft 365 configuration record.

Order Order of the field as it would appear on the
add-in pane of the document.

Aggregate on time dimension Option to aggregate the report configuration
source table data based on the chosen time
dimension. For more information about this
option, see the example in the procedure.
This field only appears when the Field name
has Time dimension.

Time dimension Time dimension for which data must be
aggregated. The list of time dimensions are:

o Year

© Semi-annual
© Quarter

© Month

°o Week

° Date

Select the dimensions according to your
requirement and move them from the
Available list to the Selected list.

@ Note: This field only appears when the
Aggregate on time dimension option is
selected.

5. Select Submit.

Resulit
The configuration data is now ready to be imported in to your add-in.

Example: Data aggregation for entities

If an ESG reporting disclosure manager wants to understand the total emissions for an entire
year for a particular location and if the location has sub-locations, you can also aggregate
the data and use it for reporting purposes. For example, consider that your organization has
a location Japan. Japan, in turn, has two sub locations, Tokyo and Kyoto. Assume that you
want to find your total yearly Scope 1 emissions for the year 2022 for Japan. Using the time
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dimensions feature, you can aggregate your data and get a view of your total emissions for

a year. You can also aggregate the data for a quarter, week, or a month depending on your
reporting requirements. The metric data is aggregated at frequencies higher than the metric

data collection frequency. To achieve this, in the Source table field, select Metric data by entity
[sn_grc_metric_data_by_entity] and select the Aggregate on time dimension option, and select
the time dimension field from the source table.

Add related Fields to a Microsoft 365 configuration record

Add related fields to filter values based on the chosen primary field. These filter values will
automatically adjust according to the selected filter criteria.

Before you begin

Create additional reporting configuration filters for a Microsoft 365 configuration record. For
more information, see Set up Microsoft 365 reporting configuration and Add additional reporting
configuration filters for a Microsoft 365 configuration record.

Role required: (per product)
« In Environmental, Social, and Governance Management: sn_esg_msoff_intg.admin

« In Audit Management: sn_audit.admin

About this task

Filter the fields dynamically and set up dependencies by using related fields. In the Microsoft
365, you can configure fields so that cascading filters are supported dynamically. You can select
a value in a field and have the related fields automatically update to show the relevant options.
This process helps you to streamline data entry and improve efficiency.

Procedure
1. Navigate to once of the following locations:

o All > Environmental, Social, and Governance > Microsoft 365 Reporting Integration >
Reporting Configurations

o All > Audit > Audit report > Reporting Configurations
2. Open the record for which you want to add the additional reporting configuration filters.

3. On the Microsoft 365 reporting configuration filters related list, select the field name of the filter
you want to add related fields to.

4. Select the lock icon (91 to unlock the related fields and then choose the fields that the Field
name should be related to.

5. Add related fields by selecting the magnifying glass icon O\ and choosing the fields that you
want.
Only fields with a greater order values can be selected as related fields.

6. Select update.
The available Field name values are now dependent on what value is selected for the fields
added as related fields. For example, if you selected the city field name you can select the
country field name as a related field so that only cities from that country show when you make
selections.

7. Repeat steps 3 through 6 until all the related fields that you want are set up.

Result
The related fields are ready to be used as part of your configuration data.
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Example: Data aggregation for entities in Japan

If an ESG reporting disclosure manager wants to understand the total emissions for an entire
year for a particular location in Japan and if the location has sub-locations, you can make this
process easier by using related fields. To add related fields, select the field that you want to set a
dependency with. For instance, select the City field and add the Country field as a related field.
Now, when you select Japan as the location's country, the options for the city field will be limited
to only cities located in Japan. This setup helps ensure that the data aggregation for Scope 1
emissions is focused on Japan and its specified sub-locations, such as Tokyo and Kyoto.

Add the ServiceNow Reporting add-in into Microsoft Word
Before you can import data into your Microsoft Word document to create your disclosure reports,
you must add the ServiceNow Reporting add-in to your Microsoft Word.

Before you begin
Role required: Any user of the Microsoft Word document.

Procedure

1. Open the Microsoft Word application.

2. On the menu bar, select Home.

3. Select Add-ins.

4, Select ADMIN MANAGED.

5. Select the ServiceNow Reporting add-in.
6. Select Add.

Resulit

The Microsoft 365 for ServiceNow Reporting integration is activated and the following buttons
are available on the Microsoft Word document in the ServiceNow Reporting add-in.

o Insert Link
» Manage Links

« Create claim

Import data in to a Microsoft Word disclosure report

Import and insert data such as ESG data points and reports into a Microsoft Word disclosure
report document from a ServiceNow instance. You can only import and insert the data that is
configured in your reporting configurations.

Before you begin
Role required: sn_esg_msoff_intg.reader

Procedure
1. Navigate to the Microsoft Word document in which you want to insert data.

2. On the ribbon, select Insert Link.
On the right side pane, the ServiceNow log in screen appears.

3. To log in to your ServiceNow instance, select Log in.
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a. A message is displayed that states that ServiceNow Reporting will display in a new window,
select Allow.

b. On the ServiceNow login screen, provide your credentials.
¢. Select Allow.

4, To insert an ESG data point from a table into the document, move the cursor at the point where
you want to insert data.

a. Select the Data tab on the right side pane.
b. The Business domain field is set to ESG.

c. In the Reporting Item field, select the Microsoft 365 reporting configuration record you want
to insert.

The additional filters dynamically appear based on the configuration record selected.
d. In the Value to insert field, select the column from which you want to insert data.
e. Select Add.

5. To insert data in HTML format move the cursor at the point where you want to insert data.
a. Select the Data tab on the right side pane.
b. The Business domain field is set to ESG.
c. In the Reporting item field, select the configured report that you want to insert.

d. In the Metric definition field, select the Metric definition that contains the HTML content you
want.

e. In the Response field, select the HTML content you want.
f. In the Value to insert field, select Response

g. Select Add.
The HTML content excluding images is inserted in to the disclosure report document.

6. To insert a report, move the cursor at the point where you want to insert data.
a. Select the Table tab on the right side pane.
b. The Business domain field is set to ESG.
c. In the Reporting item field, select the configured report that you want to insert.

d. Select Add.
The data is inserted in to the disclosure report document. The inserted text takes the
formatting of the document. You can modify the formatting as required.

7. To insert a chart, move the cursor at the point where you want to insert the chart.
a. Select the Chart tab on the right side pane.
b. The Business domain field is set to ESG.
c. In the Reporting item field, select the configured report that you want to insert.

d. Select Add.

The chart is inserted in to the disclosure report document. The inserted chart can be modified
according to your preferences. For example, you can change the colors, the type of chart and
so on.

8. To copy the document ID, select the copy icon.
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9. To view the details of any record that is inserted in the document, select the content control,
and then select Open link.

10. To view the list of all ServiceNow links that you’ve inserted in the report and obtain the latest
data on the document, select Manage Links.

a. Select the check boxes for the links that you want to refresh.

b. Select the refresh icon.
The data is refreshed while displaying the time of refresh and retaining the formatting of the
document.

11. To identify and highlight which content control is selected on the report, select the three
vertical dots or the more actions icon.
The content control is highlighted in the right pane.

Related topics
Add additional reporting configuration filters for a Microsoft 365 configuration record
Add related fields to a Microsoft 365 configuration record

Add the ServiceNow Reporting add-in into Microsoft Word

Create a claim from Microsoft Word
You can create a claim directly from Microsoft Word for use in future disclosures or reports.

Before you begin
Role required: Any user of the Microsoft Word document and sn_grc_claims.manager

Procedure
1. Navigate to the Microsoft Word document.

2. On the ribbon, select Create claim under ServiceNow Reporting.
On the right side pane, the ServiceNow log in screen appears.

3. To log in to your ServiceNow instance, select Login.

a. A message is displayed that states that ServiceNow Reporting displays in a new window,
select Allow.

b. On the ServiceNow login screen, provide your credentials.
c. Select Allow.

4. On the Claims for reporting form, fill in the fields.
For more information regarding the field descriptions, see Claims for reporting fields.

5. Select Save.

Integrating ESG Management with Advanced risk assessment

The ESG risk management capability enables you to assess and evaluate ESG risks
for businesses. This capability is an integration of ESG Management with Advanced
risk assessment. To use the risk assessment feature, you must install and activate the
sn_esg_risk_mgmt plugin.

The Advanced risk assessment feature enables you to integrate risk assessment as part of your
overall decision-making process.
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Risk assessment is of two types: Quantitative and qualitative. Qualitative risk assessments

rely on the assessor's perceptions of the probability and impact of a risk. If the method is

purely qualitative, then the ratings are based on the list values such as high, medium, or low.

In this case, the risk scores do not roll up. Because this method has minimal mathematical
dependency, qualitative risk assessment is easy and quick to perform. This method also enables
an organization to take advantage of the assessor's knowledge of the process or asset that is
being assessed. Users who are new to risk assessments usually use qualitative assessment.

A quantitative risk assessment focuses on data that is fact-based, measurable, and highly
mathematical. In a quantitative risk rating that uses advanced simulation techniques, the risk is
quantified in purely numerical terms.

The ESG risk management application provides both types of risk assessments and is employed
for assessing both entities and material topics. Object-based assessments focus on material
topics, while risk-based assessments are applied to entities. The resulting risk assessment
scores are then aggregated for risk-based assessments. Object-based assessment allows for
evaluating risks on ServiceNow records or objects even in the absence of a comprehensive
GRC setup for entities, risk statements, controls, and so on. An example of object assessment
involves assessing change management or assessing a citation. For a more in-depth exploration
of Advanced risk assessments, refer to the Advanced Risk Assessment B documentation.

To learn about the roles are installed with the sn_esg_risk_mgmt plugin, refer to Components
installed with ESG Management.

WorkAow of ESG risk management

To perform risk assessments for your material topics and your entities, the ESG administrator, the
ESG risk manager, and the ESG data owner must perform a set of defined steps.

The following steps are necessary to successfully perform your ESG risk assessments.

1. The system administrator enables the Migrate to Advanced Risk Assessments
property located under Advanced Risk Assessment > Administration > Properties.

2, As an ESG administrator, complete the following tasks.

a. Configure the two risk assessment methodologies (RAMs) that are provided by default.
One RAM is designed for evaluating material topics, while the other is tailored for assessing
entities. When you configure the methodologies, you specify the risks that you want to
assess such as inherent risk and residual risk. To understand each of these types, refer to
Advanced Risk Assessment &.

b. Configure the factors for the risk assessments. Factors are questions that appear during the
risk assessment to which the risk assessor responds. To understand more about factors and
their types, refer to Factors in Advanced Risk Assessment B.

3. As an ESG risk manager, complete the following tasks.

a. Create risk statements and associate entities with the risk statement. To learn how to create
arisk statement, refer to Create a risk statement &@.

b. Create risks. To learn how to create a risk, refer to Generate a risk from a risk statement &.

c. Create a risk assessment scope to define and identify risks for an entity, identify assessors
and approvers for assessments, define the frequency of assessments, and initiate the risk
assessment. To learn about how to create a risk assessment scope, refer to Create a risk
assessment scope and initiate assessments @.

4, For risk-based assessments, as an ESG data owner, from the Tasks pane in the ESG
Workspace, respond to an assessment, review, and submit the assessment for approval if the
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approvers are defined. If there are no approvers defined, the risk score is rolled up to the risks
and entities.

5. For object-based assessments, as an ESG program manager, from the Tasks pane in the ESG
Workspace, respond to the assessment, review, and submit for the assessment for approval if
the approvers are defined.

Configure a risk assessment methodology

Configure the risk assessment methodologies (RAMs) that are provided by default. A RAM is a
configuration or a record in the risk assessment engine.

Before you begin
Role required: sn_esg.admin

About this task

You can use a RAM to assess either the risks or objects in your organization. For example, you
can configure a RAM to specify the types of risk assessments and the entities on which a risk
assessment is performed. There are two RAMs that are provided by default with the domain area
set to ESG.

Procedure

1. Navigate to All > Environmental, Social, and Governance > Risk administration > Risk
assessment methodologies.

2. Select the RAM that you want to modify or configure.

3. On the form, modify the fields.
For information on the RAM fields, refer to Risk Assessment Methodology form &.

Create arisk assessment scope and initiate an assessment

Create arisk assessment scope to define and identify risks for an entity. Identify assessors and
approvers for assessments and define the frequency of assessments. After creating the scope,
initiate the risk assessments.

Before you begin
Role required: sn_esg_risk_mgmt.risk_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > Risk assessment planning >
Scoped entities.

2. Select New.

3. On the form, fill in the fields.
For information on the fields of the Risk Assessment Scope form, refer to Create a risk
assessment scope and initiate assessments &.

Initiate risk assessments on material topics

Assess the risks to your material topics by initiating a risk assessment and sending it to the
owner of the material topic.

Before you begin
Role required: sn_esg.program.manager
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Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Program Setup > Material topics.

2. Open the material topic for which you want to assess the risks.
3. Select Initiate risk assessment.

Resulit
The risk assessment is sent to the owner of the material topic. The assessor then responds to the

assessment.

Respond to arisk assessment
Conduct risk assessments to assess risks in the ESG Management application.

Before you begin
Role required: sn_esg.data_owner

Procedure
1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > My tasks.
2. Open the risk assessment that you want to assess and do one of the following.

o If you want to start the assessment, select Let's get started.

o If you think that the risk assessment must be assigned to someone else, select Reassign
and fill in the necessary details.

o [f this risk was previously assessed, to view the previous assessment, select Review last
assessment.

3. To perform inherent assessment, respond to the all inherent assessment questions.
4. Optional: To view the qualitative and quantitative weightage, select Overall rating.
5. To save and view the scores, select Save.
6. Optional: To change the computed inherent risk results, do the following:
a. Select the 1 would like to change the computed score option.
b. From the Override inherent risk field, select the appropriate value.
c. Enter comments that explain the reasons for the change in the computed score.
d. Select Save.

7. To assess the leftover risks after the implementation of mitigating controls, select Move to
residual assessment and respond to the factors.
You can also change the computed residual score by providing a justification for changing the
score.

8. Optional: If you want to modify the assessment, select Edit assessment.

9. If you have defined approvers, then select Review and submit.
The assessment home page is displayed. You can review the summary of your assessment.

10. To request approval, edit assignment, or reassign, select one of the following.

Description

If an approver is specified, select this option
to send the assessment for approval. You can

Request approval
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S [

also provide additional comments for the ap

prover.
Edit assessment If you want to modlfy your responses in the as
sessment, select this option.
. If the assessment must be assigned to some
Reassign

one else, select this option.

Integrating ESG Management with Watershed

Watershed is a tool that enables organizations to measure their carbon emissions and renewable
energy and its impact. It also enables organizations to act to reduce emissions, and to report on
the progress to reduce their carbon footprint.

ESG Management users can use Watershed to calculate their Scope 1, 2, and 3 emissions for
their business. A company’s greenhouse gas (GHG) emissions are classified into three Scopes.
The following table explains the difference between each Scope.

Difference between Scope 1, 2, and 3 emissions

Scope1 Scope 2 Scope 3
Direct GHG emissions from Indirect emissions from the Indirect emissions from the
the following sources: following sources: following sources:
» Fuel combustion » Purchased electricity » Purchased goods and
« Emissions from company » Heat and steam. services
vehicles « Business travel
« Emissions from chemical « Employee commuting

production in owned
or controlled process
equipment » Use of sold products

« Waste disposal

« Fugitive emissions « Transportation and
distribution (up- and
downstream)

¢ Investments

o Leased assets and
franchises

Watershed maintains its data in spreadsheets and provides those spreadsheets to the ESG
Management program manager. As an ESG Management program manager, with the role
sn_esg.program_manager, you must import the data from the spreadsheets into the source
tables in the ESG Management application. The source tables are then specified in the metric
definitions in a ServiceNow instance.

To use the features of Watershed, you must activate the Watershed Integration for ESG plugin
and configure the metric integrations.
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© Note:

« To successfully import data, you must add the import_admin role to the
sn_grc_metric.admin role.

» Only automated metric definitions with External source as the Method type support data
import. If you already have a manual metric definition in your system, you must change its
Type to Automated and the Method type to External source before you can import data.
For more information, refer to Create an automated metric definition.

Before you import data from the spreadsheets, you can either create the metric definitions or you
can rely on the system to create placeholders and add the details later.

The metrics are generated based on the frequency that you have defined in the metric definition.
The metric values, along with their units, are displayed on the metrics related list in the metric
definition. The values are then rolled up based on the formula specified in the metric definition.

@ Note: You can convert any metric data into a preferred reporting unit.

By default, the ServiceNow Al Platform provides the following data that you can import from
Watershed.

» Carbon emissions

« Renewable energy

« Non-renewable energy

You may also want to import other data such as water usage or waste disposal. To import other
types of data, you can use the Metric integrations to import your data.

Modify the Watershed Integration for ESG
Modify the Watershed Integration for ESG configurations to specify how you want to import data

from Watershed to generate metrics.

Before you begin
Role required: sn_esg.program_manager

About this task

The ServiceNow Al Platform provides a pre-configured integration to import data from
Watershed. However, you can update or modify the configuration properties based on your
requirements. For example, when you modify the configuration, you can specify if you want the
system to automatically create metric definitions or if you want to override metric data.

Procedure
1. Navigate to All > Environmental, Social, and Governance > Watershed > Metric Integration.
2. On the Metric Integrations page, select Watershed Integration.

3. On the form, edit the fields as required.

Watershed Integration form

Description
Name Name of the mapping.
Source Source of the mapping. This field is

automatically set to Watershed Data.
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Field Description

Domain area Domain from which the integration is
created. This field is automatically set to
ESG when the integration is created from
Environmental, Social, and Governance.

Source table The source table is automatically set to
Watershed Data.

Automatically create metric definition Option to automatically create the metric
definitions during data import.

Automatically create metric unit Option to automatically create the metric unit
during data import.

Automatically create entity type Option to automatically create the entity type
during data import.

Automatically create entity Option to automatically create the entity
during data import.

Overwrite metric data Option to overwrite metric data during data
import.

4. Select Update.

Create data mapping
Create data mappings to import Watershed data from columns other than the pre-configured
columns of the Watershed spreadsheet. By default, data import from three columns is supported.

Before you begin
Role required: sn_esg.program_manager

About this task

By default, you can import data related to carbon emissions, renewable energy, and non-
renewable energy. If you want to import other types of data such as water usage or waste
disposal from the spreadsheet, then you can create data mappings for them. You can create as
many mappings as you need.

Procedure

1. Navigate to All > Metrics > Metrics Integrations.
2. Select Watershed Integration.

3. In the Data mapping section, select New.

4., On the form, fill in the fields.

Data mapping form

Description
Name Name of the mapping.
Source table Source table of the mapping. This field is

automatically set to Watershed Data.

Data column Column from which you want to import data.

© 2026 ServiceNow, Inc. All rights reserved. 202
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Field Description

Start date column Column in the source table that has the start
date.

Start date Start date of the mapping. If there is no start
date column, specify the start date.

Frequency Frequency of the data in the spreadsheet. For
example, monthly data, annual data, or so on.

End date column Column in the source table that has end date.

End date End date of the mapping. If there is no end
date column, specify the end date.

Unit column Unit column from the imported data set.

Unit Unit of the data.

Default owner Metric definition owner or the entity owner.

Metric integration Metric integration. This field is automatically

set to Watershed Integration.

5. Select Submit.

Result
The new mapping is ready to import data.

Create a record identifier in an entity
Create record identifiers with text for correctly mapping the entities. This activity saves time for
the ESG program managers by not having to create new entities.

Before you begin
Role required: sn_esg.program_manager

About this task

You can map the existing data in your system, such as an entity, an entity type, and the metric
definition, with the data from the Watershed spreadsheets. If the format of the data is different in
the spreadsheets, you can create mapping record identifiers. This procedure uses an entity with
the entity class as Location as an example. For example, assume that you already have an entity
titled Akaska, Japan in your system and the spreadsheet contains the entity name as Akaska,
Minato, JP. In this case, you must enable the system to map Akaska, Minato, JP with Akaska,
Japan. To do this task, you must create a record identifier to identify the entity in your system.

Procedure

1. Navigate to All > Environmental, Social, and Governance > Scoping > All Entities.
2, Search for and open the entity for which you want to add a record identifier.

3. Select the Mapping related list.

4. Select New.

5. Copy the text that you want to map to the entity from the spreadsheet.

6. In the Record identifier field, paste the text that you copied in the previous step.

7. Select Submit.
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Result
The identifier is added to the entity. When the system detects the record identifier text during the
importing of data, the record will be mapped to the correct entity.

Load data from Watershed into ESG Management
Load data from the Watershed spreadsheets into the staging table. After you load the data and
complete the setup, you can start using the Watershed Integration for ESG.

Before you begin
You must add the import_admin role to the sn_grc_metric.admin role.

Role required: sn_esg.program_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > Load Data.

2. On the Load Data form, select Existing table.

3. In the Import set field, select Watershed Data [sn_esg_watershed_data].
4. Select Choose File, and select the file that you want to load.

5. Select Open.

6. In the Sheet number field, verify that the sheet number is appropriate.

7. In the Header row field, verify that the header row is appropriate.

8. Select Submit.

Result
The spreadsheet is loaded in the staging table. All the columns from the spreadsheet are
created.

What to do next
View the import set.

View and verify the import sets

Verify if your data is imported correctly from an external source. This verification enables you to
identify if there were any errors during the data import.

Before you begin
Role required: sn_esg.program_manager

About this task

After the data is loaded to the ESG Management application from an external source, such as

a spreadsheet, import sets are created where the state of each row is available. If there are
errors during import, the state is updated as Error. If the data is imported, the state is updated as
Inserted. You can also view the cause of the error in the error log. If the metric data is overridden,
then the state is set to Ignore.

Procedure
1. Navigate to All > Environmental, Social, and Governance > Import Sets.
2, Open the import set you want to verify.

3. In the Import Set Rows section, view the state of each row.
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If you want to reload the data to check for errors, you must import your data again. Do not
select Reprocess under Related Links in the Import set.

4. To view the error log, select the Import Log section.

What to do next
Creale a transform map.

Create a transform map

Create a transform map to match the columns from the staging table to the columns in the target
table. The transformation helps to convert the data from the source table into metric data.

Before you begin
If you already have manual Metric Definition in the system before the import, you must change

the type of metric definition to Automated and the method type to External source.
Role required: sn_esg.program_manager

About this task
A map is transformed when you import data from a staging table such as Watershed Data

[sn_esg_watershed_data] to a target table such as Metric Data [sn_grc_metric_metric_data].
By default, there are three transform maps available for each table when you import data from
Watershed.

Procedure

1. Navigate to Environmental, Social, and Governance > Watershed > Import Sets.
2. Open the import set that you created.

3. Under Related Links, select Transform.

4, On the Specify Import Set and Transform map form, move the required maps from the
Available column to the Selected maps run in order column.

5. Select Transform.

Integrating ESG Management with Urjanet

Urjanet is a cloud-based platform that extracts different utility bills directly from the source, and
delivers it into the business systems and applications that rely on it. As an ESG program manager
or a metrics manager you can get your utilities data automatically from Urjanet and avoid manual
data entry from your various facilities or office owners.

A utility bill is a detailed invoice, issued and paid once a month from utilities, including electricity,
natural gas, water, and waste. With the Urjanet ESG integration, organizations can obtain
historical or real-time utility data from Urjanet into the ServiceNow Al Platform in the form of
metrics. These metrics can then be tracked using the ESG Workspace and are associated

with other ESG components such as goals and targets thus enabling organizations to take the
necessary actions for sustainability.

Using this integration, you can automatically bring the following types of data from Urjanet into
the ESG Management application.

« Water and electricity consumption

» Waste generated and so on.

The workflow of the Urjanet ESG integration is as follows:
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1. Create entities: Each utility data for all your locations is tracked as an entity in the ESG
Management application. For example, your electricity consumption in your Atlanta office is
considered to be an entity. Therefore, you must create entities for all the utility data that you
want to track. If you've already created the entities, then you must map the utility data that is
imported from Urjanet with the entities created. Certain fields such as Entity class and Entity
owner in the entity forms must be manually filled in by the users of the integration.

2, Activate the metric definitions: For the Urjanet ESG integration, ServiceNow® provides a
few metric definitions by default. You must activate the ones that you require for your metric
collection. Only those metric definitions that are active are considered and their data is loaded
into the system. Certain fields such as Unit, Frequency and Enterprise owner in the default
metric definitions must be manually filled in by the users of the integration. If you don’t want to
use the metric definitions provided by default, you can create your own metric definitions.

3. Import the data for the metrics: After the user activates the required metric definitions, the data
for those metric definitions and their entities will be imported into the ESG Management as
metrics and metric data.

Install Urjanet ESG integration

You can install the Urjanet ESG integration application (sn_esg_urjanet) if you have the admin
role. The application installs related ServiceNow ™ Store applications and plugins if they are not
already installed.

Before you begin

« Ensure that the application and all of its associated ServiceNow Store applications have valid
ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product
or application &.

« Ensure that you create an Urjanet account and obtain the login credentials.

Role required: sn_esg.admin
About this task
The following items are installed with Urjanet ESG integration:
« Plugins
« Store applications
* Roles
» Scheduled jobs

e Tables

For more information, see Components installed with ESG Management.

Procedure
1. Navigate to All > System Applications > All Available Applications > All.

2. Find the Urjanet ESG integration application (sn_esg_urjanet) using the filter criteria and
search bar.

You can search for the application by its name or ID. If you cannot find the application, you
might have to request it from the ServiceNow Store.

In the list next to the Install button, the versions that are available to you are displayed.

3. Select a version from the list and select Install.
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In the Review Installation Details dialog box, any dependencies installed with your application
are listed.

4. If you're prompted, follow the links to the ServiceNow Store to get any additional entitlements
for dependencies.

5. Optional: If demo data is available and you want to install it, select the Load demo data check
box.
Demo data comprises the sample records that describe application features for the common
use cases. Load the demo data when you first install the application on a development or test
instance.

6. Select Install.

Create an Urjanet connection

Create an Urjanet account connection with valid credentials to establish a connection

between Urjanet and ServiceNow®. Only one connection can be active for each domain for the
integration. You can separate the imported data into logically defined domains. Data access is
restricted among the domains.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > Urjanet > Connection &
Credential Alias.

2. Select the Create New Connection & Credential.
3. On the form, fill in the fields.

Create Connection and Credential form

Field Description

Connection name Name of the connection. This field is
automatically set to Urjanet Connection.

Connection URL Urjanet APl base URL. This field is
automatically set to https://api.urjanet.com.

Date Date from which the historical data must be
loaded. This date must be in the past.

@ Note: The date must be in the yyyy-
mm-dd format.

Credential name Name of the credential. This field is
automatically set to Urjanet Credential.

Username Urjanet account username.

Password Urjanet account password.

4. Select Create.
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Create an entity mapping for Urjanet
Create entity mappings for Urjanet because the Urjanet ESG integration considers each Urjanet
account meter as an entity.

Before you begin
Ensure that you activate the sn_esg_urjanet plugin.

Role required: sn_esg.admin

About this task

Before starting with the integration, if you do not have entity mappings, you can create entity
mappings so that the Urjanet account meter data can be mapped to an entity. The Urjanet ESG
integration considers the Urjanet account meters as entities. This procedure is optional.

Procedure

1. Navigate to All > Environmental, Social, and Governance > Urjanet > Entity Mapping.
2, Select New.

3. On the form, fill in the fields.

Entity Mapping form

Record identifier Urjanet meter ID.

Related record Entity to be mapped.

Additional information Field used to specify the information that
must be filled in by the administrator. Certain
fields such as Entity class and Entity owner
must be manually filled by the user.

State Review state. Based on the information

provided in the Additional information field,
the administrator must fill in the required
information and then change the state of this
field. The choices are as follows.

o No review required: Use this option when
there are no fields to be filled in the entity
record by the administrator.

o Review required: Use this option if the
administrator must fill some fields in the
entity record.

o Reviewed: Use this option if the
administrator has already provided the
information in the specified fields in the
entity records.

This field is automatically set to No review
required. You must change the state to
Reviewed after you provide the information.

4. Select Submit.
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Create a metric definition mapping
Create a metric definition mapping to map the imported data from Urjanet with the correct metric
definitions.

Before you begin
Role required: sn_esg.metrics_manager

Procedure

1. Navigate to All > Environmental, Social, and Governance > Urjanet > Metric Definition
Mapping.

2. Select New.
3. On the form, fill in the fields.

Metric Definition Mapping form

Field Description

Record identifier Name of the record that will be used to map
data. For example, Electric - Demand
usage.

Related record Metric definition to which the record is
mapped.

Additional information Any notes or comments.

State Review state. This field is used to provide

information to sn_esg.admin that there are a
few entity mapping records to be reviewed
and those records require the missing
information. The choices are as follows.

o No review required: Use this option when
there are no fields to be filled in the entity
form by the admin.

o Review required: Use this option if the
admin must fill some fields in the record.

o Reviewed: Use this option if the admin has
already provided the information in fields.

This field is automatically set to No review
required.

4. Select Submit.

Generate Webhook URL

Define a Webhook registry for generating the Webhook URL. Urjanet uses the Webhook URL to
send real time data to the ESG Management application when an Urjanet statement data is either
generated or modified.

Before you begin
Role required: sn_esg.admin
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About this task

A statement in Urjanet refers to a bill. Whenever a new statement is generated in Urjanet, using
the defined Webhook, the ESG Management application is notified about the new statement
generation and the data is fetched into the ESG Management application without any manual
intervention.

Procedure

1. Navigate to All > Environmental, Social, and Governance > Urjanet > Webhook Registry.
2. Select New.

3. On the form, fill in the fields.

Urjanet Webhook Registry form

Field Description

Name Name of the registry.

Path Resource path of the Scripted REST API to be
used for inbound Urjanet API calls. This field
is automatically set to api/sn_esg_urjanet/
webhook.

4. Select Submit.
5. Open the record that you created and select Generate Webhook URL.

6. To copy the Webhook URL, right-click the information
message that appears on the screen and select Copy Link

[ <‘ - :.lers}'anelwebhwkr(eg?strv e = - |u.,d.t= [Gmemgwamoakum Delete v

@ Copy the Webhook URL fromjher x
"‘L_k‘ Open Link in New Tab.

Open Link in New Window

1 Path api/sn_esg urjanet/webhook

Open Link in Incognito Window

Update || Generate Webhook URL J Copy Link Address

Copy

Search Goagle for “here” (0]
Print...

Inspect

Speech >

Services >

Address.

What to do next
Paste the URL that is generated in the Urjanet console to get real-time Urjanet statement data.
For more information, contact your system administrator.

Import meter details from Urjanet

Using scheduled jobs, import meter details such as meter number, meter ID, and so on from
Urjanet into the ESG Management application for reporting purposes. The details are imported in
the form of entities.

Before you begin
Role required: import_scheduler

Procedure
1. Navigate to All > System Import Sets > Administration > Scheduled Imports.

2. Select and open the Urjanet Entity Scheduled Data Import record.
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3. Select Execute Now.
By default, the data import is set to run every 90 days but you can modify the frequency in the
Run field. For more information on configuring a scheduled data import, see Schedule a data
import &.

Result
The entities are created with the following details.

» Name: Urjanet meter’s site name and Urjanet meter’s meter number.
« Location: Service address of the Urjanet meter.

« Description: Provider of the Urjanet meter.

Load historical Urjanet data

Load historical Urjanet account statement data as metric data by creating new metrics that can
be managed as part of ESG Management. Data is retrieved from the date that you specify while
configuring the Urjanet connection.

Before you begin
Role required: import_scheduler

Procedure
1. Navigate to All > System Import Sets > Administration > Scheduled Imports.
2. Select and open the Urjanet Metric Data Scheduled Data Import record.

3. Select Execute Now.
By default, the data import is set to run every 90 days but you can modify the frequency in the
Run field on the Scheduled Data Import form. For more information on configuring a scheduled
data import, see Schedule a data import @.

Resulit
The metrics are created by using the configured entities and metric definitions.

Integrating ESG Management with Workday

The Workday ESG integration plugin enables users to import HR data that is required for ESG
reporting from Workday into the ESG Management application.

Using this integration, an ESG administrator can import monthly and yearly metric data from

a wide range of categories such as benefits, demographics, compensation, and so on. This
integration saves time for HR, ESG, and IT teams by making the data transfer process secure and
automatic. The integration is also configurable according to an organization's requirements. By
default, 150 metric definitions in Inactive state and 15 corresponding reports are provided to the
users. To configure the reports on Workday, see the Workday ESG Integration Workday Reports'
Configuration [KB1220842] & article in the Now Support Knowledge Base. The article also
provides mappings between the metric definitions and the Workday reports. ESG administrators
must activate those metric definitions from which they want data. The data that is obtained is
then used for disclosure reporting.

The following are the different types of reports that can be obtained using the integration:
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« Pointin time: In this type of report, the metric data is obtained until a given point in time. For
example, you may want to obtain data for the number of hires in an organization on a specific
date such as Jan 25, 2023. In this case, if the metric definition has the frequency set to Annual,
the data until Dec 31, 2022 will be available for reporting.

« Cumulative: In this type of report, the metric data is obtained for a given period. For example,
you may want to obtain the data for the number of hires for a particular quarter in the year
2023.

Workfow of Workday ESG integration

To import data from Workday into ESG Management, you must perform a sequence of tasks and
configure the system properly.

The workflow of the integration is described as follows.

1. The ESG administrator installs the Workday ESG integration plugin and does the following:
a. Creates a connection and credential with the help of the Workday administrator.
b. Activates the necessary metric definitions.

2. The Workday administrator configures the Workday reports.

3. The administrator offboards the webhook configuration.

4, The ESG administrator generates the webhook registry.

5. The system administrator executes the necessary scheduled jobs.

6. After the report is ready, the metric definitions and their corresponding data is available in a
comma-separated values (CSV) file.

Install Workday ESG integration

You can install the Workday ESG integration application (sn_esg_workdayg)if you have the admin
role. The application includes demo data and installs related ServiceNow ™ Store applications
and plugins if they are not already installed.

Before you begin

« Ensure that the application and all of its associated ServiceNow Store applications have valid
ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product
or application &.

Activate the ServiceNow IntegrationHub Enterprise Pack Installer
(com.glide.hub.integrations.enterprise) plugin.

Role required: admin
About this task
The following items are installed with Workday ESG integration:
* Plugins
« Store applications
o Environmental, Social, and Governance Management
o GRC: Profiles Dependencies
o GRC: Policy and Compliance Management
© GRC: Metrics

o Goal Framework
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* Roles
« Scheduled jobs

e Tables

For more information, see Components installed with ESG Management.

Procedure
1. Navigate to All > System Applications > All Available Applications > All.

2. Find the Workday ESG integration application (sn_esg_workday) using the filter criteria and
search bar.

You can search for the application by its name or ID. If you cannot find the application, you
might have to request it from the ServiceNow Store.

In the list next to the Install button, the versions that are available to you are displayed.
3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application
are listed.

4. If you're prompted, follow the links to the ServiceNow Store to get any additional entitlements
for dependencies.

5. Optional: If demo data is available and you want to install it, select the Load demo data check
box.
Demo data comprises the sample records that describe application features for the common
use cases. Load the demo data when you first install the application on a development or test
instance.

6. Select Install.

Create a Workday connection
Create connection and credential records for the Workday ESG integration so that you can
establish a new connection.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social and Governance > Workday Integration for ESG
Management > Connection & Credential Alias.

2. On the Connection and Credentials Aliases form, select the Create New Connection &
Credential related link.
Contact your Workday administrator to obtain the information for the required fields.

3. On the form, fill in the fields.

Create Connection and Credential form

Description

Connection information

Connection name Name of the OAuth connection.
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Field Description

Connection URL Workday Connection URL.

Soap version Latest version of simple object access
protocol (SOAP) available in Workday

Tenant name Tenant Name of Workday.

Credential information

Credential name Name of the OAuth credential.

OAuth Client ID OAuth Client ID configured in Workday.

OAuth Client Secret OAuth Client Secret configured in Workday.

OAuth Redirect URL OAuth callback endpoint. This field is
automatically set.

Auth URL Workday OAuth Server's auth code flow
endpoint.

Token URL Workday OAuth Server's token endpoint.

4, Select Create and Get OAuth Token.

Result
A new connection is created in the connections related list.

What to do next

Configure the Workday reports. See the Workday ESG Integration Workday Reports'
Configuration [KB1220842] & article in the Now Support Knowledge Base article in the Now
Support Knowledge Base.

Activate the Workday reports
Activate the corresponding Workday report for each of the metric definitions that is provided by
default.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social and Governance > Workday Integration for ESG
Management > Workday Reports.

2, Select and open the report you want to activate.

3. Select the Active option.

4. In the Frequency field, select the frequency to run the report.
5. Select Update.

Generate webhook registry username and password

Generate a user name and password in your ServiceNow instance to authenticate webhook
requests and retrieve the required metric data from the Workday application.

Before you begin
Role required: sn_esg.admin
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Procedure

1. Navigate to All > Environmental, Social and Governance > Workday Integration for ESG
Management > Webhook Registry.

2. Select New.
3. On the form, fill in the fields.

Workday webhook registry form

Field Description

Name Unique name for the webhook.

Workday instance URL Workday host URL and tenant name. This
URL will be provided by your Workday
administrator.

Username Username that will be generated. This field
is automatically set after you generate the
username and password.

Password Password that will be generated to log
in to the Workday instance. This field is
automatically set after you generate the
username and password.

Domain Domain in which the registry is being created.
Select global in this field.

4, Right-click the form header and select Save.

5. Select Generate username and password.
Copy and record the values of username and password. These values must be specified in the
Workday instance to authenticate the webhook requests.

Activate the metric definitions to track data
Activate those metric definitions for which you want to track or import data.

Before you begin
Role required: sn_esg.admin, sn_esg.program_manager

About this task

As part of the Workday ESG integration, 150 automated metric definitions are provided by
default. You must activate those metric definitions which are relevant for you and which you want
to track. For example, if you want to track the metric data for the number of employees in critical
role, then you must activate this particular metric definition.

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Automated metric definitions.

2, Select the filter icon on the top-right.
3. Select Advanced view.
4. In the Advanced view filter conditions, to add a filter, select and.
5. Create a condition with Source is ESG Workday.
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6. Select Update.
7. Select and open the metric definition you want to activate.
a. Select the Details related list.
b. In the Description field, provide a brief description of the metric definition.
c. In the Enterprise owner field, select an enterprise owner.
d. Select the Active option.
e. Select Save.
Result
The metric definition is now active and the data from this metric definition can be imported.
Run the entity onboarding job for Workday reports
Run the specified scheduled job to get new entities that may have been added in Workday.

Running this job ensures that the entity mapping table is updated.

Before you begin
At least one Workday report must be activated.

Role required: admin

About this task
When you run the Workday entity onboardingscheduled job, the job uses the first
activated report in the system to invoke Workday. Workday then sends the entity ID in the CSV

file along with the activated report value.

Procedure
1. Navigate to All > System Definition > Scheduled Jobs.
2, In the Search field, enter Workday.

3. From the filtered search results, select and open the Workday entity onboarding
scheduled job.

4. Select Execute Now.

Run the Workday data import job
Run the scheduled integration job that runs that pulls data for the activated reports based on the
frequency specified in the job.

Before you begin
At least one Workday report must be activated.

Role required: admin

Procedure

1. Navigate to All > System Definition > Scheduled Jobs.

2. In the Search field, enter Workday.

3. From the filtered search results, select and open the Workday data importscheduled
job.

4. Select Execute Now.
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Run the Workday on demand job

Use the ad-hoc Workday on-demand data import job to pull data for all activated Workday
reports.

Before you begin
Role required: admin

Procedure
1. Navigate to All > System Definition > Scheduled Jobs.
2, In the Search field, enter Workday.

3. From the filtered search results, select and open the Workday on-demand data
Iimportscheduled job.

4. Select Execute Now.

Integrating ESG Management with SAP Concur

Use the ESG integration with Concur to calculate your carbon emissions when your employees
travel by car, airplane, and train for business. Tracking these emissions enables you to manage
them and take the necessary actions to reduce them.

Business travel is an essential aspect of many organizations. However, such travel often results
in the emission of harmful greenhouse gases. SAP Concur is a travel and expense management
solution that automates the spend management process. It also integrates with other enterprise
systems, such as accounting and financial management software, to provide a complete view of
travel and expense data.

When you use the ESG integration with Concur, you can better understand the impact of
employee travel on the environment, and calculate the carbon emissions generated when
employees travel by plane, train, or car for business purposes. This information can help
organizations take steps towards reducing their carbon footprint and promoting environmentally
sustainable practices. Using this integration, you can import travel data for employees for Scope
3 emission calculation and avoid manual data entry.

To track the emissions, by default, the following metric definitions are provided in inactive state:
« Total distance travelled by all employees by car
« Total distance travelled by all employees by train

« Total distance travelled by all employees by airplane

You must activate those metric definitions that you require. After you create the necessary
connections and credentials and subscribe to the webhook registry, the scheduled jobs that are
provided run and every time there is a trip created or updated in Concur, the data gets imported
into ESG Management.

Install the ESG integration with Concur

You can install the ESG integration with Concur application (sn_esg_concur) if you have
the admin role. The application includes demo data and installs related ServiceNow ™ Store
applications and plugins if they are not already installed.

Before you begin

« Ensure that the application and all of its associated ServiceNow Store applications have valid
ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product
or application &.
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Role required: admin

About this task

The following items are installed with ESG integration with Concur:
* Roles
« Scheduled jobs

e Tables

Procedure
1. Navigate to All > System Applications > All Available Applications > All.

2. Find the ESG integration with Concur application (sn_esg_concur) using the filter criteria and
search bar.

You can search for the application by its name or ID. If you cannot find the application, you
might have to request it from the ServiceNow Store.

In the list next to the Install button, the versions that are available to you are displayed.
3. Select a version from the list and select Install.

In the Review Installation Details dialog box, any dependencies installed with your application
are listed.

4, If you're prompted, follow the links to the ServiceNow Store to get any additional entitlements
for dependencies.

5. Optional: If demo data is available and you want to install it, select the Load demo data check
box.
Demo data comprises the sample records that describe application features for the common
use cases. Load the demo data when you first install the application on a development or test
instance.

6. Select Install.

Activate the SAP Concur metric definitions

Activate those metric definitions for which you want to track emissions data. By default, three
metric definitions are provided to track the emissions generated by employees traveling by
airplane, car, and train.

Before you begin
Role required: admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > ESG Workspace > Lists >
Automated metric definitions.

2, Select the filter icon on the top-right.

3. Select Advanced view.

4. In the Advanced view filter conditions, to add a filter, select and.
5. Create a condition with Source is ESG SAP Concur.

6. Select Update.

7. Select and open the metric definitions you want to activate.
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a. Select the Details related list.
b. Select the Active option.

c. Select Save.

Create a connection for SAP concur event subscription service
Create connection and credential records for the ESG integration with Concur so that you can
establish a new connection.

Before you begin
Role required: sn_esg.admin

Procedure

1. Navigate to All > Environmental, Social, and Governance > SAP Concur > Connection and
Credentials Alias.

2. Select SAP Concur Event Subscription Service.

3. On the Connection and Credentials Aliases form, select the Create New Connection &
Credential related link.
Contact your Concur administrator to obtain the information for the required fields.

4., On the form, fill in the fields.

Create Connection and Credential form

Field Description

Connection information

Name Name of the OAuth connection.

Connection URL Concur Connection URL.

Version Version of the API. This field is automatically
set to v4.

Credential information

Token URL Concur OAuth Server's token endpoint.
Client ID OAuth Client ID configured in Concur.
Client Secret OAuth Client Secret configured in Concur.

5. Select Create and Get OAuth Token.

Result
The Oauth token is created successfully.

Create a SAP Concur webhook registry

Create a webhook registry to be notified whenever a trip is either created or modified in SAP
Concur.

Before you begin
Role required: sys_admin
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Procedure

1. Navigate to All > Environmental, Social, and Governance > SAP Concur > Webhook Registry.
2. Select New.

3. On the form, fill in the fields.

SAP Concur webhook registry form

Description

Name Name of the registry. For example, ESG
integration.

Path This field is automatically set.

Token Select a token.

4. Right click the form header and select Save.
5. Select Callback URL.

6. Copy the URL that is generated.

7. Select Submit.

Create a webhook subscription
Webhooks are used to simplify communication between two applications. Create a webhook
subscription to connect to Concur through webhook.

Before you begin
Role required: sys_admin

Procedure

1. Navigate to All > Process Automation > Flow Designer.

2. Select Actions.

3. Using the Search field, search for Create webhook subscription.
4. SelectCreate webhook subscription.

5. Select Test.

6. In the Test Action dialog box fill in the fields.

a. In the Name field provide a name for the test.
Ensure that the name has no spaces and special characters.

b. In the Endpoint field, paste the URL that you generated when you created the SAP webhook
registry.

c. In the Topic field, select Public.concur.travel.itinerary.
d. Select Run Test.

Run the entity onboarding job for SAP Concur

Run the specified scheduled job to get new entities that may have been added in Concur.
Running this job ensures that the entity mapping table is updated.
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Before you begin
Role required: admin

Procedure
1. Navigate to All > System Definition > Scheduled Jobs.
2. Search for the SAP Concur entity onboarding scheduled job.

3. Select Execute Now.

Run SAP Concur trip data import scheduled job

Run the trip data import scheduled job to obtain the trip data from Concur. The trip data consists
of details such as the distance traveled, trip start date and end date, and so on. This job runs
automatically but can also be executed manually.

Before you begin
Role required: admin

Procedure
1. Navigate to All > System Definition > Scheduled Jobs.
2. Search for the SAP Concur trip data import scheduled job.

3. Select Execute Now.

Run SAP Concur data import scheduled job

The data import scheduled job automatically runs monthly and can also be executed manually.
When this job runs, it aggregates the data from the SAP Concur trip data staging table based on
the trip end date and creates metric data for the respective metric definitions.

Before you begin
Role required: admin

Procedure
1. Navigate to All > System Definition > Scheduled Jobs.
2. Search for the SAP Concur data import scheduled job.

3. Select Execute Now.

Overview pages in the ESG Workspace

In the ESG Workspace, you can view various dashboards and relevant data based on the
overview pages of records. The data displayed is based on the user role of the users.

Goals overview in the ESG Workspace

Goals refer to objectives that an organization sets for itself to make an impact on their ESG
initiatives. They help you to track your progress toward the material topics that you have
identified.

When you create a goal, the overview page of the goal displays the summary of all the relevant
information for the goal. To view the goals overview page for a goal, navigate to ESG workspace
> Program setup > Goals. You can then select and open the goal for which you want to view the
information.
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The following sections are displayed on this page:

« Description

« Tracking

» Programs/Projects if you integrate with Project Portfolio Management.

« Risk and Compliance Posture if you integrate with Integrated Risk Management.

» Goals and Targets Hierarchy

The following image shows the overview page for a single goal.

Goal overview page
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Description

This section displays the description of the goal. For example, Aim to be 100% carbon
neutral by 2025.

Tracking

When you create a goal, you can associate an entity with the goal to enable tracking. You can
view the following sections:

« In-scope entities: By associating an entity, you can identify who is responsible for the goal.
This section shows the number of entities associated with the goal.

» Goals summary: Displays the total number of sub-goals associated with the goal. This section
also shows the numbers of completed goals, the number of goals on track, the number of
goals at risk, and the number of goals that are off-track.

« Targets summary: Displays the total number of targets. This section also shows the numbers
of completed targets, the number of targets on track, the number of targets at risk, and the
number of targets that are off-track.

» Metrics: Displays the different metrics associated with the goal. You can also see the number
of metrics that are due in 30 days and the number of metrics that are overdue.

You can filter the tracking section to view the data only for the goal. You can see the roll up view
to view the data of all the sub-goals. The default view is the roll up view.
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Programs/Projects

The programs and projects section only appears if you integrate with Project Portfolio
Management. In this section, you can view the projects and programs associated with the goals.
You can view the managers and states of these projects and programs.

Risk and Compliance Posture
The risk and compliance posture sections only appears if you integrate with Integrated Risk
Management. In this section, you can view the following information:

« Policy compliance: The status of compliant and non-compliant policies.

« Control compliance: The status of compliant and non-compliant controls.

« Risk profile: Risk status of the goal based on the risk assessment.

« Open control issues: The number of open issues related to the goal.

Goals and Targets Hierarchy

In the Contextual side panel, you can view the main goal, the associated sub-goals, and their
statuses.

Disclosure overview in the ESG Workspace

The Overview tab for the disclosure records in the ESG Workspace is designed for different
users to view the state and summary of the disclosures.

The new ESG Workspace is enhanced to ease the way that you perform your daily tasks. The list
view in the workspace shows a simpilified list of all the modules. You can access the disclosures
by navigating to Disclosures in the List view.

Click a disclosure in the List view to display the details of the disclosure. The top section displays
the title of the disclosure, the type of the disclosure, its state, and the owner that the disclosure is
assigned to.

Sections in the Disclosure Overview tab

The Disclosure Overview tab displays the following sections:
« State

« Disclosure summary
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Disclosure Overview tab
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State Draft

The State section displays the stepper component for the disclosure. The stepper component
displays the completion of various states of the disclosure such as Draft, Work in Progress,
Review, and Completed.

The Disclosure summary section displays the goals that are listed in the disclosure. Each goal
record displays the metric, period, and unit associated with the disclosure. For example, the goal
listed in the disclosure for a particular organization is to reduce its carbon footprint and aspire

to be 100% Carbon Neutral by 2025. The metric to measure the goal is the criteria defined in the
Scope 1 GHG emissions. The unit to measure the metric is Metric tons of carbon dioxide for the
given period.

If you want to export the data in the disclosure to an Excel spreadsheet, click Export to excel in
the Disclosure summary section.
ESG Management reference

The following sections show the roles, tables, and properties installed with the ESG Management
application.

Components installed with ESG Management

Several types of components such as roles, tables, and properties are installed with the ESG
Management application and the GRC: Metrics application.

Roles
The following roles are installed with the ESG Management application.

o Note: For the tables and roles installed with the GRC: Metrics application, see
Components installed with the GRC: Metrics application.

Roles installed with ESG Management

Description Privileges Contains
sn_esg.admin Manages all the items  Users with this role sn_esg.program_manager,
within the application can read, write, sn_esg.integrations_admin,
and configures sn_esg.internal_admin,
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Roles installed with ESG Management (continued)

Role Description

the setup for ESG

integrations.
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Privileges

update, and delete
the following:

« Material topics

» Goals

» Targets

» Metric definitions
» Metrics

» Metric data

» Metric data task
« Disclosures

o Authority
documents

« Citations

« Citations and
metric definitions
from the ESG
content accelerator
application

¢ Risk assessment
factors

» Update and publish
risk assessments
methodologies

« Emission activity

« Emission activity
source

« Emission factor

« Emission factor
location

If Scope 3 emissions
is installed, this role
can do the read, write,
update, and delete
the following.

* Scope 3 emission
category types

e Supplier emissions
by model

« Inflation factors

These users can
read and update the

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

Contains

sn_grc_metric.admin,
sn_esg.internal_disclos
report_user,
sn_esg_msoff_intg.adn

If the ESG Risk
Management

plugin is activated,
sn_risk_advanced.ara_|
and sn_risk.manager
roles are

installed. If the
com.snc.multiprovider_|
plugin is activated, the
mp_document_user
role is added.

ure_manager,

in,

admin,

documents
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Roles installed with ESG Management (continued)

Role

Description

sn_esg.metrics_managekManages metrics in

sn_esg.reporting_discloMizaagesdgsriosure
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the ESG workspace.

report in the ESG
workspace.

Privileges

sn_esg_scopel3.historical_years_s

system property and

can access the Scope

3 dashboard.

Users with this
role can read the
following:

« Material topics
« Goals

« Targets

» Metric data

» Metric data task

o Authority
documents

« Citations

These users can read,
write, and update

the metrics and
metric definitions.
These users can

only delete those
metrics definitions
and metrics that they
have created.

Users with this
role can read the
following:

« Material topics

* Goals

« Targets

» Metric definitions
» Metrics

» Metric data

» Metric data task

« Authority
documents

« Citations

e Scope 3 emission
category types

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

Contains

sh_esg.reader,

sn_grc_metric.manage

sn_esg.internal_disclos

sn_esg.reader,
report_user,

sn_esg_msoff_intg.read

If the

com.snc.multiprovider_

plugin is activated, the
mp_document_user
role is added.

elector

ure_manager,

ler

documents
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Roles installed with ESG Management (continued)

Role

sn_esg.data_owner

Description

Data owner role to
provide input to the

assigned metric data

tasks.

sn_esg.program_manag8upports the
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execution and
management of
ESG program
development,
implementation, and
reporting.

Privileges
» Supplier emissions
by model

« Inflation factors

These users can read,
write, and update the
disclosures. These
users can only delete
those disclosure that
they have created.

Users with this
role can read the
following:

« Goals

« Targets

» Metric definitions
» Metrics

» Metric data

o Authority
documents

« Citations

These users can read,
and update the metric
data tasks.

Users with this role
can read, write,
update, and delete
the following:

« Material topics

» Goals

» Targets

» Metric definitions

» Metrics

» Metric data

» Metric data task

« Content accelerator
« Emission activity

« Emission activity
source

« Emission factor

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

Contains

sn_grc_metric.user,
workspace_user,
sn_gf.goal_user_read,
canvas_user,
sn_grc_metric.reader,
sn_grc_workspace.task]
sn_grc.library_reader

If the ESG Risk
Management

plugin is activated,
sn_risk_advanced.ara_
sn_risk.reader roles
are installed.

sn_esg.reader,
sn_gf.epmo_strategy_p
sn_grc_metric.manage
sn_gf.goal_user,

|_reader,sn_grc_

ASsessor

anner,

sn_esg.internal_manager,

sn_grc.library_admin,
sn_compliance.library_

If the ESG Risk
Management

plugin is activated,
sn_risk.reader
sn_risk_advanced.ara_
roles are installed.

admin

approver,sn_ris
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Roles installed with ESG Management (continued)

Role

Description

sn_esg_risk_mgmt.risk_Manages risk
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assessments in the
ESG domain.

Privileges

« Emission factor
location

e Scope 3 emission
category types

e Supplier emissions
by model

« Inflation factors

These users can read
authority documents,
citations, framework
status, GRI citation,
Metric definition,
SASB citation, TCFD
citation, UN SDG
citation, Scope 3
dashboard, inflation
factors.

If the ESG content
accelerator,
application is
installed, these users
can read emission
activity source,
emission activity,
emission factor
location, emission
unit, and disclosures.
They can read and
update Emission
activity location.

They can also delete
only those metrics
and metric definitions
that they have
created.

They can read and
update the system
property Scope 3
dashboard's historical
years selector.

Users with this role
can do the following
tasks:

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

Contains

sn_risk.manager
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Roles installed with ESG Management (continued)
Role Description Privileges Contains

¢ Create the risk

© Note: This
framework

role is available
only when the « Create risk
sn_esg_risk_mgmt  statements
is installed and

. « Create risks
activated.

o Create the risk
scope to generate
risks

« Initiate risk
assessments

o Approve risk
assessments

sn_grc_claims.manager Manages claims in the Users with this role sn_grc_claims.manage
ESG domain. can do the following
tasks:

« Create a claim
« Edit a claim

« Export a claim

Tables

The following tables are installed with the ESG Management application.

Tables installed with ESG

Table Description

Material topics to define ESG material
Material Topic issues

[sn_esg_material_topic]

Categorize and group units
Unit family

[sn_grc_metric_unit_family]

Set up unit conversion value for From
Unit conversion and To units

[sn_grc_metric_unit_conversion]

o o An emission activity is any activity that
Emission activity leads to emissions

[sn_esg_emission_activity]
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Tables installed with ESG (continued)

Table Description

o An emission factor is a coefficient that
Emission factor allows to convert activity data into

. greenhouse gas (GHG) emissions
[sn_esg_emission_factor]

o ) To capture emission factor at location
Emission factor location level

[sn_esg_emission_factor_location]

Association between calculated metric
Calculated metric definition to Emission factor definitions and emission factor

sn_esg_m2m_calculated_definition_emission_factor

Association between metric and goal
Metric to Goal

[sn_esg_m2m_metric_goal]

Association between metric and target
Metric to Target

[sn_esg_m2m_metric_target]

Association between material topic and
Material Topic to Goal goal

[sn_esg_m2m_material_topic_goal]

Association between goal and
Goal to Disclosure disclosure

[sn_esg_m2m_goal_disclosure]

Association between goal and citation
Goal to Citation

[sn_esg_m2m_goal_citation]

Association between entity and goal
Entity to Goal

[sn_esg_m2m_entity_goal]

) ) Association between metric and
Metric to Disclosure disclosure

[sn_esg_m2m_disclosure_metric]

Association between metric definition
Metric Definition to Disclosure and disclosure

[sn_esg_m2m_disclosure_metric_definition]

Used to upload relevant documents and
Related URL resources for the data task.
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Tables installed with ESG (continued)

Table Description

[sn_grc_metric_data_task_url]

Threshold used to measure the
Threshold achieved progress of the metric
target. This table is the parent table of

[sn_grc_metric_threshold] sn_grc_metric_metric_threshold.

. Parent table of
Metric Threshold sn_grc_metric_metric_threshold

[sn_grc_metric_metric_threshold]

Disclosure summary report to display
Disclosure Summary related information such as citation,
metric, metric data associated to the
disclosure. It will be refreshed via a daily
scheduled job.

[sn_esg_disclosure_summary]

Disclosure of the company's E,S, and G
Disclosure data.

[sn_esg_disclosure]

Related document URL associated with

[sn_esg_disclosure_url]

. Goal activity summary report to display
Goal Activity Summary related info in a summarized format. It

.. will be refreshed via a scheduled job.
[sn_esg_goal_activity_summary]

Top level goal information along with
Goal Summary related sub-goal and target info

[sn_esg_goal_summary]

ESG program manager is able to
Heatmap Chart Color configure the color for heatmap chart

[sn_esg_heatmap_chart_color]

Holds ISSB framework and citation
ISSB citation content data.

[sn_esg_content_issb_citation]

) Holds the details of forecast analysis for
Analysis forecast context and forecast method.

[sn_grc_forecast_analysis]

Analysis context Holds the details of forecast context
like Name, Metric definition, Periods to
[sn_grc_forecast_context] forecast and Previous periods.
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Tables installed with ESG (continued)

Table Description

) Table that stores forecast data for future
Analysis data periods data for given a context and

analysis.
[sn_grc_forecast_data] y

) Table that stores operands forecast
Analysis parameter data data for future periods data for given a

context and analysis.
[sn_grc_forecast_parameter_data]

If Policy and Compliance Management is installed

Association between Goal and Control
Control to Goal

[sn_esg_m2m_control_goal]

Association between Control Objective
Control Objective to Goal and Goal

[sn_esg_m2m_control_obj_goal]

Association between Citation and
Citation to Disclosure Disclosure

[sn_esg_m2m_disclosure_citation]

Association between Policy and Goal
Policy to Goal

[sn_esg_m2m_policy_goal]

Association between Base metric
Base metric definition to citation definition and Citation

[sn_esg_m2m_base_metric_definition_citation]

Association between Base metric
Base metric definition to target definition and Target

[sn_esg_m2m_base_metric_definition_target]

Association between Base metric
Base metric definition to goal definition and Goal

[sn_esg_m2m_base_metric_definition_goal]

If Integrated Risk Management is installed

Association between Risk and Goal
Risk to Goal

[sn_esg_m2m_risk_goal]

Association between Risk Statement and
Risk Statement to Goal Goal
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Tables installed with ESG (continued)

Table
[sn_esg_m2m_risk_statement_goal]

Description

If Policy and Compliance Management is installed

Metric to Citation

[sn_esg_m2m_metric_citation]

Association between Metric and Citation

Properties

The following properties are installed with the ESG Management application.

Properties installed with ESG

Name
glide.ui.sn_esg_disclosure_activity.fields
glide.ui.sn_esg_material_topic_activity.fields

sn_esg.metric_approval

sn_esg_scoped3.historical_years_selector

Description
Disclosure activity formatter fields.
Material topic activity formatter fields.

Enables ESG administrators to define either
the simple approval flow or the advanced
approval flow for all the metrics and metric
definitions.

@ Note: This property is available only
when the sn_grc_appr plugin is activated
and must be set while configuring the
ESG Management application.

The choices are as follows:

« Simple: By choosing this option, the
Approval section will be enabled both on
the manual metric definition form and within
the metrics. Using this section, you can
designate approvers directly on the metric
definition form.

« Advanced: When you choose this option,
the Approval section will be unavailable
on the manual metric definition form and
the metric form. Instead, approval can
be configured by setting the approval
conditions, tables, and approvers in the
GRC: Approver Configurator application.
This application also allows you to
define multiple levels of approvals. For
more information see, Using Approver
Configurator for setting up approvals @.

Enables you to configure the number of
historical years for which you want to view the
data on the Scope 3 dashboard.
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Scheduled jobs

The following scheduled jobs are installed with the ESG Management application.

Scheduled jobs installed with ESG

Name Description

Generate ESG goals summary This job executes daily at 12 AM. This
job clears all existing goals summary
and creates new goal summaries
for all active goals classified as
"environmental,social,governance".

Generate ESG disclosure summary This job is executes daily once at 12AM. This
job deletes existing summary and creates
disclosure summary for all types of disclosure
like goals,citations,metrics.

Calculate ESG license count This Job executes daily at 11:00 PM. It
calculates the license based on active data in
base metric definition where domain area is
ESG.

Generate ESG goals activity summary This job executes periodically for every 12
hours. This job deletes the existing goal
activity summary and creates new goal
activity summary for all goals classified on
"environmental, social, governance",

Roles installed with the Goal Framework

Several roles are installed with activation of the Goal Framework plugin.

Roles installed

Role Description Contains roles

sn_gf.goal_user_read Can view the goals. Thisrole can None
be given to users such as project
user and demand user.

sn_gf.goal_user Can create, view, edit, and delete sn_gf.goal_user_read
goals, sub-goals, and associated
targets.
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Role

sn_gf.goal_admin

sn_gf.strategy_planner_read

sn_gf.strategy_planner

Description

© Note:

» A goal or sub-goal can be
deleted only by the owner
and contributors when the
sn_gf.allow_goal_deletion
system property is set to
Yes.

An associated target

can be deleted only

by the owner and
contributors when the
sn_gf.allow_goal_deletion
system property is set to
Yes.

A goal or target can

be edited only by the
respective owner and
contributors of the goal
and target.

Can update the goal preferences.

Can view all strategic plans and
strategic values.

Can create, view, edit, and delete
strategic plans and strategic
values.

© Note:

« A strategic plan can
be edited only by the
owner and sponsor of the
strategic plan.

« A strategic value can
be edited only by the
sponsor of the strategic
plan.

sn_gf.epmo_strategy_planner Can create, view, edit, and delete

any goal.

Contains roles

 sn_gf.goal_user_read

« sn_gf.goal_user

None

sn_gf.strategy_planner_read

» sn_gf.goal_user_read
» sn_gf.goal_user
« sn_gf.goal_admin

« sn_gf.strategy_planner
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Domain separation and ESG Management

Domain separation is supported for ESG Management. Domain separation enables you to
separate data, processes, and administrative tasks into logical groupings called domains. You
can control several aspects of this separation, including which users can see and access data.

Support level: Basic

» Business logic: Ensure that data goes into the proper domain for the application’s service
provider use cases.

« The application supports domain separation at run time. The domain separation includes
separation from the user interface, cache keys, reporting, rollups, and aggregations.

« The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation @.

Overview of domain separation

Domain separation is useful for users who:
« Enforce absolute data segregation between business entities (data separation).

 Customize business process definitions and user interfaces for each domain (delegated
administration).

« Maintain global processes and global reporting in a single instance.

These users can choose to expand or collapse the domain scope to show or hide data from
other domains.

Note: Users always have access to data from domains that have been explicitly granted to
them by domain visibility.

How domain separation works in ESG Management

While ESG Management supports separation of data, separation of logic and process is not

fully supported. Many types of records in the ESG Management application are automatically
generated through user processes. Integrations with Project Portfolio Management and GRC:
Metrics can create and associate data automatically. For records that are automatically and
manually generated, the domain of the record is the same as the domain of the user responsible
for creating or generating the records. Users must ensure that they are creating and generating
records at the right domain level so that they are visible to the right set of users.

For example, suppose you have domains that look like:
« Global
« TOP

© Domain A

o Domain B

If you have ESG goals, material topics and targets that you want to be assessed by users in

domains A and B, the ESG goals, material topics and targets should be manually created at the
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global level. If ESG goals, material topics and targets are created in Domain B, you will not be
able to use them in Domain A due to indexing.

If you have ESG goals, material topics and targets that you want to be assessed by users in Top
and Domain A, you can create the risk or control in Domain A. Unless the ESG goals, material
topics and targets are in the Global domain, users must not assign risks or controls in a higher
domain to users in a lower domain. In the example given, if you have an ESG goal in the Top
domain, you should not assign it to program manager in Domains A or B since those users would
not have access to the this goal.

Domain separated tables

The following is the list of domain separated tables:
« Disclosure

« Disclosure Summary

» Goal Activity Summary

» Heatmap Chart Color

« Composite Metric Definition to Citation
o Composite Metric Definition to Goal

» Composite Metric Definition to Target
« Control to Goal

« Control Objective to Goal

« Citation to Disclosure

» Metric to Disclosure

« Metric Definition to Disclosure

« Entity to Goal

» Goal to Citation

» Goal to Disclosure

« Material Topic to Goal

 Metric to Citation

» Metric Definition to Citation

» Metric Definition to Goal

» Metric Definition to Target

» Metric to Goal

« Metric to Target

« Policy to Goal

« Risk to Goal

« Risk Statement to Goal

« Material Topic

For more information on these tables, see Components installed with ESG Management.
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Use case

ESG data can be separated from the data of other departments. Each business area using

the ESG Management application can have separate data that cannot be shared with other
departments. Therefore, each department can have its own goals, targets, material topics, and
so on. When looking at a goal from the ESG domain, the user can choose to expand the domain
scope to show values from the ESG domain or collapse the domain scope to show only goals
that match the ESG domain. By default, domain separation adds a domain field to the Task
[task]and Configuration Items [cmdb_ci] tables and their extensions. You can extend domain
separation to any new tables you create by adding a sys_domain field to the table's dictionary
definition. By default, the system only domain-separates platform and baseline application
tables where appropriate.

o Note: ServiceNow® does not recommend domain separating platform tables such as any
table with the sys_ prefix such as the Dictionary Entry [sys_dictionary] and Dictionary Entry
Override [sys_dictionary_override] tables because it can produce unexpected results.

In this use case, client scripts, business rules, workflows, processes, and so on can be domain-
separated. While the behavior offered with domain separation provides multi-tenancy support,
multi-tenancy is still contained within a single instance. This means that some global properties,
some global data, and some global processes are shared across all domains. For example,

the system’s “Remember me” option on the login page is global and cannot be specified per
domain. If you need complete and total separation of all system properties and do not require
global reporting or global processes, separate instances are the best option.

Related topics

Domain separation for service providers @
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